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USA GeoGraph is a geography discovery-learning tool. That may sound a bit 
dull at first, but USA GeoGraph is anything but dull! In fact, it's an important 
development in geographic education. You can use its on-screen maps, 
graphs, and database to explore the fifty states and six U.S. territories 
(including the District of Columbia) as well as to better understand basic 
concepts of geography. But the real beauty of USA GeoGraph is that it 
functions as a "living map" because its maps and database are interactive. 
That is, what you do with maps affects the database and vice versa. As a 
result, you can explore the United States in many different ways-whichever is 
best suited to your goals and your own particular style. 

The on-screen maps in USA GeoGraph are among the most detailed, accurate 
maps you've seen on a microcomputer. In addition, the memory capabilities of 
the Apple Ilos allow you to manipulate those maps and the accompanying 
database (which includes 105 categories of information) in ways that will help 
you understand and appreciate the differences among states and territories and 
the patterns that emerge as you use the computer to explore the nation. 

The focus of USA GeoGraph is on "human geography," the relationship 
between where people live and how they live. USA GeoGraph includes 
information about the physical, demographic, economic, and cultural aspects 
of the United States, but its ultimate aim is to help you understand and 
appreciate the differences-and similarities--of people around the country and 
how they go about working with what their environments provide. 

The true value of USA GeoGraph lies in its power as a flexible investigative 
tool. You can use USA GeoGraph to help you learn to think like a 
geographer, so to speak. It's designed to aid in developing inquiry and 
analytical skills in the field of geography. The on-screen maps, graphs, and 
database functions in USA GeoGraph will help you become more proficient at 
asking and answering important, meaningful questions about the United States. 

While USA GeoGraph is indeed a powerful tool, it is just that: one of many 
tools you should use in geographic education. Textbooks, encyclopedias, 
atlases, wall maps, and globes all have vital roles to play in the geography 
learning process. Together with these other tools, USA GeoGraph can 
enhance geographic education, helping to make it exciting and meaningful. 

For more information about USA GeoGraph, including its instructional 
objectives and the equipment you need to use it, turn to the section of this 
User's Guide entitled "The Product at a Glance." But, before you do that, you 
might want to know a little bit about some of the basic concepts that inspired 
and guided USA GeoGraph' s design. 

©Copyright MECC 1989 
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The 
"living map" 

concept 

Geography 
today 

As we said before, USA GeoGraph can be thought of as a "living map." In 
other words, consider USA GeoGraph a combination map-database that you 
can interact with. You can "zoom in" on different parts of the country. You 
can use electronic map overlays to see the United States from various thematic 
perspectives. You'll see the map change as you use the database to explore the 
states. And you can use the map to manipulate the database. While this 
"living map" may not be as comprehensive or as detailed as maps you can find 
in atlases and geography textbooks, it is far more versatile. What other map do 
you know of allows you simply to "touch" it in various places and, in so doing, 
manipulate a database full of detailed information? 

What brings USA GeoGraph to life are the tools of the Apple "desktop" 
(especially that handy little rodent, the mouse) and the enhanced video and 
memory capabilities of the Apple lias. On the pages that follow, this User's 
Guide assumes that you know the standard Apple desktop "lingo," so if you've 
never used the desktop before, look through your Apple /las Owner's Guide to 
familiarize yourself with it. The Apple !I as Owner's Guide will tell you what 
you need to know about using the mouse (such as "clicking," "double
clicking," and "dragging"), icons, scroll bars, pull-down menus, dialog boxes, 
and other standard features of the desktop environment. Of course, a little 
practice will work wonders, too. 

The USA GeoGraph "living map" was developed not only to take advantage 
of the Apple desktop environment but also to accommodate different learning 
and working styles. You'll find in using USA GeoGraph that there are many 
different ways of doing the same thing. This isn't redundancy. It'sflexibility. 
Some people are highly text-oriented and will have no trouble selecting nations 
from an on-screen list and seeing data search results expressed in a data table. 
By contrast, other people are far more graphics-oriented and will have greater 
success selecting states from a map and viewing search results on a map as 
well. And depending on what you're interested in at any given time, you may 
use one method or the other to do different things. In short, USA GeoGraph 
was designed for ease and flexibility of use. 

You've probably read in the newspaper or seen on television news reports how 
most of today's students are sorely lacking in basic knowledge of geography. 
Few students can correctly point to such nations as France, Iran, or Vietnam on 
a world map. More than twenty percent, in fact, can't even find the United 
States! When asked simple yet important facts (such as "What is the 
approximate population of the United States?''), most students are at a loss to 
do anything but guess. And when it comes to understanding more complex 
geographic concepts-well, you get the point. 

4 OCopyright MECC 1989 
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If this were only a matter of "trivia," it might not be so bad. But it has far 
more serious implications. In What We Don't Know Can Hurt Us, the 
American Council on Education states that "To deal effectively with the 
multiplicity of problems we face in this shrinking world requires an increasing 
international competence."1 What's more, the Joint Committee on Geographic 
Education of the National Council for Geographic Education and the 
Association of American Geographers warns that "Americans' ignorance of 
their own country and of the world will have dire consequences for our 
nation's welfare, strength, and global interdependence .... "2 To be sure, 
there's nothing trivial about geographic education. 

In an effort to give greater structure and impetus to geography education, 
geographers have identified five fundamental themes to consider. To achieve 
"geographic competence," students should have a firm grasp of these themes 
and how to apply them to information about the world. These themes often 
overlap, but they're nevertheless useful in helping people to think about the 
United States and the world as the complex, intemctive systems that they are. 

1Commission on International Education, American Council on Education, 
What We Don't Know Can Hurt Us (Washington, D.C., 1984), p. 2. 

2Joint Committee on Geographic Education of the National Council for 
Geographic Education and the Association of American Geographers, 
Guidelines for Geographic Education: Elementary and Secondary Schools 
(Washington, D.C., 1984), p. 1. 

©Copyright MECC 1989 
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The five themes of geography education are: 

1. Location 
2. Place 
3. Relationships within Places 
4. Movement 
5. Regions 

Location Location refers to position on the earth's surface. You can think in terms of 
"absolute location," in which you use a grid of latitude and longitude lines to 
define precisely where you are, unrelated to anyone else. In other words, what 
does it mean to you that you're located at such and such latitude and 
longitude? Does it somehow affect your life? Consider climate, for example. 
A different absolute location, perhaps a matter of just a few degrees on a map, 
can make a big difference in your everyday life. 

Place 

Relationships 
within places 

You can also think in terms of"relative location," in which you consider where 
you are in relation to somewhere else. Think of how far away you live from 
relatives. How far away do you live from the original sources of things you 
may eat and drink every day, such as beef, corn, and milk? Where did the 
petroleum products you put in your car or the wool in your sweater come 
from? And what does that mean to you-actually and potentially? 

Place refers to physical and human characteristics, how locations and people 
are similar as well as what makes them unique. If you describe what 
Wyoming is like, you're probably going to describe it primarily in terms of 
"place." The physical characteristics of place involve geological, atmospheric, 
and biological processes, among others. So if you describe the physical 
characteristics of Wyoming, you would talk about the land, the weather, the 
animal and plant life, and so on. The human characteristics of place involve 
the composition of the population, settlement patterns, economic activities, 
political structures, and the wide range of cultural phenomena, from art to 
religion. When you describe a "place," you will almost invariably do so in 
terms of your own "place," noting how the two places are alike and different. 

Relationships within Places refers to the complex interrelationship between the 
physical and human characteristics of a place-in short, how people interact 
with their environment. All places offer advantages and disadvantages to their 
human populations. People take what the environment provides and do their 
best to make the most of it. In doing so, they may change the environment by 
building dams, canals, and irrigation systems. People also change themselves, 
adapting to those aspects of the environment they cannot change. In this way, 
the physical environment greatly affects human culture, including architecture, 
clothing, art, eating habits, socio-political structures, and even religious beliefs. 

6 ©Copyright MECC 1989 
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Obviously, a drastic change in physical environment can lead to drastic 
changes in human culture. This occurs when people move from one 
environment to another as well as when environments themselves undergo 
change caused either by nature or by their human inhabitants. 

Movement refers to the ways in which people interact with each other. People ·Movement 
move from one location to another and communicate with people located far 
away. They trade with people in other locales, exchanging the products of 
their labor and environment with those of another place. Today you may eat 
an orange grown in Florida, wear a shirt made out of cotton from a farm in 
Arkansas, and listen to a stereo system from California. You may read a book 
written by a New York author and your next-door neighbor may have been 
born in Hawaii. And you hear news from all over the world. In today's world, 
including the United States, no place is totally self-sufficient The constant 
movement of people, ideas, and commodities shapes our lives every day. 

Regions, the last of the five major themes, refers to the basic unit of geographic Regions 
study. Humans are organizing, classifying creatures, so it's only natural that 
we group nations and states together in regions. But those regions may vary, 
depending on the organizing criteria we're using. States may be grouped 
together in accordance with the points on a compass-North, South, East, 
West. Or we may define regions by dialects, ethnic groups, climates, political 
affiliations, or principal trade commodities. And regions can change over 
time; a state that was part of a region that produced more energy than it 
consumed twenty years ago may now be part of a region that consumes more 
energy than it produces. Why did this occur? What regions do you belong to? 
And what other states belong to those same regions? 

USA GeoGraph can make a valuable contribution to modern geographic 
education. But, as with any tool, its value depends on how it's used. A 
hammer won't do you much good if you hold it by the head and strike with the 
handle. Similarly, these five themes may help you use USA GeoGraph wisely 
by helping you ask the kinds of questions and performing the kinds of 
investigations that will enable you to really learn about the United States. 

The next section of this User's Guide is called "A Step-by-Step Look at USA 
GeoGraph," and its purpose is precisely what its name implies. By following 
its instructions step-by-step, you should get a good idea of how to use USA 
GeoGraph's many features quickly and efficiently. In addition to descriptive 
section headings, the outside margins contain several special symbols designed 
to be recognizable at first glance. 

©Copyright MECC 1989 
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The mouse symbol or keyboard symbol appears next to most "steps." They 
signal actions that you should take. The mouse symbol appears next to actions 
primarily involving use of the mouse. By the same token, the keyboard 
symbol appears next to actions primarily involving use of the keyboard. In 
some cases, both symbols are used to signal those actions in which both the 
mouse and the keyboard are used. 

The lightbulb symbol indicates "tips" or "helpful hints." 

The exclamation symbol indicates very important points that you should be 
well aware of. Remembering these points will make using USA GeoGraph 
much easier. 

The stop sign warns of potentially "hazardous" activities that, if performed 
thoughtlessly or incorrectly, could result in frustration and wasted effort. 

Following the "Step-by-Step" section, a "Reference" section describes the 
USA GeoGraph menu bar and each command to which it provides access. It 
also describes the results of various actions with the keyboard and the mouse. 
Subsequent sections of this User's Guide provide special tips and techniques 
for using USA GeoGraph and answer a number of basic questions you may 
have about it. The appendices to this User's Guide provide various kinds of 
useful information, including credits, instructions for using data disks and hard 
disks, descriptions of the data categories, and a bibliography. An index 
follows the appendices. 

This User's Guide is one of two support manuals available to help you use 
USA GeoGraph effectively. If you're going to be using USA GeoGraph with 
students in a classroom setting, we recommend the USA GeoGraph Classroom 
Guide, which contains more than forty lessons and student activities as well as 
textbook correlation information. It also includes material designed to help 
you conduct in-service teacher training on the use of USA GeoGraph. 

Also of interest USA GeoGraph is a companion program to World GeoGraph, MECC's first 
"Living Map" product. World GeoGraph has won several awards of 
excellence, including a Classroom Computer Learning Software Award and 
the Software Publishers Association Critic's Choice Award as "Best Education 
Product." It includes dozens of interactive on-screen maps, a comprehensive, 
55-category database with information about 177 nations, and other powerful 
features that provide users with a flexible, enjoyable means of learning about 
the world. Like USA GeoGraph, World GeoGraph comes with a detailed, 
illustrated User's Guide. A helpful Classroom Guide is also available. 

8 ©Copyright MECC 1989 
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USA GeoGraph is a geography discovery-learning tool featuring on-screen 
maps, graphing capabilities, and an in-depth database that includes 105 
categories of information about the fifty states and six U.S. territories. It is not 
designed to function as an "electronic atlas." Rather, it is designed to help 
users "think like geographers" as they exercise their inquiry and analytical 
skills in learning about the United States. 

If you're using USA GeoGraph with students, they should be able to use it to 
develop their skills at: 

using a database as a tool for inquiry and analysis in geography and 
other social sciences; 

observing patterns of similarities and differences among states; 

observing possible correlations among different types of geographic, 
demographic, social, and economic data; and 

understanding the basic geographic themes of location, place, 
relationships within places, movement, and regions. 

In addition, teachers can use USA GeoGraph as a tool for: 

displaying maps, charts, and data to support classroom lectures; 

creating student handouts; and 

examining geographic data in preparation for classroom activities. 

To use USA GeoGraph you need the following equipment: 

an Apple lias computer with ROM Version 01, a mouse, and at least 
768K of memory (product performance increases with additional 
memory); 

a color monitor (a monochrome monitor can be used, but without full 
benefit of the on-screen thematic maps); 

at least one 3.5" 800K disk drive (two are recommended because 
product performance increases with an additional disk drive); and 

an Apple printer (any Image Writer or LaserWriter) if you plan on 
printing USA GeoGroph reports or windows. 

@Copyright MECC 1989 
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Getting started Follow these steps to begin using USA GeoGraph: 

Step 1 

Step2 

Step 3 

~ Step4 

If you're using one disk drive, insert the USA GeoGraph Program 
Disk. 

If you are using two disk drives, insert the Program Disk in Drive 1 
and the Information Disk in Drive 2. 

Turn on your Apple lias and wait for the desktop (Figure 1) to 
appear (approximately one minute). 

USA.GEOGRAPH 
Figure 1 Figure 2 

If the Program Disk window (as seen in Figure 1) has not appeared 
on the screen, click on the Program Disk icon to highlight it and 
select "Open" from the File menu to open the window. 

The USA GeoGraph icon (Figure 2) is one of several icons in the 
Program Disk window. 

Click on the USA GeoGraph icon to highlight it and select "Open" 
from the File menu. 

3~9f Lrxingtoa Av~nue Harth. St. Paul. HK 55126 
012) ~B1-3m &ollllriahtH£Ct.1989 

Figure 3 

12 

The computer will take about 
a minute to open the program, 
during which time the title 
screen will appear (Figure 3). 
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Step 5 When the Overview Map appears on the screen (Figure 4), you're 
ready to start working with USA GeoGraph. · 

Figure 4 

If you're using two disk drives, you won't have to bother with disk
switching. But if you're using only one disk drive, you'll have to 
switch disks whenever the program asks you to do so. So have your 
Information Disk handy at all times! 

The first important feature of USA GeoGraph that appears on the screen is the 
Overview Map, so let's start exploring the program-and the United States 
itself-with maps. 

Note the information bar just above the Overview Map. On every map screen, 
the information bar contains data about the scale and projection of the map 
you're looking at and some information about the map's thematic content. For 
different types of screens, the information bar contains different types of data. 

Step 1 Use the mouse to move the cursor up the menu bar and pull down 
the Maps menu. 

Step 2 Select "Hide Boundaries" from the Maps menu. 

You should now see the Overview 
Map without state boundaries 
(Figure 5). This is just one of the 
many ways in which you can 
manipulate USA GeoGraph 
maps. Let's try some more. 

©Copyright MECC 1989 
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Step 3 

Step 4 

Step4 

Step 5 

Pull down the Maps menu again and select "Fifty States Map." 

Figure 6 

Pull down the Maps 
menu again and select 
"Theme Map." 

The dialog box that now 
appears (Figure 7) 
allows you to select one 
of 24 thematic maps to 
view at the "Fifty 
States" level. 

You now "zoom in" on a map 
of the fifty states in the union 
(Figure 6). Because you 
previously used the "Hide 
Boundaries" command, the 
boundaries to the fifty states 
still do not appear on this map. 
We'll tell you how to bring the 
boundaries back in just a 
moment. 

Theoe Hop 
Stltct IIDP to view: 
@Acid Rain 0 Hot ural Hdlords 
0 Agricultural Regions 0 Physiographic Regions 
0 Civil War 0 Population Densit1 
0 Clillate Zones 0 Precipitation, Annual Average 
0Dialect Reaion1 0 Settl111tnt Patterns 
0 llevation 0 Jeooeraturt, January Averagt 
OEnersw Con'i\IIPtion 0 Te•peroture, JulH Averasr 
0 Energy Resources 0 Territorial hponsion 
0 Ethnic Population 0 Tille Zonrs 
0 Federal lands 0 Vegetation Regions 
0 &rowing Stason length 0Water Sufficiency 
0 Indian Reservations/Culture Regions 
OLandUse (toncel) (J[) 

Figure 7 

Select "Climate Zones" from this dialog box and then click OK. 

Figure 8 

The map that now appears 
(Figure 8) shows the climate 
zones in the United States. 
Note that the information bar 
has changed to remind you of 
what's being shown on the 
screen. But what do all of 
those different colors mean? 
You need a key! 

Pull down the Maps menu and select "Show Key." 

14 ©Copyright MECC 1989 
lbcse materials may not be reproduced in whole or 

in part without written permission from MECC. 



USA GeoGraph User's Guide 

~0 Key Now a key window appears on the screen (Figure 9). 
You can "grab" this window by its title bar and drag it 
to wherever you want it on the screen. When you 
don't want it anymore, you can get rid of it either by 
clicking in the close box (at the left end of the title 
bar) or by clicking anywhere on the map window. If 
you want to see the key again, all you have to do is 
select "Show Key" again. 

tropical rain forest 
savanna 
subtropica 1 
mediterranean 
desert 

!\11 steppe 
:;:; •arine 
~ continento I I subarctic 

tundra 
alpine 
sehcted 

Step6 

Step 1 

Step2 

Step3 

Figure 9 

When you've fmished looking at the climate map, close the key 
window (if you haven't done so already) by clicking in its close 
box. Then pull down the Maps menu and choose a different theme 
map to examine. Go ahead and look at as many theme maps as you 
like. 

Once you've finished looking at theme maps for the time being, 
pull down the Maps menu and select "Blank Map." 

Sure enough, you're left with a blank map. 

Pull down the Maps menu and select "Show Boundaries." 
(Remember how it used to say "Hide Boundaries"? This command 
acts as a "toggle switch," allowing you to switch between showing 
and hiding boundaries.) 

The state boundaries should now reappear. Notice that most 
boundaries are quite distinct, but some of the smaller states are 
unclear or even "invisible." We can take care of that by "zooming 
in" on a region. 

Pull down the Maps menu and select "Region Map." 

<l:lCopyrigbt MECC 1989 
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Step4 

f/!f StepS 

~ 

Using the Step 1 
"Compare" 
command 

f!!f Step2 

Region Hop The dialog box that now appears 
(Figure 10) allows you to choose 
a region to zoom in on. 

Se I ect region to view: 
@Caribbean 0 Pacific 
0 Hidwest 0 South 

Select "South" and then click OK. 0Northeost 0West 

You should see a "zoomed-in" 
view of the South on the screen. 
Notice how much clearer the 
boundaries are now. Also, note 
that you can see major rivers and 
large metropolitan areas. 

Now try to select "Theme Map." 

(cancel)[ OK] 

Figure 10 

Oops! You can't select ''Theme Map." It's "grayed out," 
indicating that it's inactive. In USA GeoGraph, theme maps are 
available only at the Fifty States level. 

But there are other kinds of maps you can look at instead. 

Pull down the Maps menu and select "Compare." 

A dialog box appears (Figure 11) that allows you to choose a state 
or territory to compare to all the other states and territories as well 
as the numeric category you'll use to compare them. Or you can 
choose to compare states and territories to the United States overall. 

Select tbe place to which you 
wont to CIIIIPart othfl' placn: 

I.' 

Alabatla 
Alaska 
Allericon S•oa 
Arizo1a 
Arkansas 
Colifemi1 
Colorado 
Connecticut 
Del11110re 

D C011pare to Statn Only 

Cap are 
Select the category bywbich !.a 
CGIIPirt th111: 

'• ' 
Airline Passenaers 
Aooua I Pa1. Average 
Area. Land 
Aroa. Total 
Ana, Mater 
Asian Papulation 
Birth late 
Block Papllatien 
Coastline 

Figure 11 

Use the left-hand scroll box to choose "Arkansas" and the right
hand scroll box to choose "Population 1988." Then click OK. 
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Step3 

Step4 

Figure 12 

You know what to do, don't you? 

USA GeoGraph User's Guide 

The dialog box disappears and 
the map of the South now · 
appears in several colors 
(Figure 12). The information 
bar tells you how your 
comparison or "target" state, 
Arkansas, ranks in population, 
and Arkansas appears in 
orange on the map. But what 
do the other colors mean? 
Looks iike you need a key 
again! 

Just in case you didn't know what to do, choose "Show Key" from 
the Maps menu. 

A key window appears, explaining that "red" states and territories 
have populations smaller than the target state, Arkansas, while 
"green" places have populations larger than the target state. In 
some cases, three other colors may be used as well. Places 
appearing in yellow would have populations--or whatever-equal 
to the target place. When a state or territory appears in white on a 
comparison screen, it means that no data is available for that place 
in that category. And places that appear in black are current 
database selections. You can see the "true color" of such a place by 
clicking elsewhere on the map. 

But what happens if you try to pick a target place that doesn't 
currently appear on the screen, such as Michigan? Let's try it! 

Close the key window, pull down the Maps menu, and select 
"Compare" again. 

Note that the settings in the comparison dialog box remain as you 
had set them before. Note also that a check box in the lower-left 
comer of the screen reads "Compare to States Only." If this box is 
checked (by clicking in it) when you click "OK," the program will 
consider only the states-and not the territories, such as the District 
of Columbia-when it determines the ranking described in the 
information bar. If any territories rank higher than your target 
state, the "States Only" option will affect the ranking of that state. 
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Step 5 Choose Michigan in the left-hand scroll box. Since "Population 
1988" remains the selection in the right-hand scroll box, all you 
have to do now is click OK (or, if you prefer, "States Only"). 

The dialog box disappears and the map has been modified to reflect 
your changes. No place appears in orange because the new target 
state, Michigan, doesn't appear on this screen. But all the places in 
the South appear in one color or the other, depending on whether 
their populations are greater than or less than Michigan's. Also, 
note Michigan's ranking in the information bar. 

Using the Step 1 Now select "USA Quartiles" from the Maps menu. 
"USA Quartiles" 

command USA Quartiles 
Select the category to display 
USA quartile data for: 

'· ' ' i} 
Airline Passengers r-
Annual Pay, Average 
Area, land 
Ana, Total 
Ana, Water 
Asian Population 
Birth Rate 
Black Papulation 
Coastline .0. 
0States 

(concel)m Only 

Step 2 

Figure 13 

Select "Per Capita 
Income" and then 
click OK. 

The quartiles map 
(Figure 14) has 
replaced the 
comparison map. 

18 

A new dialog box appears (Figure 13) that 
allows you to choose the numeric category 
according to which you want to see U.S. 
quartile data displayed. A "quartile" is a 
block of25%, so the "highest quartile" is 
the top 25%, the "second highest quartile" 
is the second 25%, and so on. If a place is 
among the lowest 25% of the nation's 
states or territories in terms of per capita 
income, it would be in the "lowest quartile" 
for that category. 

Figure 14 

@Copyright MECC 1989 
Those mall:rials may not be reproduced in whole or 

in part without writll:n permission from MECC. 



USA GeoGraph User's Guide 

Step 3 

Step 4 

Step 5 

Step 1 

Step 2 

Now you see the map of the South appearing in different colors 
according to where each state or territory (the District of Columbia) 
stands in U.S. ranking for per capita income. Use the key to find 
out what the colors mean. It seems that, at least based on per capita 
income, some states in the South are quite a bit "richer" than others. 

Pull down the Maps menu and select "Fifty States Map." 

All fifty states are now "divided up" according to per capita income 
quartiles. Note how some states are so small that you can barely 
tell which quartile they fall into. If you wanted to see those states, 
you'd have to zoom in again to view them at the region level. But 
let's not bother with that right now. 

Pull down the Maps menu and select "USA Quartiles" again. 
When the "USA Quartiles" dialog box appears, select a different 
category and then click OK. 

Now you see the quartiles for the category you selected. 

We have some other things to do, so once you've finished 
experimenting with the quartiles, select "Blank Map" from the 
Maps menu. 

Select "Equal Steps Map" from the Maps menu. 

The dialog box that now appears is virtually identical to the "USA 
Quartiles" box (see Figure 13 on page 18). And you use it in the 
same way. But it provides different results. 

Select "Per Capita Income" again and click OK. 

Figure 15 

Once again, the map is divided 
into several different colors 
(Figure 15). But you may notice 
that, despite the fact you're using 
the same data category, this 
"Equal Steps Map" is not at all 
identical to the quartiles map you 
saw a few moments ago! 

©Copyright MECC 1989 19 These materials may not be reproduced in whole or 
in part without written permission from MECC. 

Using the "Equal 
Steps Map" 
command 



USA GeoGraph User's Guide 

Step3 

Step 4 

Step 5 

Working at the Step 1 
"close-up" level 

~ 

If the map key isn't currently on the screen, select "Show Key" 
from the Maps menu. 

Like "USA Quartiles," "Equal Steps" divides the nation into four 
parts. In "USA Quartiles," each quartile is equal in size. Because 
we're dealing with fifty states and six territories-for a total of 56 
places (unless you use the "States Only" option in the "USA 
Quartiles" dialog box)-each quartile has fourteen places in it 
(56+ 4 = 14). The top fourteen are in the highest quartile, the next 
fourteen are next, and so on. But "Equal Steps" work differently. 

"Equal Steps Map" takes the range of figures within a category and 
divides the range into four equal parts. The resulting map then 
indicates which places fall into each range. If states and territories 
fall equally across this range, then the sizes of the "equal steps" will 
also be equal. But if the distribution isn't even, then the equal steps 
won't be equal, either. The highest step may include many states, 
while the lowest may have only one or two. In fact, occasionally 
you may find that no states or territories fall into the middle steps. 
Again, using "States Only" can drastically affect the outcome. 

If you wish, do some "exploring" with the "Equal Steps Map" 
feature. You may wish to create and compare quartile and equal 
steps maps for various categories. Sometimes the two maps will be 
very similar, but at other times they will be extremely different. 

When you've finished experimenting with equal steps, select 
"Blank Map" from the Maps menu. 

We're now going to "zoom in" a little more. 

Select "Close-up Map" from the 
Maps menu. 

The dialog box that appears contains 
a scroll box that allows you to find 
and select by name a place of your 
choice (Figure 16). This allows you 
to select a place to zoom in on, 
giving you an even closer look at a 
particular state or territory than you 
had at the region level. 

20 

Close-up Hop 
Select close-up 11op to view: 

I Ill I 

Alaska 
~erican Smno11 
Arizona 
Arkansas 
Colifornia 
Colorodo 
Connecticut 
Delaware 
District of Coluabia -(). 

(cancel)(JD 

Figure 16 
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Scroll through the box until you find Puerto Rico. Then select it 
and click OK. 

I tl. File Edit Displq Naps D11t1 Rtpon The screen now shows a 
zoomed-in view of Puerto 
Rico (Figure 17), which hadn't 
been visible on the Fifty States 
Map. Note how this close-up 
map also includes the Virgin 
Islands, which are located 
quite near Puerto Rico. And 
note that the names of these 
U.S. territories appear on the 
screen, which wasn't the case 
at the Overview, Fifty States, 
and region levels. 

0 
1---llloi. 

... ] __ 

,,. ,. 

Step3 

Un~itltd 
Clos.-., Polvcuic 

ATLIHTK .. 1-Q 
KilN 

r ??. ~: ~~-:.-~ PliEIITea!tD ~ VIII GIN 
1'5UHDS 

U.ftiiiUH ~ ... 
~ ... ... 

¢ 

Figure 17 

Now that we're at the close-up level, let's try some of our special 
map features. 

Select "Compare" from the Maps menu and proceed as you had in 
"Using the 'Compare' Command" (beginning on page 16). 

Sure enough, you can compare places at the close-up level, just as 
you can at the other levels. Similarly, the "USA Quartiles" and 
"Equal Steps Map" features also work at the close-up level. But 
"Theme Map" doesn't work at the close-up level. Remember
theme maps are available only at the Fifty States level. 

Notice also that the "Hide/Show Boundaries" option is also grayed 
out on the Maps menu. At the close-up level, you're stuck with 
boundaries. 
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"Sliding" from one 
map to another 

You may have already tried clicking your mouse on the adjacent "grayed-out" 
areas of some maps. But for those of you who haven't, we'll show you what 
happens right now. 

Step 1 Use the "Close-up Map" command to look at the close-up map of 
Maine. 

Two different types of "gray" appear on USA GeoGraph maps. 
The lighter, more "checkered" gray indicates other nations, such as 
Canada and Mexico. These areas aren't "active." In other words, 
clicking on them doesn't cause the map to "slide." On the close-up 
map of Maine (which also includes Vermont and New Hampshire), 
the upper-left and upper-right comers of the screen embrace 
Canada, which appears in this light gray color. 

Figure 18 

The other type of gray is darker, 
which indicates U.S. states or 
territories that are adjacent to the 
places being focused on in various 
region or close-up maps. In the 
lower-left comer of the Maine map 
you see an area colored in this dark 
gray (Figure 18). 

t!!f Step 2 Click on the dark gray area and watch what happens. 

Your map "slides" over to a different map at the same level. Since 
you were looking at a close-up map, you've slid over to the 
adjacent close-up map. If you had been looking at a region map, 
you would have slid over to an adjacent region map. 

By clicking in gray areas on the close-up and region maps, you can 
"slide around the country," moving from map to map without using 
the Maps menu. 

We're now ready to move on to the USA GeoGraph database. But you may 
say, "Wait! There's still one command on the Maps menu that you haven't 
discussed yet! What about the 'Contrast' command?" 
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No, we haven't forgotten "Contrast." But because it works in a manner quite 
similar to one of the core functions of the database, "Search," we're going to 
hold off on discussing "Contrast" until we've first described the "Search" 
feature. But if you're impatient, you may want to skip ahead to page 55 or to 
experiment on your own. 

Meanwhile, let's see why we describe USA GeoGraph as a "living map." 

As we've already noted, underlying USA GeoGraph is a unique "living map" 
concept, in which the on-screen maps are intimately linked to a detailed 
database. What you do to the map often affects the database and vice versa. 
Let's take a quick look at one way of using the "living map." But first make 
sure that you're looking at the Fifty States map on the screen. On the Display 
menu "Display Map" should be selected and on the Maps menu "Blank Map" 
should be selected. 

Step 1 

Step 2 

Step 3 

If the Fifty States map isn't currently displayed on the screen, select 
"Fifty States Map" from the Maps menu. 

Point the cursor at Alaska and click once. 

Figure 19 

Alaska is now highlighted on the 
map (Figure 19). You have just 
"selected" Alaska. You '11 find out 
how important that is in just a 
moment. 

Point the cursor at another state and click once. 

Again, the state you clicked on is highlighted. Note, however, that 
Alaska is no longer highlighted. You have selected the other state, 
but in the process you have "de-selected" Alaska. 
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Shift-clicking Step 1 
on the map 

I Shift I ~ 

Apple-clicking and 
option-Apple

clicking 
on the map 

lo 3€1 ~ 

Step 2 

Step 1 

Hold down the Shift Key, point the cursor at Alaska, and click 
once. This is called "shift-clicking." 

Alaska is highlighted once again. But the other state remains 
highlighted as well. By holding down the Shift Key when you click 
the mouse, you're able to select more than one state or territory at a 
time. Try it with a few additional states. 

4ii6ng as you ho}t[li{)w'n (~(? $/tift Key, }ro# ell~ §eleq(Js 1rl{lf[y 
States dnd!()ftefritoriesasyc?UWifh. f'!ote also tlll.ll ifyou shift
clicl{.()fi .. (Jlt .. {llre.ady-s;electe.dp/llJe: •. y{)i(.(Je-.se.lfct.f#atplace.Without·· 
de-selecting anyotherplal:e~. 

Stop holding down the Shift Key. Now, once again, simply click 
once on Alaska. 

By releasing the Shift Key and clicking, you de-select all of the 
states you previously selected-except, of course, the one you were 
pointing at when you clicked the mouse. 

Hold down the Apple Key (cJ) and click anywhere in the western 
United States. This is called "Apple-clicking." 

When you held down the Apple Key, your cursor changed 
to a "magnifying glass" with a plus sign in the "lens" 
(Figure 20). This tells you that you will "zoom in" on the 
map when you click the mouse. 

Figure 20 

And that's precisely 
what happened! You 
automatically 
zoomed in on the 
region-level map of 
the West (Figure21). 
Notice, however, that 
no states in the West 
are highlighted. 

24 

Figure 21 
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---- ................. ,, ........ ---------------- "" ,., ............. "'' , ....................... ""'''"'. ""' . ' . 

Wb~n )loi(i\pt>/~-ei@lc d#ll state#fth~ J7lftY $tat~,{leVel, )'by zod1ft 
· i# (J# ih(f ifi4P6J.r#e r~gitflio[witfchmats(qte i~#P4tt WH#f!@ · · · · 
ei(fJ.e! se((fgtt~$ (Jf'(J¢}~(ffe4ting?,(tJ.Y}Stdte (Jf' t~ri;iic(ry, .................. . 

Step 2 Hold down the Apple Key and click on California. 

Step 3 

Step 4 

Figure 22 

Now you zoom in on the 
California-Nevada close-up map 
(Figure 22). Again, no states are 
highlighted. 

Apple-click again on California or Nevada. 

Nothing happens. There is no "closer" level of map to zoom in on, 
so Apple-clicking has no effect. 

Hold down the Apple and the Option Keys simultaneously and 
click anywhere on the close-up map of California and Nevada. 
This is called "option-Apple-clicking." 

Figure 23 

When you held down the Apple and Option Keys 
simultaneously, your cursor changed to a magnifying glass 
with a minus sign in the "lens" (Figure 23). This is a way 
of telling you that you will "zoom out" when you click the 
mouse. 

And, sure enough, you've now "zoomed out" from the 
close-up map back to the region map of the West. 

lfhetl y(JU, Hption-;fppl¢-click og anystate or territory ckthe 9tose
@••MMU.Y9##ootftduttO.t}ie•fn.dft•.ofthe••regi(jfl•of}jjfzi¢h••thatpta¢e• 

···•ts#pqft.}(l@()u,t.(:ither sel(fctin$• or• de·selectifig @:)i ptace.•••· · 
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Step 5 

Step6 

Step7 

Observing how the Step 1 
"living map" affects 

the database 

Again, hold down the Apple and the Option Keys simultaneously 
and click anywhere on the map of the West. 

Now the Fifty States map reappears on the screen. 

Option-Apple-click anywhere on the Fifty States map. 

You now zoom out to the Overview Map. 

Now option-Apple-click anywhere on the Overview Map. 

Nothing happens. Because there is no "farther" level of map to 
zoom out to, option-shift-clicking has no effect. It doesn't even 
select or de-select any state or territory because use of the Apple 
Key on maps "deactivates" the ability of clicking to affect the 
selection process. 

Zoom in again on the Fifty States map (Apple-click) and then, 
releasing the Apple Key, click on Texas to select it. 

Texas should now be highlighted, indicating that it is the current 
selection. 
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Move the cursor up to the menu bar, pull down the Display menu, 
and select "Display Data Cards." 

I (.;o' Fib Edit Displa111 Hops Data Report ·' This is new! The map of 
the United States, with 
Texas highlighted, has 
disappeared, and in its 
place we see a list of data 
about Texas (Figure 24). 

0 Untitled 
Place: '"" (!of I) 
Plact: TtiDS fr 
Abbreviation, Postal: IK 
Agricultural C01111odities: co\l.le 

cotton 
dairy products 
fruits and vege-tables (lliscelloneous) 

Agricultural Valut: $8.~~~ oillion '"year 
Airline Passengers: 30,853 thousand ll'ff year 
Annual Pay. Average: $20.~60 
Rrea,land: 262,017 •ouar .. ilos 

By selecting "Display Data 
Cards" from the Display 
menu, you have gained 
access to the database. And 
because Texas was the only 
state selected when you 
entered the database, all 
you see here is information 
about Texas. 

Area, Total: 266,807 <Quare oile< 
Area,Woter: ~.790.quareoilos 
Asian Population: o.n {)-

IQI 

Step 3 

Step 4 

Step 5 

¢ 

Figure 24 

Take a few moments to scroll through the data card for Texas. (Use 
the scroll bar on the right-hand side of the screen to scroll through 
the card.) You should see a great variety of interesting information. 

When you have finished examining the data for Texas, select 
"Display Map" from the Display menu. 

Because it was the last map you were viewing, you return to the 
Fifty States map. Texas is highlighted because it's still selected. 

Hold down the Shift Key and click on two additional states. 

Now three states should be selected, indicated by the fact that 
they're highlighted on the map: Texas and the two additional states 
you clicked on. 
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Step 6 

1\ §~ep-by .. st~p Lookat usrioeoGttiP~ 
I[ji)u $!tinted to, you coulq even go(o (t· dlfterent fhap--say, of the 

· ·. Pacific territ?rie~d selectplacesth~re as well. As long ru you 
~old dqwn the Shift key when you clicldhe mouse, you c~n add.·.· 

.stat(!saniltetrit9riesto YG¥tselecti¢# )itithout de-selectingplaces 
yow have prcviouslysel~(;te~. even if they' ~e not currently sf1own on 

···.the s.creen. p ispnlYlVhen you click without holding down the Shift 
Key that you ''lqse" yourprevious sele£iions, · · 

Also, note tha!Cliclcingin the dar.~ gray qreas.ofa tegion ot close
up rnqp "$,liqes>' you to anoihflrmap butdoes nottiff:ect the . 
. ita{abas~ ~election,. (;lic;/(ing. in a bpdfofwaier, in another.· . ... · .. · 
c;ou~trj, .Ofifrlthe latitudel(oilgitiUJe qars, · h()wever, Will de-select 

. all preWouSselections, 

Select "Display Data Table" from the Display menu. 

You're back in the database, but you're looking at it in a new way. 
Instead of the data card, you're looking at a data table. Data cards 
list information in a vertical format, while tables list data both 
horizontally and vertically-horizontally for different information 
about the same place and vertically for different places. 

Notice that you're seeing information about three states: Texas and 
the two additional states you selected. 

You should now be gettinga goodi¢ea of one of th~ ways in which 
the lJSA Geo(jiaph ''Uv#lg map~ works. OM rrzethod of 

•· r!UJnipl.lil.lf(!lg.thl/daidbase#bYinaiupu!qting the maps, . 

We'll explore other ways to take advantage of the "living map" concept later. 
But for now let's learn more about how the USA GeoGraph database works. 
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The USA GeoGraph database contains 105 categories of information about 
fifty states and six U.S. territories. And it has all of the searching and sorting 
capabilities you'd expect to find in a powerful database. Let's take a few 
minutes to learn how the USA GeoGraph database works. 

Step 1 If you're not already looking at the data table (from the previous 
activity), go ahead and select "Display Data Table" from the 
Display menu. If you're not sure whether you're looking at the 
data table, simply pull down the Display menu and see whether 
"Display Data Table" has a check mark by it. 

Step 2 Pull down the Data menu (Figure 25) and select "Clear Selection." 

Clear Selection 
search... .tv 
Select Ploces •.. 

Find... .t F 
Find NeHt .tJ 
Sort... .t R 

Show Cfltegories ... 
Arrange Categories ..• 
Resize Categories ... 

Rbbreuiote Category Names 

Show English Units .t E 
Show Metric Units .t U 

Figure 25 

Because we've already been manipulating 
the database through the use of USA 
GeoGraph's "living map" capabilities, we 
should return the database to an "unselected" 
or "un-narrowed" state. The "Clear 
Selection" command allows you to do this, 
clearing the database (and, incidentally, the 
maps as well) of any selections you have 
made. So all of the states and territories in 
the database become "active" again! Now 
you can use the database without worrying 
about whether your actions will be restricted 
by previous activities. 

As we've already noted, USA GeoGraph contains 105 categories of data. 
That's a lot of data to work with! In fact, it can get downright unwieldy! You 
might want to limit the number of data categories that appear on the screen. 
The USA GeoGraph "Show Categories" command lets you determine which 
categories will appear so that you won't have to bother with ones that you're 
not interested in at any given time. Of course, you can always go back and 
decide to show different categories later. 

Step 1 

Step 2 

If you haven't done so recently, select "Clear Selection" from the 
Data menu. 

Choose "Show Categories" from the Data menu. 
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Figure 26 

The "Show Categories" 
dialog box appears on the 
screen (Figure 26). Notice 
that all of the data categories 
are highlighted, indicating 
that they're all "active." 
The names of all the data 
categories are listed in 
alphabetical order. 

The following is a list of these 105 categories, along with their units of 
measurement (if applicable): 

Data Category 

Abbreviation, Postal 
Agricultural Commodities 
Agricultural Value 
Airline Passengers 
Annual Pay, Average 
Area, Land 
Area, Total 
Area, Water 
Asian Population 
Birth Rate 
Black Population 
Borders 
Capital 
Cities 
Climate Zones 
Coastline 
Crime, Property 
Crime, Violent 
Date of Admission 
Death Rate 
Education, College 
Education, Expenses per Pupil 
Education, High School 
Education, Under 5 Years 
Electoral Votes 

30 

Unit of Measurement (if applicable) 

$million (millions of dollars) per year 
thousands per year 
$ (dollars) per year 
square miles or square kilometers 
square miles or square kilometers 
square miles or square kilometers 
%(percent) 
per 1,000 population per year 
%(percent) 

miles or kilometers 
per 1,000 population per year 
per 1,000 population per year 

per 1,000 population per year 
%(percent) 
$ (dollars) per year 
%(percent) 
%(percent) 
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Data Category 

Electricity, Coal 
Electricity, Gas 
Electricity, Hydro 
Electricity, Nuclear 
Electricity, Petroleum 
Elevation, Average 
Elevation, Highest 
Elevation, Lowest 
Energy Consumption 

Energy Consumption per Capita 
Energy Production 

Energy Production per Capita 
Fun Facts 
Gross Domestic Product 
Ground Water Dependence 
Hazardous Waste Production 

Highway Mileage 
Highway Usage 

Hispanic Population 
Industries 
Infant Mortality Rate 
Labor Force, Female Participation 
Labor Force, Male Participation 
Labor Force in Agriculture 
Labor Force in Industry 
Labor Force in Office Work 
Labor Force in Services 
Land, Built-up 
Land, Cropland 
Land, Federal 
Land, Forested 
Land, Pasture 
Land, Rangeland 
Life Expectancy (Females) 
Life Expectancy (Males) 
Low-Income Families 
Manufacturing Industries 
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Unit of Measurement (if applicable) 

%(percent) 
%(percent) 
%(percent) 
%(percent) 
%(percent) 
feet or meters 
feet or meters 
feet or meters 
trillions BTUs or millions megawatt-hours 
per year 
millions BTUs or megawatt-hours per year 
trillions BTUs or millions megawatt-hours 
per year 
millions BTUs or megawatt-hours per year 

$million (millions of dollars) per year 
%(percent) 
thousands tons or thousands metric tons 
per year 
miles or kilometers 
miles per mile per year or kilometers per 
kilometer per year 
%(percent) 

per 1,000 births per year 
%(percent) 
%(percent) 
%(percent) 
%(percent) 
%(percent) 
%(percent) 
%(percent) 
%(percent) 
%(percent) 
%(percent) 
%(percent) 
%(percent) 
years 
years 
%(percent) 
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Data Category 

Manufacturing V aloe 
Millionaires 
Minerals and Fuels 
Minerals and Fuels V aloe 
Native American Population 
Natural Features 
Natural Increase Rate 
Net Migration, 1980-87 
Nitrogen Oxides 

Particulates 

Per Capita Income 
Place 
Political Index 

Population 1800 
Population 1850 
Population 1900 
Population 1950 
Population 1988 
Population 2000 (Projected) 
Population Age 65 and Over 
Population Born Outside State 
Population Density 
Population Foreign-Born 
Population Growth, 1980-87 
Population Growth Rate, 1980-87 
Population per Physician 
Population Under Age 15 
Precipitation, Annual Average 
Recreation Lands 
Region 
Soil Erosion 

Status 
Sulfur Oxides 

Temperature, January Average 
Temperature, July Average 
Toxic Waste Sites 
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Unit of Measurement (if applicable) 

$million (millions of dollars) per year 
per 100,000 population 

$million (millions of dollars) per year 
%(percent) 

per 1,000 population per year 

thousands tons or thousands metric tons 
per year 
thousands tons or thousands metric tons 
per year 
$(dollars) per year 

rating (0 = "totally Democratic" and 
100 ="totally Republican") 

%(percent) 
%(percent) 
people per square mile or square kilometer 
%(percent) 

%(percent) 

%(percent) 
inches or millimeters 
square miles or square kilometers 

thousands tons or thousands metric tons 
per year 
"state" or "territory" 
thousands tons or thousands metric tons 
per year 
·For ·c (degrees Fahrenheit or Celsius) 
·F or ·c (degrees Fahrenheit or Celsius) 
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Data Category Unit of Measurement (if applicable) 

Unemployment Rate % (percent) 
Union Membership %(percent) 
Urban Population 1980 % (percent) 
Urban Population Change 1970-80 %(percent) 
Water Use for Irrigation millions gallons or millions liters per day 
Water Use per Capita gallons or liters per day 
White Population % (percent) 

Step3 

Step4 

In the "Show Categories" scroll box, select the category "Area, 
Total" by clicking on it. 

If you wanted the "Area, Total" category to be the only one that 
appears on the screen, you would now click OK. But chances are 
that you'll want more than one category. In fact, one category that 
you'll hardly ever want to do without is "Place." Mter all, 
information about various states and territories won't do you much 
good if you don't know which places it relates to. 

Scroll through the box until you find the "Place" category and then 
hold down the Apple Key when you click on it. 

If you were merely to click on the word "Place," you would indeed 
select that category, but in so doing would de-select the "Area, 
Total" category. If you want to view both categories, you must 
Apple-click. By Apple-clicking, you select an item without de
selecting any previous selections. 

You've selected both the "Area, Total" and the "Place" categories. 
If you wish to verify this, scroll back up to "Area, Total" to see 
whether it's still selected. If you Apple-clicked on "Place," it will 
be. Now, if you wish to view additional categories, you can do so 
by Apple-clicking on them as well. 

Also, shift-clicking allows you to select a range of contiguous items. 
Simply click on the first item you wish to select and then shift-click 
on the last item you wish to select. Everything between and 
including the first and last items you clicked on are then selected. 
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If you select a category accidentally or if you change your mind 
about selecting it, Apple-clicking on a selected category de-selects 
it without de-selecting any other previously selected categories. 
Again, simply clicking (as opposed to Apple-clicking) on a 
category de-selects any other category that may have been 
previously selected. 

Once you've selected all the categories you wish to view, click OK. t!!f Step 5 

rr===============~ You'd rarely want to view data 
without the "Place" category. 
That's why, if you try to exit 
from the "Show Categories" 
dialog box without having 
selected "Place," a special alert 
box appears (Figure 27). 

r.\ Warning! You have nat 
ll.l selected the place 

catl!gory. 

Step 6 

( Continue ) [Add Place] 

Figure 27 

This alert box warns that the "Place" category hasn't been selected 
and gives you two options. If you definitely don't want the names 
of the states and territories to appear on the screen, click the 
"Continue" button. But if you do want the names of the places to 
appear on the screen, click the "Add Place" button. 

After you click one of the buttons in this alert box, the "Show 
Categories" box disappears and you return to where you were in the 
program when you selected the "Show Categories" command. 

What if you want to restore all of the data categories to view again? 

Select "Show Categories" again from the Data menu. 

In the "Show Categories" dialog box that reappears, you '11 notice-
in addition to the standard "Cancel" and "OK" buttons-two other 
buttons: "Show Prefs" and "Show All." Don't worry about the 
"Show Prefs" button right now; we'lllearn about that one later (in 
"Setting Preferences" on pages 94-96). 
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Step 7 

Step 1 

Step2 

Simply click the "Show All" button. 

The result of clicking "Show All" is the same as if you had selected 
each and every category in the "Show Categories" scroll box and 
then clicked OK. You return to where you were before you had 
selected "Show Categories," but now with all of USA GeoGraph's 
data categories in view once again. 

Now, let's say you wanted to find an occurrence of a particular 
word in the database. For example, if you wanted to find "Florida" 
or "wheat," one way you might go about it is to use the "Find" and 
"Find Next" commands. 

Pull down the Data menu and select "Find." 

The "Find" dialog box now appears (Figure 28). We're going to 
use it to find the first occurrence on the screen of the word "wheat." 

Find 
Find next entry that contains: 

(Cancel) ( Find ) 

Figure 28 

Type wheat and click "Find." 
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Step3 

The "Find" box disappears and the screen "moves" to the first 
occurrence in the screen display of the word "wheat," which 
"flashes" for a few seconds to call your attention to it (Figure 29). 
But in which place's record does it appear? Right now you can't 
tell because the screen has scrolled off to the side, away from the 
names of the states and territories. To identify this place, all you 
have to do is "zoom in" on the data card for that place. 

Figure 29 

Point at the item that flashed and Apple-click or double-click on it. 

The name of the place now appears in the information bar at the top 
of the screen (Figure 30). 

cDrn 
Aericult..al Valut: $~,1125 •illiDIIII&r lttr 
Air lint Posstngtrs.:- &33 thDUsan• per 111r 
IMual P11.lverase: $ll,m 

If you wanted to, you could 
Apple-click or double-click 
again to return to the data table. 
But for now let's continue 
working with data cards. If 
you wish, you can scroll 
through them to examine data 
for various places. On the 
other hand, the "Find" process 
works as well in the data card 
format as it does in the table 
format. 

Ina, Ltntl: 11,778 S.UIIf't•ilts 
I"'· loti!: 12.277 saacre oilos 
lrta.llfattr: ~gg SIIUIIflllilts 

Figure 30 
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To find the next occurrence of "wheat" in the database, you could 
use the "Find" command again. "Wheat" is still in the "Find" box, 
so you can click "Find" and thus look for "wheat" again. Or, if you 
prefer, you can enter something different to look for. But there's an 
easier way to find the next occurrence of "wheat." 

Pull down the Data menu and select "Find Next." 

No dialog box appears. The screen simply moves to the next 
occurrence of the word "wheat," which again flashes momentarily. 

If, on the other hand, you want to look for something different, you 
wouldn't use "Find Next." Instead, you'd use the "Find" command 
again. When the dialog box appears, you would either delete the 
last item you entered (by backspacing over it or using the Clear 
Key) or highlight it (by dragging over it or double-clicking on it). 
Then you would enter the new item you're looking for. 

You may be wondering whether the items you enter have to match 
the database entries exactly in order for the program to find them. 
What about capitalization, spaces, punctuation, fragments of words 
(such as the "Indiana" in "Indianapolis"), and the like? 
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Notice that the "Find" and "Find Next" commands locate only one 
occurrence of an item at a time. And they don't make any 
"selections," narrowing the database down in any way. But what if 
you wanted to find all the occurrences of a particular item, though 
perhaps only within a certain category, while at the same time 
narrowing down the database to only those places that contain that 
item? That's what the "Search" command is for. 
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Step 1 

Step 2 

Step3 

Select "Display Data Table" from the Display menu. 

You don't have to be viewing a data table in order to use the 
"Search" command, but at this point it will be easier for you to 
observe the effects of using it if you're looking at a data table. 

Select "Search" from the Data menu. 

The "Search" dialog box appears (Figure 31). As it says near the 
top of the screen, no "rules" are in effect. It's up to you to create a 
search rule for the program to use in narrowing down the database. 

Search 
Search for all placeswhtre: 

No rules ore in effect. 

@Expand to all places 
0 Li11it to states onl~ 
0 Li11it to current selection 

( Add Rule ) (Arranoe Rules) ( Cancel ) 

( F.dHRule ) (RI!IIIOiteRules)[ Seat<:h ) 

Figure 31 

Click on the "Add Ru1e" button at the bottom of the screen. 

Now the "Add Rule" dialog box appears (Figure 32). Its scroll box 
and radio buttons will help you create your search rule. Let's 
narrow the database down to the states in the Northeast. 

Add Rule 
Se I ect the categor~ to search: Select the rule to search bs: 

Abbreviation, !Dstal i} @equals 0 don not equal Agricultural Comodities 
Ocontoins 0 does not contain Agricultural Value 

Air line Passengers 0 is less !han () i !i ere11 ter thon 
Annual Pas. Average 0 begins with 0 does not begin with 
Area, Land Ondswith 0 does not end with 
Area, Total Ois before Ois 1fter Area, Noter 0 

Enter the COIIporison infomotion: 

I I 
Units: none 

l Show List J ( Cancel J ( OK ) 

Figure 32 
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Step4 

StepS 

Step6 

In the scroll box in the upper-left portion of the screen, scroll down 
until you fmd the word "Region" and click on it. 

This scroll box allows you to choose the data category in which you 
want to search for a particular item. 

Among the radio buttons in the upper-right part of the screen, click 
on the word "equals" (if it isn't already selected). 

These radio buttons allow you to determine the "equation" or 
"operator" relationship between the data category you select and 
the item that you want to search for. Notice that some radio buttons 
are grayed out That's because whether a particular radio button is 
active or not depends on the data category you select in the scroll 
box. The only radio button that is always active is "equals." 

Now you have the choice either of directly typing in the data you 
want to search for or of clicking the "Show List" button, which will 
display another scroll box from which you can select available 
items. 

Click the "Show List" button. 

Show List 
Choose comporison information: 

Another dialog box appears, 
featuring a scroll box that allows 
you to complete the "equation" by 
selecting the item that you want to 
search for (Figure 33). While the 
content of the first scroll box (the 
one you used to select the data 
category) is constant, this scroll 
box changes, depending on the 
item you selected in the first scroll 
box. Because you selected 
"Region" in the first scroll box, 
this scroll box contains a list of 
regions. If you had chosen another 
category, the content of this scroll 
box would have been different 

Co11bbeon Is I onds m 
H1dwest 
Northeast 
Pacific Islands 
South 
West 

Units: none 

(Cancel) ( OK J 
Figure 33 
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Select the word ''Northeast" by clicking on it and then click OK. 

The "Add Ru1e" box reappears, with "Northeast" entered in the 
record comparison information box-just as it would have if you 
had typed it in yourself (Figure 34). 

Add Rule 
Select the cateaarv ta search: Se hct the ru h ta search bu: 

Papulation Under Aae15 fr @equals 0 don not equal 
Precipitation, Annual Averaat 

Ocontains 0 don not contain Recreation Lands 
., ' Ois lm than () i !i arPat~r 1:hon 

Soil Erosion Obeainswith 0 don not begin Mith 
Status Oendswith 0 don not end with 
Sui fur Oxidn 

'3- Oisbefon Oisofter 
Temperature, January Average 

Enter the CDIIDarison infor1ation: 

IMorthmt I 
Units: none 

( Sh0t1list) ( Cancel ) ( OK ) 

Figure 34 

Now that you've created your search ru1e, click OK. 

The "Add Ru1e" box disappears and, in its place, you see the 
"Search" box again. But now, instead of reading "No rules are in 
effect," the rule "Search for all places in which Region equals 
Northeast" has been established (Figure 35). 

Search 
Search for all places when: 

Region equals Northeast 

@Expand to all places 
0 Lillit to states only 
0 Lillit to current selection 

( Add Rule ) (Arrange Rules) ( Cancel ) 

( Edit Rule ) (RI!IIove Rules) [ Search ] 

Figure 35 

Let's see the resu1ts of putting this search rule into effect. 
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Step9 

Conducting an Step 1 
"And" search 

Step2 

Step3 

Click the "Search" button at the bottom of the screen. 

The "Search" box disappears and the data table reappears on the 
screen (Figure 36). But now, instead of including all of the places 
in the database, only the places in the Northeast appear. You've 
narrowed the database down to those places in which "Region 
equals Northeast." 

I c'l file Edi~ DbDlaB """ Da~a •• ,...~ 
Uatitled 

PI DO! Abbreviation. Postal llgrlcullural c ... odi Rsricullurol Yoh 
Connecticut Cl t88<. vogotobles (oi it 
Hoi no HE dair1 preduccs. pttat 
Hauachuntts HA vtsewbles (oimll 
Kew H•pshirt HH 4aU, products, Vf&et 
MewJers11 H Vt8'tt.obll5 C.iscell 
Mew York HY dairtoroducu, vtset $2 
PtiiRStlVOR I PA oirv produces. cenl $3 
Rhode Island Rl veget.oblt'i (liscell 
Ver1ant VI daira products. cattl 

¢ 

Figure 36 

You've just performed what is called a "simple search." A simple 
search involves only one search rule. 

But there are other kinds of searches you can perform as well. 
Let's add a second rule to the one we've already established. 

Select "Search" again from the Data menu. 

The "Search" box reappears. Note that the rule "Search for all 
places in which Region equals Northeast" is still in effect. 

Click on the "Add Rule" button. 

The "Add Rule" box reappears. This time, let's establish the rule 
"Population 1988 is greater than 5,000,000." 

Look through the scroll box (if necessary) until you find 
"Population 1988." Then select "Population 1988" by clicking on 
it. 
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Select the "is greater than" radio button. 

This time, instead of clicking "Show List" to choose from the 
available entries, let's enter the record comparison information 
directly. 

Type 5,000,000 in the record comparison information box. 

~y til~ w~}'; &S# 4()~·~ h~v~ i() enter ¢9mtrl@ ~ }arge #11rti~t$tr 
)'94 49n;tw®t m; 't@ ¢#tfY t'8#l4eli~¢*'\tll(lt9kk'Y tixih~ '\F'illli" 
commdfitlXth~ ffz@~fi!JiJ}} r;"f! pqg@$7-$$) (lppl'Jt9 th¢ XS¥aN:h'L 
co~&l 4S welt. x&ti shorita, 69We\I'¢#Be a.wweatth.e#itre~ent 

.· <litifb~s~ ~~le¢#9~$ tl1~~ ¢~# r@ijitfr8rif)IsiQgthe ''{l(}fia1s" all<l· · · 
·····;•¢oliiaips''• ()~~ators••<s~•page 124%···· 

Now that you've established your search rule, click OK. 

Search 
Search for oil plaoes where: 

The "Add Rule" box 
disappears, replaced by 
the "Search" box. Region equals Mortheast 

@And 0Dr 
Population 1988 is greater than 5,000,000 

Now "Population 1988 is 
greater than 5,000,000" 
appears as your second 
search rule (Figure 37). 

@ hpond too II places 
0 lillit to states only 

( Add Rub ) [Rrronge Rules] [ Cancel ) 

( Edit Rule ) (R<!Ilove Rules) [ Search D 0 lillit to current selection 

Step 7 

Figure 37 

Note that a pair of conjunctions, "And" and "Or," have appeared 
between your two rules. Radio buttons allow you to choose the one 
you want. The default conjunction is "And," so if "And" is what 
you want, you don't have to do anything. In this case, "And" is 
indeed what we want. 

By using "And," we establish the following "compound" search 
rule: "Search for all places in which Region equals Northeast and 
Population 1988 is greater than 5,000,000." The program will 
search for states that meet both criteria-not just one or the other. 

Click the "Search" button. 
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Conducting an 
"Or" search 

Step 1 

Step 2 

The "Search" box disappears, replaced by the data table. Now your 
current database selection has been narrowed down even further, 
including only those states in which "Region equals Northeast" and 
"Population 1988 is greater than 5,000,000." 

Select "Search" from the Data menu. 

When the "Search " dialog box appears, click on the "Or" button 
between the two search rules. 

Note that the "And" button automatically turned off when you 
clicked on the "Or" button. Each pair of "And" and "Or" buttons 
acts as a toggle switch. Only one can be turned on at a time. 

Starch 
Seoroh for all places •hero: 

Your search rule now reads, 
"Search for all places in 
which Region equals 
Northeast or Population 
1988 is greater than 
5,000,000." But before you 
click the "Search" button, 
look at the three radio 
buttons near the bottom of 
the screen indicating 
"Expand to all places," 
"Limit to states only," and 
"Limit to current selection" 
(Figure 38). 

R•sion eoquals Northeast 
0And @Or 

Po1>11latian 1988 is greater than tOOO.OOO 

® [xoand to all olacos 
0 Lioitto statts onl8 
0 li•it \o currrnt selection 

~(Arrange Rules)~ 

~ (Reoo•eRules)( Search J 

Figure 38 

If the "Expand to all places" button is selected, the program will 
ignore the results of any previous searches and search through the 
entire database in order to come up with the new database selection. 
If the "Limit to states only" button is selected, the program will 
search through all of the states but only the states, ignoring the six 
territories in the database. And if the "Limit to current selection" 
button is selected, the program will search only through the current 
database selection-no matter how narrow it is-in creating the 
new database selection. So the new selection cannot possibly be 
any larger than the previous one. Like "And" and "Or," these three 
buttons act as a toggle switch. 
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Step 1 

Step 2 

Step 3 
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"Expand to all places" is the button we want. That's the default 
button, so you shouldn't have to do anything with it right now. 

Click on the "Search" button. 

The "Search" box disappears, replaced by the data table. Your 
record selection has grown quite a bit, hasn't it? That's because 
you used an "Or" search. A place had to meet only one criterion to 
be part of the database selection, whereas with the "And" search, a 
place had to meet both criteria in order to be included. But always 
remember that, whether you conduct an "And" or an "Or" search, 
your search criteria will only be applied to the current database 
selection unless the "Expand to all nations" or the "Limit to states 
only" button is selected near the bottom of the "Search" box. 

... . . ... . . . ... . .... . .. 

WHat happens if yo~rseflrch. rule:slfarrow iJie datqb<ise diJWn to tid Lt 
records #ialtf-ihat is, if no pl(lc~s meet your cfit~ria? 1l!tfU:d case,. • • 

.... yqy' l{see hn alertbox tHat info~ you thaf"Your search did not •.·•. 
find (lhyplat¢$.'' When you click OKifl thts b{J~. the progr(1m · · 

... ieturnstd the "Search" screen,whefe yozlll·!J~ llbleto chahge 
yourrules. (See· f'Editi!Jl{ orR~ptaCing §earch Rules" (}npage 48.) 

We've now seen three different kinds of searches: simple searches, 
"And" searches, and "Or" searches. But there's still a fourth type 
of search to consider-the most complex type of all. 

Select "Search" from the Data menu. 

When the "Search" box appears, click the "Add Rule" button. 

Establish the rule "Borders does not contain Ocean." 

If you have difficulty doing this, go back and review the process 
used in establishing the two previous rules. 

You'll need to type the word "Ocean" in the comparison 
information box. 

Conducting 
searches that 
include both "And" 
and"Or" 
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Step 4 

f!!/ StepS 

Step 6 

Add Rule Once you've 
established the rule 
"Borders does not 
contain Ocean" 
(Figure 39), click 
OK. 

Stlt~tt the cottgon to uarch: Select therulttasesrchby: 
Rsian Population 

~ Qequol~ Odotsnotequol 
Birth loU• 

Ocontains @do•snotcontoin Block Pvpulation 
:o I ()is le-ss ~~on C!isr:~re-o~Mthon 

Capital 

I 
Obtains with Odounot buinYith 

tides Oends"ith Odotsnottndwith 
ClilateZonn Oisbrfart Oisafter 
CDa<allrte 

[ntrr thf c011parh11n inforHtien: 

Oceonl 
Units: none 

(Show list] ~ ~ 

Figure 39 

The "Add Rule" box disappears, replaced by the "Search" box. 
Now the search rule reads, "Search for all places in which Region 
equals Northeast or Population is greater than 5,000,000 and 
Borders does not contain Ocean." 

Change the first conjunction to "And" and the second conjunction 
to "Or." 

Now your search rule should read, "Search for all places in which 
Region equals Northeast and Population is greater than 5,000,000 
or Borders does not contain Ocean" (Figure 40). Also, check to 
make sure the active option near the bottom of the screen is 
"Expand to all places." 

Soorch 
Sur of! for all placos "hm: 

Reaion equals Northeast 
@And 0Dr 

Population 1188 is anotor t~an 5,000,000 
0And @Dr 

llordtrs dou nat contain Ocfan 

@ Exoond to all olacrs 
0 lillit to stales only 
0 lillit to current selection 

( Add Rule ) (Arrange Rules) ~ 

( Edit Rule ) (Re•ove Rules) ( Search ] 

Figure 40 

Click the "Search" button. 
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Step 7 

Step 8 

Step 9 
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The "Search" box disappears and the data table comes up. Use the 
scroll bars to look through it for a while. Notice that the current 
database selection includes Northeastern states with 1988 
populations over 5,000,000 plus any state or territory that does not 
border on an ocean. But if a state or territory doesn't fit one of 
these two descriptions, it doesn't appear. Do you understand why 
this is the case? 

'I-IeT¢;s ~\ret)' ii11wrt®truixt0t~ll1embei\\lh~ti using ·i;\rM" ~lld ~ 
.''()r'~.to~etl1er.il1.f6tnP()UJ14searchrt1tes:·······'An(j''·••rel~tio6ships •• rakf 1. 
preceJe~c~ ...... II1.othe_r \VO.rd~,.tllepf()}5ffilT1. pr-oups •• t??eth~r•aiiY•rules···· 
lirlke<l b)' ?A.A4'' }l~fote it@ce~ ()thyrr1Jlesjf1t()S<)llside!ftioo. ~.o, 
pec~l!~~ tile f'~xWfh R.IJI~s." ppxfead ~·§~cpJor aU pl~ces Jf1 
whicp Region yql1als No.rtll~w>t gnq gO}Jpl~tiop J9&8 is greater til® 
5,()()Q,OQ0pr l3o.r<Iyr~d~s llotcollWn()<:yap.» tile prpgrapft[s.t 

•...•.... foui1<I••<lll•plilces.that.met.bo.th.•gf. tllefii:~t·twgrutes••<\Vl1i<:h••I10.'Y .......• •••• 
J11qr¢ .o.rless b~ilaY~ as ~ .~ingle )Jlle)@d (JzeJT a£iqe4. all. place~ .. that 
metthe lhitd n.lle. < . . .. 

Let's see what happens when we switch the "And" and the "Or" 
around. 

Select "Search" from the Data menu again. 

When the "Search" dialog box appears, click the "Or" button for 
the first conjunction and the "And" button for the second 
conjunction. 

Click the "Search" button. 

When the data table appears, you may notice that your record 
selection is a bit different this time. Now your current database 
selection includes places with 1988 populations over 5,000,000 that 
do not border on an ocean plus all the states in the Northeast. Do 
you see why this change occurred? 

Again, the "And" relationship took precedence. The program first 
found all places that met both the second and third rule and then 
added all places that met the first rule. 

Now, what if you want to change any of the search rules you've 
already created? 
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Editing or 
replacing 

search rules 

Step 1 

Step 2 

Select "Search" from the Data menu. 

When the "Search" dialog box appears, click on the "Edit Rule" 
button at the bottom of the screen. 

Edit Rule 
Select o rule to edit: 

A dialog box now 
appears, allowing you to 
select the search rule 
that you wish to edit or 
replace (Figure 41). 

Reg1on equals ~ortheost 
Population 1988 is areow thon 5,000,000 
Borders do" not contoin Ocean 

Step 3 

Step 4 

Figure 41 

You can choose only 
one rule at a time to 
work with. 

Select the rule "Population 1988 is greater than 5,000,000" and 
then click OK. 

The "Edit Rule" dialog box, which is virtually identical to the "Add 
Rule" box, now appears. You can use this box just as you would 
"Add Rule," but in this case the newly created rule will replace 
your old rule with something different-either slightly modified or 
drastically changed, whichever you prefer. 

Create the new rule "Population 1988 is less than 5,000,000" and 
then click OK. 

The "Search" box reappears, looking just as it did before but with 
one difference: "Population 1988 is greater than 5,000,000" has 
been replaced by "Population 1988 is less than 5,000,000." 

Removing Now, what if you want to get rid of a rule altogether? 
search rules 

Step 1 At the bottom of the "Search" dialog box, click on the "Remove 
Rules" button. 

The dialog box that appears is very similar to the one you saw when 
you clicked on "Edit Rule" (see Figure 41), except in this box you 
can choose more than one rule at a time by Apple-clicking. 
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Step 2 

Step 3 

Select the rules ''Population 1988 is less than 5,000,000" and 
"Borders does not contain Ocean." Then click OK. 

An alert box appears, asking whether you're sure that you want to 
remove those rules. 

Click the "Yes" button. 

The "Search" box returns, now with only the "Region equals 
Northeast" rule. 

. ............................................................... . 

Wll~~ )'od l"JtrU')y~ seqfc}l rW¢s, ihg ~9~J~tncliq~srerruliHinl~#ir 
f)ffgzTt.qJqflJeb 1\Reftfmi?piftg rztles. )ilxri ~hr/414 eictfuWe tft¢ 
46iti#d#9h£ t9 irlJzk~ i'Jlrl tMlth~Y c(Jhforni t6 §6uri>U6i:i. 1JlheY 
t@ft't. #fuPlY ~eli:ct th~ £c/nJit#c#911§ yoiJ. lV(Jfl;t /;)et\<.'MH eticXr'Jlte.< 

There may be times when you'll want to rearrange the order of your search 
rules. For instance, if you've already created three rules and wish to add one 
more, the "Add Rule" button allows you to do so. Any rule you add at this 
point would come after your first three rules. But what if you want to link it 
by "And" to the very first rule? The easiest way to do this would be to use the 
"Arrange Rules" button in the "Search" dialog box. Let's try a simple 
procedure that demonstrates how "Arrange Rules" works. 

Step 1 

Step 2 

Step 3 

Step 4 

If the "Search" box isn't currently on the screen, select "Search" 
from the Data menu. If two or more rules aren't currently installed 
(for instance, if you've just now completed the previous activity, 
"Removing Search Rules"), go ahead and install several new rules. 

Click on the "Arrange Rules" button. 

The dialog box that appears is very similar to the one you saw when 
you clicked on "Edit Rule" or "Remove Rules" (see Figure 41). 

Move the cursor up to the scroll box and notice what happens. 

The cursor changes from the usual arrow to a 
"hand" (Figure 42) when it moves over this box. 

Decide which rule you wish to move and then 
click and hold down the mouse button while 
pointing at that rule. 

Figure 42 
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Limiting searches 
to the current 

database selection 

Step 5 

Step 6 

Step 7 

Step 8 

Note that the rule that you've "grabbed" in this way becomes 
highlighted in red. 

While still holding down the mouse button, "drag" the rule up or 
down to where you want it. 

When you've got the rule where you want it, release the mouse 
button. 

When you release the mouse button, the rule is no longer 
highlighted in red. 

If you wish, repeat this process as often as you wish, rearranging 
the rules as you see fit. 

Once you've finished putting the rules in the order you prefer, click 
OK. 

The "Arrange Rules" box disappears and the "Search" box 
reappears, now with the rules in their new order . 

... · .. ·. ·.·.· ·.··.·.· ·.··.·.·.· .... ·. ·.·.· ... ···.·.·.·.·.· .· .. · ... 

Aia.'.in,, .. n.o .. t.e. that1Ke iJrdetbJ the c()nJucttbns hils twtcha~ged) .. ·. ·.·.·. 
After rearrang{/{g /ulb, you shdWd cibs"e]yexarnfne thecon]u(;ticmi 
to frl{lke Sure. th(Jithiycdnforin tdydufwzsh"es. ··If they don' i, simply 
selectthe conjunctions you\ycmtbetween,eachrule, 

.·.·.· ·.·.·· ·.·.·.··· .·.· .. ·.·· . . .· .. ·.· .. ·.· .·.· .. ·.···· ... . . . .. 

So far, the searches we've conducted were applied to the entire database. Now 
let's see what happens if you limit a search to the current database selection. 

Step 1 

Step 2 

Step 3 

Your current search rule should be "Region equals Northeast" 
(from the preceding activity). If you're not sure that this is the 
case, go ahead and use "Search" to establish this as your database 
selection. 

Select "Display Map" from the Display menu. 

The data table is replaced by a map--whichever map you were last 
looking at. We want to see the Fifty States Map. 

If the map on the screen is not the Fifty States Map, select "Fifty 
States Map" from the Maps menu. 
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Step 4 

Step 5 

Step 6 

Figure 43 

Click on Hawaii. 

Notice that the 
Northeastern states are no 
longer highlighted. 
Instead, only Hawaii is 
highlighted (Figure 44). 
Hawaii is now the current 
database selection. 

USA GeoGraph User's Guide 

Notice how all of the Northeast is 
highlighted on the Fifty States Map 
(Figure 43). That's the USA 
GeoGraph "living map" in action 
again! The places that are part of the 
current database selection are always 
highlighted on the map. 

Figure 44 

Shift-click on Alaska and California. 

Figure 45 

Because you shift-clicked, you 
were able to select Alaska and 
California without de-selecting 
Hawaii. So all three states should 
now be highlighted (Figure 45) and 
should comprise the current database 
selection. (You did shift -click, dido' t 
you?) 

Now select "Display Data Table" from the Display menu. 

The Fifty States Map is replaced by a data table, which includes 
only the records for Hawaii, Alaska, and California. 
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Step 7 

Step 8 

Step 9 

Select "Search" from the Data menu. 

When the "Search" box appears, you'll notice that your old search 
rule, "Region equals Northeast," is still in effect. This is because 
the "Search" box is not necessarily a reflection of the current state 
of the database selection. Rather, it is a tool through which you can 
manipulate the database. If you were to click on the "Search" 
button at this point, with "Expand to all places" as the selected 
option near the bottom of the screen, the places described by your 
old search rules would once again become the current database 
s~lection, replacing Hawaii, Alaska, and California. That way, if 
you accidentally "wipe out" your current database selection with a 
careless click on the map, you can easily restore it by using calling 
up the "Search" command again. 

But let's not do that. Instead-

Replace the old rule "Region equals Northeast" with a new rule, 
"Population 1988 is less than 1,000,000," and return to the 
"Search" box, but don't click the "Search" button yet. 

If you don't remember how to replace a rule, you need to go back 
and review "Editing or Replacing Search Rules" on page 46. 

When you've created the new rule and returned to the "Search" 
box, select "Limit to current selection" near the bottom of the 
screen. 

Your screen 
should now look 
like Figure 46. 

52 

Search 
Search for all places where: 

Population 1988 is less thon UOO,OOO 

0 lxpond to oil place. 
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Figure 46 
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~ Step,.by-SteJ:)LoQk· afUSA GeaGraph··· 

Step 10 Now click the "Search" button. 

When the data table appears, you'll see that only Alaska remains as 
the current database selection. This is because you've limited your 
search to the database selection of Hawaii, Alaska, and California. 
Of those three, only Alaska has a 1988 population of less than 
1,000,000, so it became the sole entry in the current database 
selection. 

If you hadn't limited your search to the current database selection
using instead the "Expand to all places" option-the data table 
would have included all of the states and territories in the entire 
database with 1988 populations of less than 1,000,000. 

That should give you a pretty good idea of how the USA GeoGraph "Search" 
command works. It's now time to move on to some other useful database 
functions. 

As you've learned, you can select places by clicking on the map. But what if 
you know the name of a state or territory you're interested in but not its 
location on the map? Then, of course, you can use the search procedure, 
installing a rule like "Place equals Virgin Islands" to select that place. But (to 
complicate matters even more) what if you want to select a number of places
more than you can search for using the standard search procedure? In that 
case, you can use the "Select Places" command. 

Step 1 

Step 2 

Select "Clear Selection" from the Data menu. 

This is just to ensure that you '11 be working with the entire 
database. 

Now choose "Select Places" from the Data menu. 
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Step 3 

Step 4 

Step 5 

Figure 47 

The "Select Places" dialog box appears 
(Figure 47), allowing you to select as 
many places by name as you wish. 
Simply use the standard clicking 
procedures to select the states and/or 
territories you want to search for. 

Scroll through the box until you find "Guam" and then click on it. 

Guam is now selected. Let's add some other places to the selection. 
If you were to simply click on a different place, that state or 
territory would indeed be selected, but Guam would then be 
de-selected. So how do you select more than one place at a time? 

Apple-click on "Virgin Islands." 

Now both Guam and the Virgin Islands are selected. 

••• A.\' ldni/f#y(/4••1zqlrf•rfqwh thr ,f,.pjJle. f<:eY{&~e.n y()4••c!ick•in••this.bpx;· 
ybp, can. M.@qslrz(fnYftlacesfoYbAr {ldtaHa}fe. S~(e.'Cttbn WithoU/ 

·······qe-selectingdny}iVe."vt6lisly•sete2t~d.ones .. 

You can also select a range of places. Let's narrow the database 
down to only those places whose names start with "A". 

Scroll up to the top of the box and click on the first place, 
"Alabama." 

Keep in mind by simply clicking on "Alabama," you de-select your 
previous selections, Guam and the Virgin Islands. But that's all 
right-we want to do that. 
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Step6 

Step7 

Find Arkansas (the last place starting with "A'') and shift-dick on 
it 

Notice that all of the places between Alabama and Arkansas, 
inclusive, are now selected. 

Once you've selected all of the states and territories you want to 
work with, click OK. 

If you recall, 'way back on page 23 we promised that we'd tell you about the 
Map menu's "Contrast" command after covering "Search." Well, a promise is 
a promise-

Step 1 

Step2 

Step3 

If you're not currently looking at a map, select "Display Maps" 
from the Display menu. 

Select "Fifty States Map" from the Map menu. 

Select "Contrast" from the Maps menu. 

Contrast Hap 

~ Rulo 'A': Mo rule entertd. 

The dialog box that now 
appears (Figure 48) looks 
like a greatly simplified 
version of the "Search" 
dialog box. It allows you 
to create two search rules. 

~ Rule '8': No rulo entered. 

C1ncel ) ( OK J 

Figure 48 

With "Contrast," you can see displayed on a map all the states and/ 
or territories that meet one rule, all that meet a second rule, and all 
that meet both rules. (And, of course, all that meet neither rule.) 
Yet you can do this without affecting the database itself. In other 
words, although "Contrast" employs a "Search"-like interface, it 
does not make any database selections in the way that "Search" 
does. 
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Step4 

Step 5 

Step 6 

Step7 

Step 8 

Step9 

In the "Contrast" dialog box, click on the "Add" button next to 
"Rule A." 

The next dialog box that appears should be pretty familiar by now. 
It's our old friend, the "Add Rule" box (see Figure 32 on page 39). 
Use it to create the rule "Black Population is greater than 10%." (If 
you're not sure how to do this, you should review the "Search" 
instructions on pages 39-41.) 

When you've finished setting up the rule, click OK. 

The "Contrast" box returns, with your search rule, "Black 
Population is greater than 10.0%," appearing as Rule A. 

To set up your second rule, click on the "Add" button next to 
"Rule B." 

The "Edit Rule" dialog box reappears. This time, create the rule 
"Native American Population is greater than 1 %." 

When you've finished setting up your second rule, click OK. 

When the "Contrast" box returns, check to be sure that both rules 
are as you wish. Then click OK. 

The Fifty States map reappears on the screen, now with several 
colors. 

Pull down the Maps menu and select "Show Key." 

As the key indicates, states without shading are those that match 
neither rule. States shaded light green are those that match Rule A, 
"Black Population is greater than 10.0%." States shaded dark green 
match Rule B, "Native American Population is greater than 1.0%." 
And one state--North Carolina-is shaded orange, indicating that it 
matches both rules. In other words, North Carolina is the only state 
in which the black population is greater than 10% of the total 
population and the Native American population is greater than 1%. 
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In short, "Contrast" allows you to compare and contrast states and territories in 
a way quite different from the "Compare" command. For one thing, 
"Contrast" enables you to use textual categories as well as numeric ones, 
whereas "Compare" is limited to numeric categories. And it allows you to 
create a map based upon an "and/or" search concept, yet without affecting your 
database record selection. Feel free to experiment with "Contrast" for a while, 
setting up sets of rules of your own. The results are often fascinating. 

On the other hand, you may be ready to continue with our investigation of how 
the USA GeoGraph database works. Now that we've pretty much covered 
various kinds of search procedures, let's see how to go about sorting the 
database. 

Step 1 

Step 2 

Step3 

Select "Clear Selection" from the Data menu. 

By using the "Clear Selection" command, you make the entire 
database readily available. When you now examine the data table, 
all of the states and territories in the database should appear. 

If you're not already looking at a data table, select "Display Data 
Table" from the Display menu. 

Select "Sort" from the Data menu. 

Sort 
Se bet the category to sort by: 

The "Sort" dialog box appears on the 
screen (Figure 49). The scroll box 
allows you to select the category 
according to which you want the 
database sorted. Radio buttons also 
allow you to determine whether the 
database records will be sorted "From 
A to Z or 0 to 9" or "From Z to A or 
9 to 0." 

@From A to Z or 0 to 9 
0 From Z to A or 9 to 0 

( Sort J 
Figure 49 
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In short, the "Sort" command allows 
you to arrange the records in the 
database in alphabetical (A to Z), 
reverse-alphabetical (Z to A), 
numerical (0 to 9), or reverse
numerical (9 to 0) order according to 
the data within whichever category you 
choose. 
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Step4 

StepS 

Step6 

. lilo Edit 

no doto ovallo 

Step7 

StepS 

Step9 

Step 10 

Locate the "Population Density" category in the scroll box and then 
select it. 

Select "From Z to A or 9 to 0" ne ar the bottom of the dialog box. 

Click on the "Sort" button. 

···-· 1Foroio~Bo Poouloti111Bro 

'"' '"·" nedotoovoiloblo 
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Figure 50 

When the data table reappears, 
notice that the order of the 
records has changed. If you 
scroll horizontally over to the 
"Population Density" category, 
you'll see that the database 
records are indeed organized in 
reverse-numerical order, with 
the place with the highest 
number-that is, the place with 
the greatest population density 
-appearing first (Figure 50). 

Select "Search" from the Data m enu, establish "Population Density 
h rule, and begin the search. is less than 30" as the only searc 

If you don't remember how to do this, see "Conducting a Simple 
Search," beginning on page 39. 

When the data table reappears, y 
with population densities of less 
measurement in a moment) rem · 
but they're still organized in reve 
with the greatest population dens 

ou'll notice that only those places 
than 30 (we'll discuss units of 

am part of the database selection, 
rse-numerical order. The place 
ity less than 30 is listed first. 

tamenu. Select "Sort" again from the Da 

In the "Sort" dialog box, select th e category "Place" and the order 
"From A to Z or 0 to 9." 

Click on the "Sort" button. 

The resulting data table still lists only those places with population 
're now listed in alphabetical densities of less than 30, but they 

order. 
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Now, about those units of measurement-

There are 25 categories of data in USA GeoGraph that you can choose to 
express in either English or metric units of measurement: 

Data Category 

Area, Land 
Area, Total 
Area, Water 
Coastline 
Elevation, Average 
Elevation, Highest 
Elevation, Lowest 
Energy Consumption 

Energy Consumption per Capita 

Energy Production 

Energy Production per Capita 

Hazardous Waste Production 

Highway Mileage 
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English Units 

square miles 
square miles 
square miles 
miles 
feet 
feet 
feet 
trillions 
ofBTUs 
millions 
ofBTUs 
trillions 
ofBTUs 
millions 
ofBTUs 
thousands 
of tons 
miles 
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Metric Units 

square kilometers 
square kilometers 
square kilometers 
kilometers 
meters 
meters 
meters 
millions of 
megawatt -hours 
megawatt-hours 

millions of 
megawatt-hours 
megawatt-hours 

thousands 
of metric tons 
kilometers 

Determining units 
of measurement 
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Data Category English Units Metric Units 

Highway Usage miles kilometers 
per mile per kilometer 

Nitrogen Oxides thousands thousands 
of tons of metric tons 

Particulates thousands thousands 
of tons of metric tons 

Population Density people per people per 
square mile square kilometer 

Precipitation, Annual Average inches millimeters 
Recreation Lands square miles square kilometers 
Soil Erosion thousands thousands 

of tons of metric tons 
Sulfur Oxides thousands thousands 

of tons of metric tons 
Temperature, January Average degrees degrees 

Fahrenheit Celsius 
Temperature, July Average degrees degrees 

Fahrenheit Celsius 
Water Use for Irrigation millions millions 

of gallons of liters 
Water Use Per Capita gallons liters 

It's a simple matter to choose the system that you prefer to use. 

Step 1 

Step2 

Step3 

Select "Clear Selection" from the Data menu. 

Pull down the Data menu again and see which option is checked
"Show English Units" or "Show Metric Units." 

The option with the check mark by it is the active option. In other 
words, if "Show English Units" has the check mark by it, then 
English units are currently in use in the 25 categories listed above. 

If you want to use the other option, simply select it. 

The "Show English Units" and "Show Metric Units" options act as 
a toggle switch. Only one can be active at a time, so selecting one 
cancels the other. 
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Note that when you're using the data table format, uni_ts of 
measurement are always indicated in the column headings 
(Figure 51), but when you're using the data card format, they're 
always listed with the individual figures (Figure 52). 

Figure 51 

Annual Pas. Average: $23.81111 ~ 
Area. Land: 7.1168 squarniles llllr" 
Area. T ota 1: 7. 787 squaremil es 
Arta. Wattr: 319 square 11il es 
Asian Population: 1.11, 
Birth Rau: 111.11 per 1.000 pop. per year 

Figure 52 

How about manipulating the order in which data appears on the screen
changing the order of the data categories on data cards and tables? The 
procedure is quite similar to that for rearranging search rules. 

Step 1 

Step2 

If you're not currently viewing a data card, select "Display Data 
Cards" from the Display menu. 

It actually isn't necessary for you to be viewing data cards when 
you arrange categories, but it will make the immediate results of the 
arranging process a bit clearer. 

Select "Arrange Categories" from 
the Data menu. 

The "Arrange Categories" dialog 
box appears (Figure 53). It contains 
a scroll box that lists the names of 
the categories in their current order. 
Categories that you have chosen not 
to view through use of"Show 
Categories" are grayed out. 

Arranse Categories 
Drog categories to chooge order: 
Phce ~ Abbreviation, Postal 
Agricul turul c-odities 
Agricultural Value 
Airline Passengers 
Annual Pay, Average 
Area, Land 
Area, Total 
Areo. Water 
Asian Population 

(Cancel) (Restore) m 
Figure 53 
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Step 3 

Step4 

~ 
StepS 

~ Step 6 

~ 
Step 7 

~ Step 8 

Move the cursor up to the scroll box and notice what happens. 

The cursor changes from the usual arrow to a hand (see Figure 42 
on page 49) when it moves over this scroll box. 

Scroll through the box using the scroll bar. When you find the 
name of a category you'd like to move-"Population Per 
Physician," for example-click and hold down the mouse button 
while pointing at that category name. 

Note that the name of the category you've "grabbed" in this way 
becomes highlighted in red. 

While still holding down the mouse button, "drag" the category 
name up or down to where you want it. 

Notice how the box automatically scrolls when you reach its top or 
bottom edge, allowing you to move the category name to wherever 
you like. 

When you've got the category name where you want it, release the 
mouse button. 

When you release the mouse button, the category name is no longer 
highlighted in red. 

If you wish, repeat this process as often as you wish, rearranging 
the categories as you see fit. · 

But if you look at the data card "behind" the dialog box, you may 
notice that it hasn't changed yet to reflect your rearrangement. 
That's all right. It won't change until you click OK to indicate that 
the entire process is complete. 

Once you've finished putting the data category names in the order 
you prefer, click OK. 

The dialog box disappears and the data card on the screen is 
rearranged to reflect your changes in category order. If you wish, 
scroll through the card(s) to verify this fact. 

The changes you made will be reflected in the data table as well as 
in the data cards. 
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Step9 Pull down the Display menu and choose "Display Data Table." 

The data table appears and, as you can see, the categories appear 
horizontally, from left to right, across the screen in the same order 
as they appeared vertically, from top to bottom, down the screen on 
your rearranged data card. 

. . .. . ..................... " .......................... "''' .. ' .. 

Ify()# ever }Visht6 r¢stor~ the Or4W'? oJthW 9iJ.teiiJr~~s< to) th¢ }Vcfy 
thfFYffl!ri P.fiifn(Jl!)l(wlffiAYPUr 99ft)lof.JJ§ci Q?f!Qta[Jfl '}Vasfifst< 

•••i!Arc#(f.seiOH..owhic:fl W9~•W!rn••t~'(J?JtNlf''• ¢9£egofYf!r#t••.aff4•9zt•••···········. 
··••s1fbJgi[ll¢fti•(:Ate§9rtei••m aJiJl#f?eti¢iJ.t•§f4lf*'••••• "#e;lecftfle 'Mli"Mgg .. 
(;(lteg6fi¢~» (;ofn.lrlfln.dO..@#i#tea4ofusi#g tl;e ~cmltbc#. simply cliEk6n m~ "f&stoFe" b#tiM. · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · 

You may also be wondering whether you can change the width of the columns 
in the data table. 

Step 1 

Step 2 

If you're not currently viewing a data table, select "Display Data 
Table" from the Display menu. 

The command that allows you to change column widths, "Resize 
Categories," is active only when a data table is the current display 
on the screen. Otherwise, it's grayed out. 

Select "Resize Categories" from the Data menu. 

Resize Cote!]Cri!s 
Drag lines to rE"size categ~Jries: 

The dialog box that now 
appears allows you to 
change the width of data 
columns (Figure 54). It 
shows the column 
headings in their current 
order and width. 

Place Abbreviation, Pasta II Agricultural CaHadil Rgriculturall 
¢ ¢1 

(cancel) (Res taro) OD 
Figure 54 

A scroll bar allows you to "slide" across to additional headings. 
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Step 3 

Just as in the "Arrange Categories" box, the "Resize Categories" 
box shows categories not currently "active" for on-screen viewing 
as grayed-out headings. 

Move the cursor up to the headings in the box and move it about. 
Notice what happens when the cursor is located at or very near the 
"border" between two headings. 

The cursor changes from the "standard" arrow to a special 
"double-headed arrow" (Figure 55) when it moves near a 
line dividing two headings. 

Figure 55 

Step4 

StepS 

Step 6 

rt!f Step7 

Look through the box using the scroll bar. When you find a 
category heading that you'd like to resize-"Minerals and Fuels," 
for instance-click and hold down the mouse button while pointing 
at the ''border line" at the right-hand edge of that heading. 

Note that the heading you've "grabbed" in this way becomes 
outlined in red. 

While still holding down the mouse button, "drag" the right-hand 
edge of the heading to the right or left until it has the width you 
want. 

Dragging to the left makes the column smaller. Dragging to the 
right makes it larger. Note that there are maximum and minimum 
widths beyond which you cannot "stretch" or "compress" the 
column. Any category that contains more information than can be 
easily viewed on a data table, no matter how wide you make the 
column, is best viewed with data cards. 

When you've got the category width as you want it, release the 
mouse button. 

When you release the mouse button, the heading is no longer 
outlined in red. 

If you wish, repeat this process as often as you wish, resizing the 
columns as you see fit. 

64 ecopyright MECC 1989 
ThciiC mall:rials may not be reproduced in whole or 

in part without wrinml pctmission from MECC. 



USA GeoGraph User's Guide 

StepS 

But if you look at the table "behind" the dialog box, you may notice 
that it hasn't changed to reflect your resizing of columns. It won't 
change until you click OK to indicate that the process is complete. 

Once you've finished resizing the column headings, click OK. 

The dialog box disappears and the columns in the data table on the 
screen are resized to reflect your changes. You may wish to scroll 
through the table to verify this fact. 

Keep in mind that any changes you make to a data table using 
"Resize Categories" have no effect whatsoever on data cards. 
Because they have no columns, column width is irrelevant to data 
cards. 

The names of many of the data categories in USA GeoGraph are quite long
so long, in fact, that they often won't fit conveniently in the headings of a data 
table! That's why USA GeoGraph lets you abbreviate the category names in 
data tables. 

Step 1 

Step 2 

If you're not currently viewing a data table, select "Display Data 
Table" from the Display menu. 

The command that you're going to use next, "Abbreviate Category 
Names," is grayed out and thus "inactive" unless you're viewing a 
data table. 

Select "Abbreviate Category Names" from the Data menu. 
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Step3 

When the data table reappears, you'll notice that it reflects this 
change. The headings across the top of the table are now greatly 
abbreviated. If you wished, you could now use the "Resize 
Categories" command to decrease the width of the columns without 
obliterating the "uniqueness" of the headings. 

But as you examine the category abbreviations, you may be 
mystified by some of them. What does "EdHS" mean? What does 
"P15-" stand for? You need help! 

Select "Help" from the ti (Apple) menu. 

Click en tM •uttou llillllllll to obtain Hlpful i1f1,.oti01: 

The "Help" dialog box now appears 
(Figure 56). Notice the various 
types of"help" provided. By 
clicking on the appropriate button, 
you can obtain information about 
"Abbreviations," "Categories," 
"Clicking," "Search," and "USA 
Overall Data." 

( Abbnviatim ) ( Clickin1 

( Cat•aarios I S.•ch 

(USAOvoroli Data) 

For Mre detailH :illftrllllill. sH \he DSA &ea&riiDh User's &wide. 

Step 4 

.... 
Figure 56 

Abbreviations-Tells what each category abbreviation stands for. 

Categories-Briefly describes each data category. 

Clicking-Describes the result of various clicking actions. 

Search-Provides instructions for database search operations. 

USA Overall Data-Provides information for the United States 
overall (as opposed to the database's state-by-state information). 

Click on the "Abbreviations" button. 

..... 
lgC 

~:, 
IPap 
Arl 
lrT 
Rrtl 
lord 
BPop 
Ill c., 
Cit 
Clio 

lllbrNiatioo. Postal 
lgrie~lturtl C-.dit.i11 
Asriculturtl Vtltt 
lirlinePassenaen 
Ilion Papulation 
lrea,Land 
ltna,Toul 
Ana. !later 
larders 
Black Population 
lirtb late 
Capital 
Cities 
Clillate z,,., 

You now see an alphabetical list of 
the category abbreviations along 
with the full names of the 
categories they represent 

( Bock It Sltrl ) I llext ] 

(Figure 57). You can move from 
screen to screen, viewing the 
various abbreviations, by clicking 
on the "Next" button near the 
bottom of the screen. Figure 57 
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When you're finished examining the list of abbreviations, click on 
the "Back to Start" button. 

Click on the "Done" button. 

The "Help" box disappears. Let's say you're now finished with the 
data table. 

Select "Display Data Cards" from the Display menu. 

Because there's plenty of room on data cards for the full names of 
the data categories, the category abbreviations do not appear on the 
data cards. The "Abbreviate Category Names" command affects 
only data tables. 

Select "Display Data Table" again. 

Note that the category abbreviations still appear on the data table. 
They will continue to appear on data tables-and only on data 
tables-until you "turn them off." 

Pull down the Data menu and hold it for a moment without 
selecting anything. 

Notice that "Abbreviate Category Names" appears with a check 
mark next to iL The check mark indicates that the abbreviation 
feature is "on." The "Abbreviate Category Names" command 
functions as a toggle switch. When it's "off," selecting it will turn 
it on. When it's "on," selecting it will turn it off again. 

Step 10 Go ahead and select "Abbreviate Category Names." 

The data table reappears, now with the full category names (which 
may be partially obscured, depending on the current width of the 
columns). If you were not to pull down the Data menu again, you'd 
see that the check mark no longer appears next to "Abbreviate 
Category Names," indicate that it is now turned "off." 
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"Zooming in" on 
data fora 

particular place 

~ 
~ 

Wouldn't it be nice if, while you were looking at a data table, there were a 
quick, easy way to "zoom in" on data for a particular state or territory? Well, 
we wouldn't ask that question if there weren't. 

Step 1 

Step 2 

Step 3 

Select "Display Data Table" from the Display menu. 

When the data table appears, point your cursor at any item within 
the record for any particular place-such as the name of the state or 
territory itself-and then Apple-click or double-click. 

The data table disappears and is replaced by a data card for the 
place whose record you were pointing at when you Apple- or 
double-clicked. 

If you wish, you can now scroll through that card or to the cards for 
the other places in the current database selection. 

Now Apple-click or double-click anywhere on the data card. 

The data card disappears and is replaced by the data table for the 
current database selection. 

Note that option-Apple-clicking on a data table or card has exactly 
the same effect as Apple-clicking or double-clicking. No other 
variation on clicking with the mouse has any effect whatsoever on 
data tables or cards. Also, note that Apple-clicking or shift-clicking 
on a data table or card changes only your "view" of the data. It 
does not change the current database selection. 

So now you should know how the USA GeoGraph database and "living map" 
works. All of this may seem a bit overwhelming at first, but don't worry. As 
with any software, the more you use USA GeoGraph, the easier it gets. Before 
long, you'll be moving from one database function to another and from the 
map to the database and back again as if it were second nature. But we're not 
yet finished. There are still more features we haven't touched upon yet. Let's 
look at USA GeoGraph's graphing feature next. 
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USA GeoGraph lets you create graphs based on information in the database. 
Ordinarily, graphing can be an extremely tedious process. But with USA 
GeoGraph, it's a breeze. 

Step 1 

Step 2 

Step 3 

Select "Clear Selection" from the Data menu. 

The program will create graphs for the current database selection 
only. If you want to see graphs for all of the states and territories in 
the database, you should use the "Clear Selection" command before 
doing anything else. 

Select "Display Graph" from the Display menu. 

The "Graph" dialog box appears, allowing you to choose a data 
category to view in graph form (Figure 58). Only numeric 
categories can be depicted in graph form, so those are the only 
categories listed in this box. The categories are listed in 
alphabetical order. You can pick only one category at a time, so 
Apple- or shift-clicking has precisely the same effect as ordinary 
clicking. 

Display Graph 

Annual Pay. Average 
Area. Land 
Area. Total 
Area. Water 
Asian Population 
Birth Rate 
Block Population 

Figure 58 

Select "Birth Rate" and then click OK. 

©Copyright MECC 1989 69 lb.ese materials may not be reproduced in whole or 
in part without written permission from MECC. 

Exploring the 
United States 
with graphs 

Creating a graph 



USA GeoGraph User's Guide 

Arranging graphs 

The dialog box disappears and, within a few moments, the graph 
display screen appears (Figure 59). The information bar notes the 
type of data being graphed and the units involved. 

I (''; Fih Edit Display Mops Doto Report 

~0 Untitled 
Graph: Birth Rate Units: per 1,000 pop. per year 

40f-· . - - ·it 

20 ·---·-------------·---

10 . -· 1- -· --· ·-·-··· -·-···- ··--

0 AL AK AS AZ RR CA co CT DE 
("""~-ew-=-ca-t-eg-or-.y) ¢ 1 

Figure 59 

Because we had used "Clear Selection" before choosing "Display 
Graphs," birth rate data for all of the states and territories in the 
database has been graphed. But that's too many graphs to appear 
on one screen! So the scroll bars allow you to move horizontally or 
vertically, as necessary, to see all of the graphs. 

()11 g,-l1ph stfe~4s, tlz(J bffittlil/l1!odettel" t.r.s.J!Clstall1bb~evilliioft$ 
Cl.T~If~i4fq[tb~ltfJllF~ of{lt~ #qt~~ a:~4X¢tnJqf.ie§) TJ'Ja(~ b~~~e 
lli~i~ lli#'i¢#6ilih#X>m f()ftiJ~ f@fi@l~:> 9f IJ1()$i:PJ~ces. M9sf 
:1)1~2¢$ ¢~# J)~ I"¢~~t)' l<f~#tifi.~ fl"9iri i~~~~ abbr-~-vJap6ns, bijfiri 
4$~Y9G havWli<>iJJ)t¢ @Wl¢#ill#di#s lliefu,i¢feit9lli¢ l)'.s;t >· 
Q~()(;r#}JIJ ~tap~~ ¢#f¢g()J:}' Ptt¢9 f'j\J)bie~'@ygp, };'g§fil." < 

What about the order in which the graphs appear? That depends on how the 
data was last sorted when you were using the database. If, for instance, you 
had last sorted on the basis of the "Precipitation, Annual Average" category, 
the "Birth Rate" graphs would appear on the screen in a seemingly nonsensical 
order. But that can be easily fixed. 

Step 1 Select "Sort" from the Data menu. 
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The "Sort" dialog box appears 

tura 
Agricultural Value 
Airline Passengers 
Annuo I Pay, Average 
Area, land 

(Figure 60), allowing you to choose the 
category according to which you want 
the graphs arranged. 

If you want the graphs to appear in 
alphabetical order as determined by the 
"Place" category, you should select 
"Place" and "From A to Z or 0 to 9." If 
you want the graphs to appear in 
ascending order on the basis of birth 
rate, you should select "Birth Rate" and 
"From A to Z or 0 to 9." And if you 
want the graphs to appear in 

Area, Total 
Area, Water 

@From A to Z or 0 to 9 
0 From Z to A or 9 to 0 

Step 2 

[ Sort J 
Figure 60 

descending order on the basis of birth 
rate, you should select "Birth Rate" and 
"From Z to A or 9 to 0." Let's try this 
latter option. 

Select "Birth Rate," click on the radio button for "From Z to A or 
9 to 0," and then click the "Sort" button. 

The "Sort" box disappears and, in a few moments, the graphs 
reappear, now arranged in the order you selected (Figure 61). Note 
how the graph format makes the descending order immediately 
apparent. This is one example of how graphs can convey and 
contrast numeric data with far greater impact than mere figures in a 
table. 

I (~'· File Edit Display Haps Data Report 

ii!D Untitled 
Graph: Birth Rate Units: per 1,000 pop. per year 

~ 0 ,_,_,_,_,_,_,_,_,_,_,_,_,_,_,_,_,_,_,,_,_, ___ ,_,_,_,_,_,_,_,_,_ .. _ .. _ .. _ .. _ .. _,_,,_,_,._.,_ .. _ .. _,_,_, ~ 

1 0 . ,_,_,_ _,_ .. _ -.. -.. -· _,_, 

AS HP AK GU UT VI PR MH TX 

(Me" Category) ¢I 

Figure 61 
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Applying the 
living map concept 

to graphs 

Step 1 

Step 2 

Step 3 

Step4 

Step 5 

Select "Display Map" from the Display menu. 

If you're not currently viewing the Fifty States Map, select "Fifty 
States Map" from the Maps menu. 

When the Fifty States Map appears, click on Alaska and then shift
click on the Texas so that both Alaska and Texas are highlighted 
(Figure 62). 

Figure 62 

Alaska and Texas are now your current database selection, so any 
graphs you now create will pertain only to those two states. 

Select "Display Graph" from the Display menu. 

When the "Graph" box appears, select "Area, Total" and then click 
OK. 

I ~~} Filf Edit DisJlas Maps Data Roort. The box disappears, replaced 
by a simple pair of graphs 
comparing the area of Alaska 
to that of Texas (Figure 63). 
Without even looking at the 
figures, you can immediately 
tell that Alaska is more than 
twice as large as Texas. 

0 UAtitl!d 
&raph: Arta. Tot Ill Units: SQuarr ailts 

600.001 ·--·-· ------- ----------------------- i) 

5oo.m
lij!O,m 

aoo.m 

m.m
w.m-

O AK IX 
~ (H~Catoea") h¢~-------------------..¢~ 

Figure 63 

Note that the scroll bars are inactive. Because you're only creating 
graphs for two states, there's nothing for you to scroll to! 
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Step6 

Step7 

Click on "New Category" in the lower-left comer of the scieen. 

If you wanted to change the selection of states referred to in this 
graph, you could do so by using, for example, the "Search" 
command. But the ''New Category" button gives you a quick, easy 
way to change the data category upon which the graph is based 
without having to go through the process of pulling down the 
Display menu and selecting "Display Graph" all over again
although if you wanted to, you could do that, too. 

When the "Graph" box appears, select "Population Density" and 
then click OK. 

The new pair of graphs that appear allow you to quickly and easily 
compare the population densities of Alaska and Texas. 

So that's a look at the graphing capabilities of USA GeoGraph. Feel free to 
experiment On the other hand, you may now want to investigate the "Display 
Distribution" command, which no doubt you've noticed on the Display menu. 

Perhaps you're curious about how "similar" or "different" the states and/or 
territories in your current database selection are. At your command, USA 
GeoGraph will automatically examine the records of a group of states and 
territories and report how entries are "distributed" among those places. If this 
isn't clear to you, don't worry-we'll explain. 

As with graphing, USA GeoGraph's "Display Distribution" feature works 
only with the current database selection. Also, "Display Distribution" works 
only with the data categories currently selected for viewing with the Data 
menu's "Show Categories" command. In this way, the program will concern 
itself with only the categories you're interested in. But if you're not sure what 
kinds of data matches you may fmd within a particular group of states and 
territories or if you have no particular category focus, you may want to use 
"Show Categories" to be sure that all of the data categories are "active." The 
primary disadvantage to viewing all of the categories while using this feature is 
the "unwieldiness" of the resulting distribution tables. That is, it provides so 
much information that it can be intimidating. Still, you are the best judge of 
how many categories you should view simultaneously while using the 
"Display Distribution" feature. 
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Now, let's see how "Display Distribution" works. 

Step 1 

Step2 

Step3 

Step4 

Looking at the Fifty States Map, either click/shift-click on all the 
states in the South or pull down the Data menu and use "Search" to 
create and implement the rule "Search for all records in which 
Region equals South." 

In short, narrow down the database to the Southern states. 

Select "Display Data Cards" from the Display menu. 

This is simply to activate the "Show Categories" option so that you 
can perform the next step. 

Pull down the Data menu and use "Show Categories" and Apple
clicking to select the following ten categories for viewing: 

Agricultural Commodities 
Black Population 
Capital 
Education Expenses Per Pupil 
Education, College 

Per Capita Income 
Place 
Precipitation, Annual Average 
Region 
Temperature, January Average 

For the time being, working with this relatively small number of 
states and categories will make it easier to show you how USA 
GeoGraph's distribution analysis feature works. 

Pull down the Display menu and select "Display Distribution." 

Display Distribution 
Displa~ distribution table for currently active: 
@numeric categories 

The "Display Distribution" 
dialog box appears (Figure 64), 
allowing you to choose whether 
you want to see the textual or 
numeric categories within your 
currently "active" set of data 
categories. "Display 
Distribution" cannot work 
simultaneously with both textual 
and numeric categories. You 
must choose between them. 

0 textual categories (entries that 
appear [fi] or •ore times in the current 
database selection of 17 places) 

(Cancel) [ OK ) 

Figure 64 
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If you choose to work with textual categories, you can also 
designate the minimum number of times an entry must appear in a 
category for it to be reported. You may enter any number from 1 to 
99. The default setting is 2. 

Click on the "textual categories" button and leave the "number of 
appearances" setting at its default value, 2. Then click OK. 

I <'! file Edit Bisolot Haas Data Report The dialog box disappears 
and the textual distribution 
table appears (Figure 65). 
Of the ten "active" data 
categories, four are textual: 

[J Untitled 
Categor11 Entry 
Place 
Agricult.ural CoModitin cattle 
Agricult.urol CoModitit~s cotton 
Agricultural Ca111oditin dairy products 
Asricvlt.urol CoModitits esu 
Agricultural Co1111oditieos fruits and vevetobles (Jtiscelloneou 
Agricultural Co~~toditits punuts 
Aariewlturol Co11110ditits aaultra 
Agricultural Co10oditits so beans 
Agricultura I Ca111adit1ts susorcont 
Agricultural Ca111oditits tobacco 
Agricultural Co•editieos vegetables (llisc•llanPous 

ap tt 

~I 

Figure 65 

Ploces 
lila 0 

13 of17 
3 of 11 
I of 17 
2of 17 
21111 
2of 1 

1hf17 
7of11 

• 
~0!17 
3of11 

nla .(} 
¢ 

"Place," "Agricultural 
Commodities," "Capital," 
and "Region." But note 
that, for "Place" and 
"Capital," "n/a" ("not 
applicable") is listed 
because those categories 
consist entirely of unique 
entries. 

If no "matches" are found in any other "active" textual category, 
the line following the name of that category is left blank. 

The categories are listed in their current database order, which you 
can change, if you wish, by using the "Arrange Categories" 
command. The scroll bar on the right side of the screen allows you 
to scroll up and down to see the entire table. 

For "Agricultural Commodities" (which lists four agricultural 
products that are among the most important to a state's economy), 
the program reports that the item "cattle" appears for thirteen of the 
seventeen states in the South, that "cotton" appears for three of 
them, that "dairy products" appears for eight of them, and so on. 
Note that the table doesn't provide the names of the states in which 
these matches occur-only the number of matching entries. 
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~ Step6 

Step7 

Also note that items appearing only once in a category within the 
current database selection are not reported because you used the 
default setting of two or more appearances. In this case, the textual 
distribution category only reports items that appear at least twice. 

Note that the distribution analysis reports that all seventeen of the 
selected states list "South" in the "Region" category. This is, of 
course, to be expected since the search criterion for selecting these 
states was "Region equals South." 

Now let's look at those numeric categories. 

Pick "Display Distribution" from the Display menu once again. 

The "Display Distribution" box returns. 

Click on the "numeric categories" button and then click OK. 

I • FiLt Edit. Di1ph!J 1a111 lalt lotrt. The dialog box disappears 
and, after the program 
completes its analysis, the 
numeric distribution table 
appears on the screen 

D Untitltd 
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(Figure 66). As you can see, 
it's quite different from the 
textual distribution table. 
Rather than look for exact 
matches as it does for textual 
data, the program reports 
where the numeric data for 
the current database selection 
falls within U.S. deciles for 
each "active" category. 

These U.S. deciles are similar to the quartiles used for the "USA 
Quartiles" maps, except instead of dividing sets of data into four 
equal parts, it divides data into ten equal parts. 
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StepS 

Look at the "Black Population" category. The table reports that of 
the seventeen places in the current database selection, five of them 
rank in the highest U.S. decile for black population, five rank in the 
second-highest U.S. decile, three in the next-highest, and so on. 
Note that while the program is reporting on the decile placement of 
only seventeen states, it considers the entire United States in 
creating those deciles in the first place. 

As you can see, the table simultaneously reports the program's 
fmdings for the other five "active" numeric categories as well. 

To exit from the numeric distribution table (or from the textual 
distribution table, for that matter), simply choose whichever other 
option from the Display menu you prefer, such as "Display Map." 

Now, you may be thinking that this "Display Distribution" feature is very 
interesting, but what good is it? Well, it serves as a very convenient aid in 
searching for patterns among states. In our example of the Southern states, 
you know that the states in the current database selection have at least that 
much (being in the South) in common. If you then were to use "Display 
Distribution" to discover other correlations-such as the frequent appearance 
of a certain type of agricultural commodity or an unusually large number of 
these states appearing within the lowest deciles of the college education 
category-you'd have evidence of some potentially meaningful patterns. 
Because apparent correlations can be "accidental" as well as meaningful, it 
would be a mistake to jump to any conclusions. But such "preliminary" 
fmdings can provide valuable "jumping-offpoints" for further research and 
discussion, which may even lead to more definitive conclusions. 

By now you've gone through many different activities with USA GeoGraph. 
Maybe you've felt frustrated that you haven't been able to save and print out 
the fruits of your labors. But you can save and print the results of your work 
with USA GeoGraph! That's what comes next. 

iCICcJpyrigbt MECC 1989 
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Creating reports Anything that you do with USA GeoGraph-any map, data table, set of data 
cards, set of graphs, or distribution table that appears on the screen-can be 
saved and printed out. You do this by creating a "report." 

Adding a section 
to your report Step 1 

Step 2 

If you're not viewing the Fifty States Map already, select "Display 
Maps" from the Display menu (if necessary) and then "Fifty States 
Map" from the Maps menu. 

Use "Search" to create the rule "Region equals West." Then 
conduct the search. 

The Western States should now be highlighted as your current 
database selection. 

Pull down the Report menu (Figure 67) and select "Add Section." 

Figure 67 

You might wonder, "Add section? Add a 
section of what to what?" But the first 
step in creating a report is to create a 
"section" of that report, which is done 
with the "Add Section" command. 
Whatever was on the screen when you 
selected "Add Section" is going to be the 
first section in your report. 

ThirJk ofq ''section'' (lS a speci/icipo1rl£:ntint#e hisrowofyoUr use 
.... ofQSA.••¥£:£1y'l1P'P If~ a.••\Ya.y •• pf''sa.virig''••asett.ai•l•rnap,•tiata' 
···•talJ1x···orsom~.thi1lgxl~>x.tliat.x()p'yesn:aiedthatyotJffiight··wanJ.•to 
printqutot come backwla.ter. · .. · · ·. · 

At any rate, when you select "Add Section" from the Report menu, 
the "Add Section" dialog box appears (Figure 68). 

Add Section 
Enter section name: 
lulitnulll 

( Cance 1 ) ( OK ) 

Figure 68 
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Step4 

Step 5 

Step6 

Step7 

StepS 

Enter a title for the first section of your report. (This title· can 
consist of no more than twenty characters.) 

Your title should be clear and accurate so that you'll know exactly 
what it refers to. Something like "West Selected" would do nicely. 

Click OK. 

The dialog box disappears and you're right back to the screen you 
were looking at before you used the "Add Section" command 
What happened? 

Pull down the Report menu but "hold" it for a moment, without 
selecting anything. 

Note that the title of your new report section has been added to the 
end of the Report menu (Figure 69). This menu grows in length as 
you add sections to your report In a few minutes you'll see what 
happens when you select a title from this menu. But let's first add 
some more sections to the report. 

Add Section... a+ 
Replace Section .. . 
Remove Sections .. . 
t•Jes t Se 1 ected [j 

Figure 69 

Select "Theme Map" from the Maps menu. 

When the "Theme Map" dialog box appears, select "Physiographic 
Regions" and then click OK. 
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Step 9 

Step 10 

Step 11 

The "Physiographic Regions" map now appears on the screen. If 
you wish, select "Show Key" from the Maps menu to see what the 
various colors mean. Notice, however, that the Western States are 
still highlighted because they're still the current database selection. 
If you wish to see the physiographic regions in the West, you can 
choose the "Clear Selection" command, which eliminates the 
highlighting so that the screen will resemble Figure 70. Choosing 
"Undo" from the Edit menu immediately afterward will restore the 
West as your database selection. 

Figure 70 

Select "Add Section" again from the Report menu. 

Follow the same procedure as you aid before (see Steps 4 and 5 on 
page 79) to assign a title to this new section and to add it to your 
report. 

Create and add several more sections to your report, up to the 
maximum of ten. You can add whatever kinds of sections you 
like-----theme, comparison, contrast, quartile, or equal steps maps, 
data tables, data cards, graphs, whatever. Explore! 

........................................ '' '"'''"'' , ............... ---------------- ............... , ..... . 
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After you've added a number of sections to your report, you may want to go 
back and look over what you've created. 

Step 1 

Step2 

Step 3 

Step 1 

Step2 

Pull down the Report menu and select "West Selected" (or 
whatever you called your frrst section). 

The section that you selected now appears on the screen. In a 
manner of speaking, you've "gone back in time" to when you 
created this report section, although any other report sections you 
created since then are still "saved." At this point you may proceed 
to use USA GeoGraph as usual, changing the screen, performing 
other activities, or creating other reports as you see fit. 

Perform any simple action that will change the screen, such as 
selecting a different type of display (going from maps to data or 
vice versa). 

Now pull down the Report menu and select the same section title 
that you chose in Step 1. 

That same report section reappears, just as it did after you 
completed Step 1-unchanged! Once again, you've "gone back in 
time" to when this section was frrst created. So this section truly is 
"saved." 

But what if you want to change one of your report sections so that 
when you select it from the Report menu, the "new, improved 
version" appears? 

Select from the Report menu a section of the report that you want to 
change. 

Step 1 isn't really necessary, as you'll see in Step 3. But if you 
want to make relatively minor changes to a report section, it's 
probably easiest to start with that section. 

When the report section appears, go ahead and make whatever 
changes you like. 

For instance, change it from a map to a data table or from a 
comparison map to a quartiles map, or change your current 
database selection. 
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Step3 

r!!/ Step4 

~ r!!f StepS 

Select "Replace Section" from the Report menu. 

The "Replace Section" dialog box appears (Figure 71). 

Replace Section 
Se ltct section to rep I ace: 

Phys Regions ~ Population Graph 
Precip Hap 
West Seltcted 
West Table 

~ 
(Cancel) (Replace) 

Figure 71 

Select the title of the report section that you want to replace with 
your "revision" and then click the "Replace" button. 

Another dialog box appears, asking you to give your new section a 
name. You have the option of keeping the name of the section 
that's being replaced, but let's not do that right now. 

Enter a new name for your new report section and then click OK. 

The dialog box disappears and your screen looks as it did before 
you selected the "Replace Section" command. If you were to pull 
down the Report menu now, you would notice that the report 
section that you wanted to replace is indeed replaced by a new 
section. 

As noted just after Step 1, you don't even have to first select a 
report section in order to replace it. You can select "Replace 
Section" at any time after you've created at least one report section. 
Then you would simply follow Steps 3-5 in order to replace any of 
your existing report sections with whatever was on your screen 
when you selected the "Replace Section" command. 

What if you want to remove a section altogether, not replacing it 
with anything? 
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Step 1 

Step 2 

Step3 

Select "Remove Sections" 
from the Report menu. 

The "Remove Sections" 
dialog box appears 
(Figure 72). 

Select the title of the section 
that you want to remove from 
the report and then click the 
"Remove" button. If you 
wish, you can use Apple- or 
shift -clicking to remove more 
than one section from the 
report simultaneously. 

Re11ove Sections 
Select sections to re11ove: 

Phys Regions 
Population Graph 
Precip Hap 
West Selected 
West Table 

Figure 72 

After you click "Remove," an alert box appears, asking whether 
you're sure that you want to remove those report sections. 

Click on the "Yes" or "No" button, whichever you prefer. 

Now that you've created your report, you may want to do some printing. 

USA GeoGraph allows you to print two different things: reports (all or in 
part) and windows. Let's see how you'd go about printing a report. 

Removing a 
section of your 
report 

~ 
~ 

Printing 

You won't have to go through all of the Printing a report 

age Setup ... 
Printing Options ... 
Print Report... li R 
Print Window... liP 

Quit 

Figure 73 

following steps every time you want to print a 
report. Once you go through this procedure, the 
settings you establish will remain in effect until 
you change them. But the first time you use USA 
GeoGraph, all or most of these steps will be 
necessary. 

Step 1 Select "Choose Printer" from the 
File menu (Figure 73). 
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Step2 

Step3 

The "Choose Printer" dialog box 
appears (Figure 74), allowing you 
to designate the type of printer and 
printer port you'll be using. 

Make the appropriate choices in 
the "Choose Printer" box and then 
click OK. 

Choose Printer v2.2 
Printer Type: 

LASERWRITER 
EPSOM 

Printer Port: 

HODEH 
PARALLEL.CARD 

iJ 

~ 
iJ 

~ 
0 AppleTalk @Direct Connect 

If you have difficulty with your 
printer or are unsure how to use it, 
see your Apple IlGs and/or printer 
instruction manuals. 

Um N•e: 1 !!i!jljll•jll!ilm 

U!illD ( 

Figure 74 

Select "Page Setup" from the File menu. 

I 
OK ) 

The "Page Setup" dialog box appears (Figure 75 if you chose 
"LaserWriter" in Step 2; Figure 76 if you chose "Image Writer"). 
The printer and printer port that you had designated with the 
"Choose Printer" box are listed at the top of the "Page Setup" box. 

LaserWriter 112.2 lHAGEWR ITER/PRINTER 112.2 
Paper: @US Letter 0 A~ Letter 

0 US Legal 0 85 Letter 
Orientation: Vertical Sizing: 

@Mor~~al 
0 Inter1ediate 
0Condensed 

Printer Effects: Reduce or 
l2l Smoothing? Enlarge: !fiJ, 
l2l Font Substitution? 

(Concei](D 

Figure 75 

Paper: @US Letter 
OUS Lesal 
OA~ Letter 
0 International Fanfold 

Vertical Sizing: 
@Nor11al 
0Condensed 

Orientation: 

Printer Efftcts: 
0 50\ Reduction 
0 No Gaps BetNeen 

Pages 

Figure 76 

The "Page Setup" box allows you to designate the paper size that 
you'll be using, the vertical sizing of the print (normal or 
condensed), the orientation of the pages (vertical or horizontal), and 
other special printer effects, such as reduction or enlargement. 
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Step 4 

StepS 

Make the appropriate choices in the "Page Setup" box and then 
click OK. 

Select "Printing Options" from the File menu. 

Printing Options 

Nome: ln101:11mbll 
181 Print page n1111bers 
181 Print date 

The "Printing Options" dialog box 
appears (Figure 77), asking you to 
give your report a name (if you wish) 
and to designate whether you want 
page numbers, the current date, the 
report name, and/or map keys to 
appear on the printed pages. 181 Print n•e 

181 Print •op keys 

(Cancel) ( OK J 
Figure 77 

Step6 Make the selections you want and then click OK. 

Step7 Select "Print Report" from the File 
menu. 

The dialog box that appears 
(Figure 78) allows you to specify 
which sections of the report you 
wish to print. The default setting is 
for all sections of the report to be 
printed. If you want to print just 
some of the report sections, you must 
de-select the ones you don't want to 
print. 
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181 Phas Regions 
181 Populotion Graph 
181 Preoip Map 
18111est Table 
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StepS Once you've made the appropriate entry and/or selections, click 
OK. 

A second dialog box now appears (Figure 79 if you chose 
"LaserWriter" in Step 2; Figure 80 if you chose "ImageWriter"). 
As in the ''Page Setup" box, the printer and printer port that you 
had designated with the "Choose Printer" box are listed at the top. 

LasuWriter v2.2 
Pages: @All 

0 Fr011: D To: D 
Copies:[[] IMAGEWRITERIPRIMTER 

Quality: 0 Better Tl!xt 
@Better Color 
ODraft 

v2.2 

Paper Source: 

Step9 

@Paper Troll 
0 Manual Feed 

(Cancel)(]) 

Figure 79 

Page range: 
@All 

0 Fr011: D To: D 
Copin: [![] 
Paper Feed:@ Automatic 0 Manual 

DColor 

Figure 80 

This dialog box provides you with control over such things as print 
quality (better text, better color, or draft), paper feed (automatic or 
manual), and the number of copies that will be printed. The page 
range setting is ignored. 

If you have a color printer with a color ribbon, you can check the 
"Color" box in the lower-left comer of the dialog box in order to 
print in color. 

When you've finished making appropriate selections, click OK to 
begin printing. 

And the printing of all or part of your report begins. 
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In addition to printing report sections, you also have the option of printing Printing a window 
whatever is currently on your screen, regardless of whether you have made it a 
part of your report. 

Step 1 

Step2 

Select "Print Window" from the File menu. 

The "Print Window" dialog box appears. If it looks familiar, it 
should-it's identical to the second "Print Report" box (see 
Figures 79 and 80 on page 86). And it's used in precisely the same 
way. Again, the page range setting is ignored. 

When you've fmished making appropriate selections in the "Print 
Window" box, click OK to begin printing. 

And the printing of the item that is currently on your screen begins. 
The same two important points noted above about printing a report 
apply to printing a window as well. 
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Saving, closing, Let's say you're all done using USA GeoGraph. What do you do? How do 
opening, and you get out of the program without all of your hard work going to waste? And 

quitting how, if you wish, can you save the work that you've done? 

Saving a It's already a computing cliche, but it bears repeating: 
document 

You never can tell when something will go wrong-anything from a hardware 
or software problem to a power blackout-that will cause your computer to 
lose everything stored in its memory. If you've been using your computer for 
a long time without saving, a lot of your valuable time can go to waste. But if 
you save your work often, maybe every ten minutes or so, then you'lllose only 
the work you've done since the last time you saved. 

Step 1 Pull down the File menu and select "Save As." 

If your document has not yet been saved, selecting "Save" will have 
the same effect as selecting "Save As." 

The "Save As" dialog box appears (Figure 81), allowing you to 
assign a name to your USA GeoGraph document. Give it a name 
that will help you remember what you've done or created with it so 
that later you can easily find the document you want. But don't 
choose a name that's being used for some other document. 

® /USA.GEOGRAPH/ 
Free: 168k out of BOOk. ( Disk ) 
D Fl!IOER.IUIHI ~ ( New Folder ) 
D FlHOf.R.tiEf 
D FlHOf.R.ROOT ( O~P.n ) 
D ICONS 
·:~ PRODOS !( Cl<IS4! ) 
D PRODUCl.IIIFO 

) Enter document nome: ( Save 

I~ I c Cancel ) 

~ Step2 

Figure 81 

Type a name for your document. 

If you don't give your document a name when you save it, it will be 
called "Untitled." 
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Step 3 

Step4 

There isn't room on either USA GeoGraph disk (the Program Disk 
or the Information Disk) to store more than one or two documents, 
so to save it you may have to use a formatted data disk. (See 
Appendix B, "Creating and Using a Data Disk with USA 
GeoGraph," for instructions on creating a data disk.) 

If you're using only one disk drive, eject the Program Disk and 
insert your data disk. 

If you're using two disk drives, eject the Information Disk in 
Drive 2 and insert your data disk. 

First click the "Disk" button and then click the "Save" button to 
save your document to your data disk. 

The "Save As" dialog box disappears and your document is now 
saved on your data disk under the name you gave it. 

If you wish, you may continue working with that document, saving 
any subsequent versions under the same name by using the "Save" 
command from the File menu. 

When you close a document, you exit from that document without exiting the 
USA GeoGraph program itself. You can then quickly and easily open a 
different USA GeoGraph document. 

Step 1 Select "Close" from the File menu. 

If your document has not yet been saved or if you have made 
changes to it since the last time it was saved, the program will ask 
whether you want to save before proceeding. 
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Step2 

Opening an Step 1 
existing document 

from within the 
program 

Step 2 

Step 3 

If the program asks, indicate whether you want to save your 
document. 

Your document then closes and the screen goes "blank" without 
returning to the desktop "Finder" program. But because you 
haven't left USA GeoGraph itself-only one particular document 
created with it-the USA GeoGraph menu bar remains at the top of 
the screen. Several of the menu items are grayed out because they 
are currently inactive. The ti and File menus, however, are still 
active. If you wish, you can now go ahead and open a different 
USA GeoGraph document, reopen the one you have just closed, or 
create a new one from scratch. 

Select "Open" from the File menu. 

The "Open" dialog box appears (Figure 82). Its scroll box lists any 
USA GeoGraph documents that may be saved on the disk that is 
currently active. An existing USA GeoGraph document would 
probably have been saved on a data disk. 

Select file to open: 
(g) /USA.GEOGRAPH/ 

DICOHS r!1 
D SEARCHHElP 
DSYSUM 

( 

( 

Disk ) 

Open ) 
Cli>S~ ) 

.() ( Concel ) 

Figure 82 

If you are using one disk drive, eject the Program Disk and insert 
the data disk containing the USA GeoGraph document that you 
wish to open. 

If you are using two disk drives and the data disk containing the 
document you wish to open is not in the second drive, eject 
whatever disk may be in the second drive and insert the appropriate 
data disk. 

If the contents of your data disk have not yet appeared in the scroll 
box, click the "Disk" button. 
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Step4 Select the name of the document you wish to open and then click 
the "Open" button. 

The document you selected opens. It appears exactly as it was 
when it was last saved. You may now proceed to work with it, 
printing reports or changing it as you see fit. 

If you've finished using USA GeoGraph for the time being and do not wish to 
open another USA GeoGraph document, you should use the "Quit" command. 

Step 1 

Step2 

Step3 

Select "Quit" from the File menu. 

If your document has not yet been saved or if you have made 
changes to it since the last time it was saved, the program will ask 
whether you want to save before proceeding. 

If the program asks, indicate whether you want to save your 
document. 

Your document then closes and you exit from USA GeoGraph. 
The screen returns to the desktop "Finder" program. 

If you're using one disk drive, close the window to whichever USA 
GeoGraph disk is currently active (most likely the Program Disk) 
and then drag the disk icon to the desktop "trash can," thus ejecting 
the disk. 

If you're using two disk drives, drag the icons for both USA 
GeoGraph disks (or for one of the disks plus your data disk) one at 
a time to the desktop trash can, thus clearing both disk drives. 

You are now ready to use a different program with your Apple Ilos. 
But because you probably 11booted up" with the System file on the 
USA GeoGraph Pro gram Disk, you will most likely need to reboot 
the computer with a different System file in order to run a different 
program. 
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Opening an 
existing USA 

GeoGraph 
document from 

the Finder 

••••A. .• $fep .. l>y±Step••••Lq()k••••at• ·l!$1\ GeoGrtlPh•······· 
If you haven't yet opened the USA GeoGraph program and wish to create a 
new document from scratch, it's best to follow the procedure described in the 
"Getting Started" section. In short, you simply open the program using the 
USA GeoGraph icon when it appears on the screen either by using the File 
menu's "Open" command or by double-clicking on the icon. 

If you wish, you can open an existing USA GeoGraph document the same 
way, although you have to go through the extra steps of closing your "new" 
document when it opens and then using the "Open" command from the File 
menu to open the existing document. In fact, you must open an existing USA 
GeoGraph document this way if you're using a single disk drive. But if you're 
using two disk drives, there's a much easier way to open an existing USA 
GeoGraph document from the Finder. 

Step 1 

Step 2 

Step 3 

Insert the USA GeoGraph Program Disk in Drive 1 and the data 
disk containing the document you wish to use in Drive 2. 

Open the data disk's window and double-click on the icon 
representing the document you want to open. 

When the document itself appears on the screen, you may begin 
using it as you see fit. 

Exporting data Perhaps you'd like to export some of the data in USA GeoGraph to, say, an 
Apple Works spreadsheet so that you can use it for various calculations or 
advanced correlation activities. The "Export Data" command allows you to do 
this. It works in a manner similar to the "Save As" command, except in this 
case you'll definitely need a data disk. 

Step 1 

Step2 

Make sure that all of the data you 
wish to export-all of the places 
and data categories you want
are selected and "active." The 
"Export Data" function works 
only with your current database 
selection. 

Choose "Export Data" from the 
File menu. 

The "Export Data" dialog box 
appears (Figure 83). 
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Export Dota 

® /USA.6E06RAPH/ 
r.21"'1f..,..re=e =o f--=80,..,0 .,..K·_...,., ( Disk ) 
[, f I~DFR.ORrA Q ( Hew Folder ) 
[1 f I~DER.o!f 
[1 mOER.ROIH ( Op(m ) 
D ICOHS 
<•;~ PROOOS Ill ( 1: I os1~ ) 
DSYSTEM 0 

Enter fi h n11u: [ Export ] 

lll.lll.llml I ( Cance 1 ) 
ODIF file (Databases ond Sprtadshetts) 
@Tnt fih (Word Processors) 

Figure 83 
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Step 3 

Step 4 

Step 5 

Enter the information requested in this dialog box but don't click 
the "Export" button yet. 

Before you click "Export," you need to insert your data disk. 

If you're using only one disk drive, eject the Program Disk and 
insert your data disk. 

If you're using two disk drives, eject the Information Disk in 
Drive 2 and insert your data disk. 

First click the "Disk" button and then click the "Export" button to 
export your data to your data disk. When this operation is 
complete, you can go ahead with other activities as you see fit. 

To conduct the "second half' of the exporting process-that is, to 
transfer the data from your data disk to Apple Works or whatever 
other program you're going to use-follow the instructions 
provided with that particular program. 

If you're a teacher or parent who plans on using USA GeoGraph with students, 
you may want to make certain modifications to the program in order to 
"customize" it to your instructional plans. You would make these 
modifications using the Management menu. But where is it? How on earth 
can you pull down a menu when it's not even listed on the menu bar? Well, 
that's a secret-or at least it is to students. But you can continue reading in 
order to find out! 

There will be times when you'll want to modify USA GeoGraph to suit your 
instructional goals. You can "customize" USA GeoGraph in two ways: 

by setting "preferences," the data categories that will function as 
"defaults" as students use the program; or 

by adding to the database up to three data categories, which you can 
edit as you wish and remove when you no longer want them. 

These tasks are performed with the Management menu. But where is it? 

To prevent students from undoing anything you've done with the Management 
menu, "Management" doesn't appear on the menu bar unless you first use a 
secret key combination command to gain access to it. 
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Accessing the Step 1 
Management 

Press Control-A on your keyboard. (Hold down the Control Key 
and type the letter "A". Then release the Control Key.) 

menu 

I Control I[!} 

Step 2 

The Management options can be used only if no USA GeoGraph 
document is currently open. For this reason, pressing Control-A 
calls up an alert box that asks whether you wish to go ahead and 
close your document. 

Click on the "Yes" button. 

Unless you used the "Save" command immediately before pressing 
Control-A, another alert box appears, asking whether you wish to 
save your current document before proceeding. 

If you prefer, you can choose "Close" from the File menu before 
pressing Control-A. In this way, your "desktop" goes "blank" 
without exiting the USA GeoGraph program itself (as explained in 
"Closing a Document" on pages 89-90). Then press Control-A. 

Notice that the word "Management" has been added to the menu 
bar (Figure 84). Now you have access to the Management menu. 

It rile Edit Displa!:l Hops Data Report Management 

Figure 84 

Control-A acts as a toggle switch, making "Management" appear 
and disappear from the menu bar. Let's see how this works. 

~ Step3 Press Control-A again. 

-v-
Setting 

"preferences" 

Note how "Management" disappears from the menu bar so that the 
Management menu is no longer accessible. 

·.· ···w~enevef you'yefimshefJ4¥ill'g tW:••Marmiirft¢fH AA:n#To•!JlPai}y 
(j'S){ (JeoGra[Jh, lJiPsure tq @t: Co/l(fof-.'4 m. f'~id4" ##gai#. 

Perhaps you're working with young students who might be confused or 
intimidated by the large number of data categories in the USA GeoGraph 
database. Or maybe, because of your particular lesson plans, you want to 
"nudge" your students toward working with, say, ten categories of your choice. 
Here's how you'd go about setting "preferences"-that is, the data categories 
that will function as the "default" setting as your students use the program. 
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If you haven't already done so, use Control-A to gain access to the 
Management menu. 

Pull down the Management menu and select "Set Preferences." 

Set Preferences 

Abbreviation, Polloi 
Agricul turol Commodities 
Agricultural Value 

m 

I 
Units: 
@English 
QHetric 

The "Set Preferences" dialog box 
appears (Figure 85). The "Set 
Preferences" box allows you to 
determine which categories will 
appear on the screen when students 
first view data cards or dac tables. 
Using the scroll box and clicking, 
Apple-clicking, and/or shift-clicking, 
you can select as few or as many data 
categories as you wish. 

Air lin~ Poss~nge" 
Annual Poy, Aviragv 
Area.lond ~ 

~ 
( OK ] 

Areo, Total 
Area. Water 
Asian Paoulotion 

I' : ~ 

Birth Rote 

Step 3 

w 
Figure 85 

If you prefer, you can select all of the categories by clicking the 
"Show All" button. You can also use the radio buttons to choose 
whether students will initially view data in English or metric units. 

Set your preferences and then click OK. (Clicking OK is not 
necessary if you click "Show All.") 

You'd rarely want students to view the database without the 
"Place" category appearing on the screen. So if you try to exit from 
"Set Preferences" without having selected "Place," a special alert 
box appears (similar to Figure 27 on page 34), warning that "Place" 
hasn't been selected. You have two options. If you don't want the 
names of the states and territories to appear, click the "Continue" 
button. But if you do want them to appear, click "Add Place." 

@Copyright MECC 1989 
Thesc materials may not be reproduced in whole or 
in part without written pctmission from MECC. 



USA GeoGraph User's Guide 

Adding a category Even the 105 categories built into USA GeoGraph can't handle everything 
to the database teachers might want to cover with their students. So we've left room for you 

to add up to three additional data categories to the database. You can create 
three different kinds of data categories: 

textual categories, in which the data con~ists of words; 

numeric categories without English/metric conversion capabilities, in 
which the data consists of numbers that may or may not have a unit of 
measurement assigned to them; and 

numeric categories with English/metric conversion capabilities, in 
which the data consists of two sets of numbers-one set with an 
English unit of measurement assigned to it and another set with a 
metric unit of measurement assigned to it. 

In creating your additional data categories, you have several restrictions: 

no more than three categories can be added; 

no textual entry can consist of more than thirty characters, including 
spaces; 

no numeric entry can consist of more than fourteen characters, 
including commas; and 

no category can include multiple entries per place. (For instance, if 
you create a category called "Livestock," you cannot enter both 
"horses" and "turkeys" as separate entries in that category for a single 
state or territory.) 

Also, you cannot edit the 105 categories that are built into USA GeoGraph. 
Those are "frozen"-although, of course, you can use "Set Preferences" to set 
"default" categories, thus "nudging" your students in the preferred direction. 

Given those restrictions, here's how to go about adding data categories to USA 
GeoGraph: 

~ Stepl Press Control-A to access the Management menu. (Remember that 
you cannot access the Management menu until close the current 
document-unless, of course, no document is currently open.) 
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Step2 

Step3 

Step4 

Select "Add Category" 
from the Management 
menu. 

The "Add Category" box 
appears (Figure 86). 

Enter the title of your new 
data category. If you like, 
you can also enter a 
category abbreviation of 
up to six characters. 

Add Cattsara 

Category n1111: 
Abbrtviatian: c==J 
Type of data tht oattsary will aantain: 
®tutual 
0 n111eric without Enslishlllttric canvtrsian 
0 n111eriowitb Enslish111ttrio oanvtrsian 

Figure 86 

If you don't enter an abbreviation, the program will create one. 

You may change the title and abbreviation later if you wish (see 
"Editing a Category" on pages 100-101). 

Indicate whether your new category will be textual, numeric 
without English/metric conversion, or numeric with English/metric 
conversion. 

Notice how the lower half of this dialog box changes depending 
on which of the three settings you have selected. If you select 
"textual," you cannot designate units of measurement (see 
Figure 86 above). 

Add Cottgory 

Category n011e: "-~----------' 
Type of dota the category will contain: 

If you select "numeric without 
English/metric conversion," you may 
designate a unit of measurement if 
you wish, but it's not required 
(Figure 87). 

Ottxtual 
@ nUIIericwithout Enaliihllletric convtriian 
0 nu11eric 11ith Enslish/lletric conversion 

Units: 

Figure 87 
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~ StepS 

Step 6 

Ploct 
~!mDaao 
~lnka 
IIMtricanSI*oct 
Arizona 
~rkonsos 
Co!ifornio 
tolorodo 
tonntcticcrt 
U~IOIWP 
Di~tric\ of Co ~abio 
rlorido 
Georgit 

Step 7 

If you select "numeric 
with English/metric 
conversion," you should 
designate two different 
units: one English and the 
other metric (Figure 88). 

If necessary (depending 
on the option you chose in 
Step 4), enter your unit(s) 
of measurement. 

Caugary n1111o: LL'==~------' 
Abbroviation: [:==J 
Type of data the category "ill contain: 

0 textual 
0 nu11oric without Englith/llotrio convenion 
® nu11eric with English/aetric conversion 

English Units: 11=-------1 
Httric Units: . 

Figure 88 

When you've finished supplying the information requested in this 
dialog box, click OK. 

The data entry window now appears. This window comes in two 
forms: one with a single column for entering textual data or 
numeric data without English/metric conversion (Figure 89), and 
the other with two columns for entering numeric data with English/ 
metric conversion (Figure 90). 

Governor PI act FishCnch(\ans) FishCotch(•nrictons) 

0 lllob•a 0 
Rloska 
AltrricanS.oa 
llriZDI\lf 

Arkansas 
tolihrni• 
Colorado 
Conntcuc~t 

OtiiiNOrl! 
Districtoftol•bia 
Florida 
6tor1io 

(Conorl) C][J ( Canctl J C][J 

Figure 89 Figure 90 

· Rerr~ember:••••leitual .. Catego}y.~n,tfte~··¢9#.c6itfJii'l·•lipro••thirty···· 
. charapters @ch. N@wridca,(~g(jry ~ntd~lc#r(co6t4iii Up t() ....... . 
fourte~n .. characters••each.•••4!##•1.f)l8k(li§o.se••t(j••c:Eedte•a•cmeiof"J••• 
involv(ngE~g!fshlrfietric••c«nveisio#, .. it'~••up[g•yJ)#••'a••e:nter•·@th•·· sets offigures. . . . . ··············· ................... ·····. ..... .. . .. 

Enter the appropriate data after the name of each state or territory. 

You may find USA GeoGraph's word-processing features useful as 
you enter your new data. Basic word-processing functions can be 
employed through Apple's standard key-combination command 
equivalents: OX for "Cut," OC for "Copy," and OV for "Paste." 
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When you've finished entering data for your new category, click 
the OK button at the bottom of the screen. 

fi\ You have not entered data for every place. 
Lll Do you wont to leave blanks or to continue 

adding data? 

You may want to stop 
before you've finished 
entering data for every 
place. If you click OK 
while there are still blanks, 
an alert box appears 
(Figure 91), reminding 
you that some blanks 
remain. 

(Leave blanks) [continue adding doto] 

Figura 91 

You must then choose whether you wish to leave blanks (which 
you may later come back to fill using the "Edit Category" 
command) or whether you want to continue adding data, in which 
case you would return to the data entry screen. 

After clicking OK, you return to the blank "desktop," which is 
where you were when you initially selected the "Add Category" 
command. Your new category has been added to the database, 
which you or your students can examine by opening a new or old 
USA GeoGraph document. Any blanks that you may have left in 
your new category will indeed appear on the screen as blanks. 

If you want to, you can go ahead and add another category to the 
database before opening a new document. You can add a total of 
three categories. After that, the "Add Category" command on the 
Management menu is grayed out, indicating that it is inactive. 
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Editing a category You cannot edit any of the 105 categories built into USA GeoGraph. But you 
can certainly edit any of the three categories you may have added yourself. 

~ Stepl 

Step 2 

Step 3 

Select "Edit Category" from the Management menu. 

Y au may have noticed that before you added a category to the 
database, the "Edit Category" and "Remove Category" commands 
were grayed out. But now that you've added at least one category, 
these commands are active. 

After you select "Edit Category," you'll see a dialog box that 
allows you to indicate which of the categories you have added to 
the database you are going to edit (Figure 92). 

S!lect Cat!gory 

S!lect the cat!gory that you want to edit: 

@6overnor 
0 Fish Catch 
0State Song 

Figure 92 

Select the category you wish to edit and then click OK. 

Now the "Edit Category" dialog box appears. It allows you to 
rename your category if you wish or, if appropriate, add or change 
references to units of measurement. Of course, you don't have to 
change anything at all if you don't want to. 

·····You···cdnn&i. .. /u)ffievJr;•••chattg~ .. ybU,. •• t./uJite.()[t)lp~··Rfddta .. tqtegpey······ . 
... •.(te:xtual ... numerJc•w.ithqut•cw~ver:fiQ~·•·w·~tic)jlith•t;qnyersiiJfi)·••• 
'["hat•felecti()f!.is•'lfr;oz%tt·''••••••Thf:•Qnl):•.~a.)'yqu••E·m•"gh.q'!ge''•it@w.•••• 
is to rett~ov~Y9W qaegpry g{fqgphf:f9f(d s;tartoger;asam. 
When you are sure that the information in the "Edit Category" box 
is as you want it, click OK. 

The data entry window now appears, allowing you to use the 
program's simple word-processing capabilities to edit the entries or 
to fill in any blanks. 
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Step 4 When you've finished editing the data in your category, click OK. 

The data entry window disappears, replaced by the blank 
"desktop." The changes you made to your data category are now a 
part of the database, which you can examine by opening a new or 
old USA GeoGraph document. 

Again, you cannot permanently remove any of the 105 categories built into 
USA GeoGraph. You can only temporarily "hide" them using the "Set 
Preferences" command. But you can, of course, remove any categories that 
you have added to the database. 

Step 1 

Step2 

Select "Remove Category" from the Management menu. 

The dialog box that appears allows you to indicate which of the 
categories you have added to the database you are going to remove 
(Figure 93). 

St hct Cateaary 

Se hct the category that yau want ta re~ave 
fro11 the database: 

@Governor 
OFish Catch 
0State Song 

Figure 93 

Select the category you wish to remove and then click the 
"Remove" button. 

You are about to permanently remove 
the category State Song 
and all of its data from the database. 
Are you sure you wont to do this? 

[ Ho ) ( Yes ) 

Figure 94 

An alert box now appears 
(Figure 94), warning that the 
act of removing a data 
category is permanent and 
asking whether you're sure 
that you want to do this. 
Keep in mind that the 
removal of a data category 
cannot be reversed with the 
"Undo" command. 
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-v-
Step 3 

!Jefol"eflrft(JJJitg@y ofyour added dqt{J catbg()tl¢s, CY64shollld 
ma/4 (l copyofirfffi l.[$A Gio(iraph. (titidfileii{ofJ.tdil1ilfg tHem. 
'[his" Way, if/YM ~hiiftgky@i @ing@ter,jpu'llsti/lhavi(l cojJyqf 
tfiedcJ/q./iles po/1.taiitiltgyoit]" tafeg()ties. $ee A[J]J¢ntiix E. 
''(Jre],!fi#i tzilf{ ttsi1ti (J tratlf.QiskWfttzBS.t{GeoQfkph,"for 
tiifaiMizttiJ11.•411.~4Yil1.t••l'l••·co!'Yo.fr.Iata.fil~s. 

If you want to go ahead and delete your category, click the "Yes" 
button. Otherwise, click the "No" button. 

The alert box disappears and you are returned to the blank 
"desktop." The USA GeoGraph database no longer contains the 
data category you have removed-a fact that you can verify by 
opening and examining a new or old USA GeoGraph document. 

1./,ftl1W.¢1iehyb.u 0r y()ur S1WJenfs; hdv~ s@f!dtib§ur@rlfs th,afwere 

ctkateti/W.## (J$.;{ ()e()(;faplt b¢/dr~Y.bllediied an"Jdata ·············· .. ¢atef(Jrtis. 411.dtei-ibbx }jlil/dp]J¢(lf()fl t#e i~reifl. Whf!ht@se 
(!(;FumfiiJSdf.¢ b[J¢n¢d. war}tfn@i/ftlt#11.Yref)(J##ec1iilns Wai ffiay 
lzdW•/;eeh·•swe:d•@atd•be••chdtfgedb'Jyow·&c¢ntedits.••••A..h4/i.f · · · 
S;(lveH doyrprle.flr~ }jlet¢ treated. With rt$A lJeoXii-af/h be./ofeyqu 
retitiJv;ed anY categiJfie-S.tMse d(}cumet.#s. ftiiJilqtbe o[Jtrn~tl (lfall. 
Ah #tertbpx. Wi/la[J]Jf!(JY@ ~xpfl1ifl1VM this is; {hl~ds¢. Therefore, 
~e16tekerlft41Ze#ttYretiz9ViHg tl!'Y dcr@ tx.~tlgof1~$JJ9it $/t6uJ4 M 
very sifre thatyplf()J'$1U:r$tu.fJe## 116 @#g@ !'eet1 a4c~ss t!J#!'Y 

••••••J!qtufpAnts.tly}f•wer~••trtaf!cl•am~·sarMJffeJ'Wus/y .. ••. 

So that's about it for this step-by-step look at USA GeoGraph. It's now up to 
you! We hope you'll find this program helpful in your geography and/or other 
social studies work. If, however, you have any questions or additional 
concerns, you may find them addressed in the next few sections of this User's 
Guide. 

In the meantime, happy exploring! 
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The ti (Apple) menu provides access to useful information about USA 
GeoGraph as well as to any desk accessory programs that may currently be 
installed on your System file. For this reason, the contents ~ 

The USA 
GeoGraph 
menu bar 

The ti (Apple) 
menu 

of this menu may vary from time to time, depending on the W System file in use. ,. .. _____________ .,. 

When you are using USA GeoGraph, the first two options 
on the ti menu are: 

About USA GeoGraph .•• 

Rbout USR GeoGraph ••• 
Help... .S? 
MECC Key Caps 

This option provides information about the program, including the 
version number of the program, its copyright, designers, and publisher 
(MECC), and the MECC address and telephone number. 

Help ••• 

This option provides immediate access to a screen with "buttons" 
listing various USA GeoGraph features: "Categories," 
"Abbreviations," "Clicking," "Search," and "USA Overall Data." 
Clicking on these buttons provides information about these things. 
This infom1ation is extremely brief and is not intended to substitute 
for reading this User's Guide. 

USA GeoGraph comes with one or more desk accessory programs that will 
also be listed on the ti menu unless you have deleted them for some reason 
(such as to make room for other desk accessories). Desk accessories can be 
used any time you can pull down a menu, even in the middle of a program. 
One of the desk accessories that comes with USA GeoGraph is: 

MECC Key Caps 

This desk accessory allows you to see the characters that you can type 
by pressing character keys in conjunction with the Shift, Control, and/ 
or Option Keys. It provides a quick look at the entire "library" of 
characters available in the particular font you're using. 

Other desk accessories may have also come with your copy of USA 
GeoGraph. And if you've installed other desk accessory items to the USA 
GeoGraph System file (or whichever System folder is currently in use), they 
will appear on the ti menu, too. 
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The File menu The USA GeoGraph File menu provides access to the basic "housekeeping" 
functions of the program-opening, saving, and closing documents-as well 
as to printing functions. The commands on the File menu are: 

Ill fill 

New *N 
Open ... •o 
Close aw 
Saue •s 
Saue As ... 

EHport Data ... 

Choose Printer ... 
Page Setup ... 
Printing Options ... 
Print Report ... an 
Print Window ... a p 

Quit •o 

New 

This command creates a new USA GeoGraph document, 
which will be called "Untitled" until you save it, at which 
time you will be required to give it a name. This 
command is not active as long as an existing document is 
open. 

Open ••• 

This command allows you to open an existing USA 
GeoGraph document, one that you or someone else 
previously created. Again, this command is not active as 
long as an existing document is open. 

Close 

This command closes a document without exiting USA 
GeoGraph itself. If the document you want to close has 
never been saved or if you've made changes to it since 
you last saved it, you will be given an opportunity to save 
the document before it actually closes. 

Save 

This command saves the document currently in use, replacing the 
existing file with the same name. 

Save As ••• 

This command allows you to save the document currently in use with 
a different name (thus preserving the previously saved version of the 
document) and/or on a different disk. 

Export Data ... 

This command allows you to export currently selected data (nations 
and categories) to DIF files (for spreadsheets and databases) or text 
files (for word processors), which you can then use to create 
spreadsheet, database, or word processing documents of your own 
design. 
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Choose Printer ... 

This command allows you to designate the printer and printer port (on 
the back of the Apple lias computer) you will be using. 

Page Setup ... 

This command allows you to choose the size and orientation (vertical 
or horizontal) of your printed pages and other special printing effects. 

Printing Options .•. 

This command allows you to assign a name to your report for printing 
purposes and to determine whether the pages you print will include 
page numbers, the report name (if applicable), the date, and/or map 
keys. 

Print Report ... 

This command allows you to choose the sections of your report (see 
"The Report Menu" on page 114) to print and then to begin printing. 

Print Window ... 

This command begins printing the contents of the currently active 
window. 

Quit 

This command closes the document in use (first, if necessary, 
providing an opportunity to save it), exits the USA GeoGraph 
program, and returns you to the desktop "Finder" program. 
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The Edit menu The Edit menu, which is quite important in many desktop programs, has very 
limited use in USA GeoGraph because of the nature of the program. Its frrst 
command is, however, extremely important: 

llinl 

Undo liz 
Cut liH 
Copy lie 
Paste liU 
Clear 

Undo 

This command reverses the effects of the immediately preceding 
command or action, providing you with a quick "ftx" of mistakes. It 
is available most of the time while using USA GeoGraph. 

The other four commands on the Edit menu cannot be accessed through use of 
this menu unless you're currently using a desk accessory that permits their use. 
At certain times, however (such as when you're using the "Add Category" 
Management option; see the description of the Management menu on page 
115), the "Cut," "Copy," and "Paste" commands can be accessed through use 
of Apple's standard key combination command equivalents (see "Key 
Combination Command Equivalents" on pages 116-117). These commands 
are: 

Cut 

This command cuts an item you select out of the document and stores 
it temporarily in the desktop Clipboard. (An item remains in the 
Clipboard only until another item is cut or copied.) 

Copy 

This command makes a copy of an item you select and stores it 
temporarily in the desktop Clipboard. 

Paste 

This command "pastes" a cut or copied item in a location of your 
choice. 

Clear 

This command cuts an item you select out of the document but does 
not store it in the desktop Clipboard. 
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The USA GeoGraph Display menu provides general control over the type of 
display you will see on the screen. The Display menu commands are: 

Display Map 

The Display menu 

This command displays maps on the screen, 
allowing access to theme, comparison, contrast, 
quartiles, and equal steps maps. Display Map 15M 

Display Data Cards 

This command displays database information in 
the form of "cards," a primarily "vertical" 
format. You can also view data cards by 
Apple-clicking or double-clicking on any item 
in a data table. 

Display Data Table 

Display Data Cards ltD 
Display Data Table ItT 
Display Graph &G 
Display Distribution It 1 

Restore Window Position 

This command displays database information in the form of a "table," 
a primarily "horizontal" format. You can also view a data table by 
Apple-clicking or double-clicking anywhere on a data card. 

Display Graph 

This command displays numerical database information in graph 
form. 

Display Distribution 

This command examines the current database selection and the data 
categories currently selected for viewing on the screen and displays 
either a table that cites "matches" found within the textual categories 
or one that indicates where the currently selected nations fall within 
U.S. "deciles" for the numeric categories, whichever you prefer. 

Restore Window Position 

This command quickly restores any windows currently open on the 
screen to their "default" (original) positions. The same thing can be 
achieved by "grabbing" the title bar of any window and "dragging" it 
back to its original position, but this command does this more easily 
and accurately, especially for novice users of the Apple lias "desktop 
interface." 
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The Maps menu Once you've used the Display menu's "Display Map" command to view maps 
on the screen, the Maps menu provides extensive control over those maps. 
The Maps menu commands are: 

~ 

Oueruiew Map 
Fifty States Map 
Region Map ... 
Close-up Map ... 

Blank Map 
Theme Map ... 
Compare ... 
Contrast ... 
USA Quartiles ... 

til 
li2 
ti3 
li4 

liB 
tiL 

Overview Map 

This command displays on the screen a large portion 
of the world map-approximately one-fourth of the 
earth's surface, focusing on North America and most 
of the Pacific Ocean. This allows you to see all of 
area encompassed by the United States, including its 
Caribbean and Pacific territories. You can also zoom 
out from the Fifty States Map to the Overview Map 
by option-Apple-clicking anywhere on the "active" 
portion of that map. 

Fifty States Map 

Equal Steps Map ... 

This command allows you to "zoom in" on a map of 
the fifty states. You can also zoom in to this map 
from the Overview Map by Apple-clicking on any of 
the fifty states on that map. And you can zoom out 
from a region map to the Fifty States Map by option
Apple-clicking anywhere in that region. 

Hide Boundaries 
Show Key 

liH 
liK 

Region Map ••. 

This command allows you to zoom in on a map of a region of your 
choice. You can also zoom in from the Fifty States Map to any of 
four regions (Northeast, South, Midwest, and West) by Apple
clicking on any state within that region. From the Overview Map, 
Apple-clicking on any territory within the Caribbean or Pacific 
regions takes you directly to that region. 

Close-up Map ..• 

This command allows you to zoom in on the "close-up map" that 
includes a state or territory of your choice. 

Blank Map 

This command returns the screen from a theme, comparison, contrast, 
quartiles, or equal steps map to a "clear" state. Using the "Blank 
Map" command does not, however, affect the database, so "selected" 
states and territories remain selected. 
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Theme Map •.• 

This command allows you to view 24 different types of thematic 
maps at the "Fifty States" level. 

Compare ... 

This command allows you to view a graphic comparison of a state or 
territory of your choice to the rest of the United States (or the rest of 
the states and/or territory on a region or close-up map) in terms of a 
"greater than" and "less than" dichotomy for numeric data categories. 
For example, you can choose to compare Nebraska to the rest of the 
country based on population and, as a result, see the states with 
populations greater than Nebraska's shaded in one color and those 
with populations less than Nebraska's shaded in another. You can 
also compare places to averages or totals for the United States overall. 

Contrast ... 

This command allows you to define a pair of "search rules" that result 
in a map in which all of the states and territories that meet one 
criterion are shaded in one color, all that meet the second criterion are 
shaded in another color, and all that meet both criteria are shaded in a 
third color. Although this command employs a dialog box closely 
resembling that of the "Search" command (see pages 112-113), it 
does not effect the current database selection. 

USA Quartiles ... 

This command allows you to view the states and territories shaded 
according to their quartile ranking within the numeric data categories. 
For example, you can choose to see USA quartiles for per capita 
income and, as a result, see the states and territories that rank in the 
top 25% for the United States in that category shaded in one color, 
those in the second 25% shaded in another color, and so on. There 
will be an approximately equal number of places within each quartile. 

Equal Steps Map ... 

This command allows you to view the states and territories shaded 
according to how they fall within four equal steps within the numeric 
data categories. For example, you can choose to see equal steps for 
per capita income and, as a result, see the places that rank in the top 
25% of the figures in that category shaded in one color, those in the 
second 25% shaded in another color, and so on. There will usually 
not be an equal number of places within each of the four "steps." 
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Hide/Show Boundaries 

This command functions as a "toggle switch" that allows you to 
choose whether state boundaries should appear on the Overview, Fifty 
States, and region maps. Close-up maps, however, always include 
state boundaries. 

Show Key 

This command allows you to display an explanatory key on the screen 
along with thematic, comparison, contrast, quartiles, or equal steps 
maps. 

The Data menu The Data menu provides extensive control over the database. The Data menu 
commands are: 

II:f.tg 

Clear Selection 
Search ... i&Y 
Select Places ... 

Find ... i&F 
Find NeHt i&J 
Sort ... i&R 

Show Categories ... 
Rrrange Categories ... 
Resize Categories ... 

Rbbreuiate Category Names 

Show English Units i&E 
Show Metric Units i&U 

Clear Selection 

This command cancels the effects of using the 
"Search" command or of selecting states and 
territories by clicking on a map. Use of this 
command affects both the database and the 
maps. It restores the database record selection 
to include all states and territories. 

Search ..• 

112 

This command allows you to conduct database 
searches for the purpose of narrowing the 
database down to only those states or territories 
that meet your specifications. You can conduct 
four different kinds of searches: 

1. A Simple Search-You specify only one 
criterion for states and territories to meet in 
order to remain part of the database record 
selection. 

2. An "And'' Search-You specify two or 
more criteria, linked by the conjunction 
"and," so that states and territories must 
meet all of the criteria in order to remain 
part of the database record selection. 
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3. An "Or" Search-You specify two or more criteria, linked by 
the conjunction "or," so that states and territories need to meet 
only one of the criteria in order to remain part of the database 
record selection. 

4. A Search That Includes Both "And" and "Or"-You specify 
three or more criteria that include both "and" and "or." "And" 
relationships take precedence, so that "A and B or C" results in a 
search for all states and territories in which either A and B are 
both true or Cis true, while "A orB and C" results in a search for 
all states and territories in which either A is true or B and C are 
both true. 

In using the "Search" command, you also have the option of limiting 
the search to your current database record selection, of limiting or 
expanding it to states only, or of expanding it to include all states and 
territories. 

Select Places ... 

This command allows you to perform a special type of search to 
narrow the database down to the records for the states or territories 
you select by name from a scroll box. 

Find ... 

This command allows you to find the next appearance in the database 
of textual or numeric data that you specify. 

Find Next 

This command repeats the Find command for previously specified 
data. 

Sort ••• 

This command arranges your current database selection according to 
alphabetical or numerical order within a data category of your choice. 

Show Categories .•• 

This command allows you to determine which data categories will be 
displayed on the screen. 

Arrange Categories ••• 

This command allows you to arrange the order in which the data 
categories appear on data cards, data tables, and distribution tables. 
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Resize Categories ... 

This command, active only when you're viewing a data table, allows 
you to modify the width of the columns on the screen. 

Abbreviate Category Names 

This command, which functions as a toggle switch, allows you to 
determine whether the category names will be abbreviated in the 
column headings of data tables. It does not affect data cards. 

Show English Units 

This command allows you to view pertinent data in English units of 
measurement (square miles, etc.). Using this command cancels the 
effects of using the "Show Metric Units" command. 

Show Metric Units 

This command allows you to view pertinent data in metric units of 
measurement (square kilometers, etc.). Using this command cancels 
the effects of using the "Show English Units" command. 

The Report menu The USA GeoGraph Report menu allows you to create a "report" showing the 
results of your work, which can then be printed. A report consists of up to ten 
"sections" that are added one at a time. Only one report can be created per 
USA GeoGraph document, although you can modify a report (add sections to 
it, replace sections, or remove sections from it) as you see fit. The Report 
men c mmands are: u 0 

l.il:J Ill] Iii 
Add Section ... eJ+ 
Replace Section ... 
Remove Sections ... 

[Section Name] 
[Section Name] 
[Section Name] 
[Section Name] 
[Section Name] 

Add Section ... 

This command allows you to assign a name to the 
current screen selection and to add it to your report. 

Replace Section ... 

This command allows you to replace a section of your 
choice with the current screen selection. 

Remove Sections ... 

This command allows you to remove sections of your 
choice from the report. 

114 ©Copyright MECC 1989 
These materials may not be reproduced in whole or 

in part without written permission from MECC. 



USA GeoGraph User's Guide 

In addition to these three commands, the Report menu also lists each existing 
report section by name. You can view your report sections at any time by 
selecting from this menu list. 

In order to print all or part of a report, you must use the various print-related 
options on the File menu (see "The File Menu" on pages 106-107). 

The Management 
menu 

Management" does not ordinarily appear in the USA GeoGraph 
menu bar. It appears only after you use a "secret" key 
combination command, Control-A (hold down the Control Key 
and press the A Key simultaneously). Because Management 
options cannot be used while a document is open, Control-A 
automatically closes any document currently open. The word 
"Management" then appears in the menu bar, to the right of 
"Report," allowing you access to the Management menu. The 
Management menu commands are: 

Management 

Set Preferences ... 

Rdd Category .. . 
Edit Category .. . 

Set Preferences •.• 
Remoue Category ... 

This command allows you to determine which data categories 
students will initially view on the screen in USA GeoGraph and 
whether English or metric units will initially be used in pertinent 
categories. In essence, it creates "default" categories, although 
students can easily view other data categories if they wish. 

Add Category ••• 

This command allows you to add a new data category of your own to 
the USA GeoGraph database. You may add up to three categories. 

Edit Category ••• 

This command allows you to edit and/or rename a category that you 
have added to the database. 

Remove Category ••• 

This command allows you to remove a category that you have added 
to the database. 

To make "Management" disappear from the menu bar so that students cannot 
gain access to the Management menu, simply press Control-A again. 
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Key combination 
command 

equivalents 

As already noted, the Control-A key combination command provides access 
to the Management menu. Many of the menu bar commands described above 
can also be executed directly from the keyboard through key combination 
command equivalents involving the Apple Key (0). These key combination 
command equivalents are listed below: 

Command 

timenu 

Key Combination 
Command Equivalent 

Help ... 

File menu 

New 
Open ... 
Close 
Save 
Print Report ... 
Print Window ... 
Quit 

Edit menu 

Undo 
Cut 
Copy 
Paste 

Display menu 

Display Map 
Display Data Cards 
Display Data Table 
Display Graph 
Display Distribution 

Maps menu 

Overview Map 
Fifty States Map 
Region Map ... 
Close-up Map ... 
Blank Map 
Theme Map ... 
Hide/Show Boundaries 
Show Key 

116 

0? 

ON 
00 
ow 
os 
OR 
OP 
oQ 

oz 
ox 
oc 
ov 

OM 
OD 
OT 
oG 
01 

01 
02 
03 
04 
OB 
OL 
OH 
OK 
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Data menu 

Search... OY 
Find... OF 
Find Next... OJ 
Sort... OA 
Show English Units OE 
Show Metric Units OU 

Report menu 

Add Section... 0+ 

One additional key combination command is 0• (Apple-Period), which is used 
to interrupt printing once it has begun. 

Various types of"clicking" actions with the mouse have different effects at 
different times, as noted below: 

On Maps 

Clicking-Selects a single state or territory. All previously selected 
places are de-selected. Also, clicking on the "grayed-out" area of a 
region or close-up map "slides" you over to an "adjacent" map at the 
same level. 

Shift-clicking-Adds a state or territory to the current database 
selection or subtracts a state or territory from the current database 
selection without de-selecting any other previously selected places. 

Apple (0 )-clicking-Zooms in from the Overview Map to the Fifty 
States Map (as long as you click on an "active" part of the map) or, if 
you click on a "territorial region," to a region map; from the Fifty 
States Map to the map of the region on which the cursor is resting; or 
from a region map to the close-up map that includes the state on 
which the cursor is resting. If the cursor is not resting on a particular 
region or state, nothing happens. No places are selected or de
selected. 

Option-Apple-clicking-Zooms out from a close-up map to a region 
map; from a region map to the Fifty States Map, or, if you're looking 
at a "territorial region," to the Overview Map; or from the Fifty States 
Map to the Overview Map. No places are selected or de-selected. 

Unlike World GeoGraph, double-clicking has no special effect on 
maps in USA GeoGraph. 
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On Data Cards and Data Tables 

Apple-clicking or double-clicking-"Toggles" between the data card 
and the data table formats. When you Apple-click or double-click on 
a particular place in the data table format, you "zoom in" on the data 
card for that place. When you Apple-click or double-click on a data 
card, you "zoom out" to the data table for the current database 
selection. No states or territories are selected or de-selected in either 
instance. 

Any other clicking action performed on anything other than an on
screen button, the menu bar, or a scroll bar has no effect whatsoever. 
Depressing the Option Key while Apple- or double-clicking has 
exactly the same effect as simply Apple- or double-clicking. 

On Graphs and Distribution Tables 

Any clicking action performed on anything other than an on-screen 
button, the menu bar, or a scroll bar has no effect whatsoever. 

On Dialog Scroll Boxes 

Clicking-Selects a single item. All previously selected items are de
selected. 

Shift-clicking-Selects a range of items. Used after a click, shift
clicking selects all items between and including the item initially 
clicked on and the item shift-clicked on. 

Apple-clicking-Adds an item to or subtracts an item from the current 
selection without de-selecting any other previous selections. 

On many scroll boxes, only one selection is permitted. In those cases, 
shift-clicking and Apple-clicking function just like ordinary clicking. 
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Different types of cursors will appear on the screen to reflect various program 
functions: 

The "selection" cursor appears most often. You use it to perform most basic 
program functions, including selecting menu items and clicking on maps. 

The familiar "wait" cursor indicates that the program is in the process of 
carrying out a command or some other function you have implemented. Until 
it changes back to some other type of cursor, you can't do anything with it. 

The "zoom in" cursor appears when you hold down the Apple Key '.';bile 
viewing an Overview, Fifty States, or region map. By clicking at this point 
(Apple-clicking), you zoom in on the next "closer" map view. 

The "zoom out" cursor appears when you hold down the Apple Key and the 
Option Key while viewing a Fifty States, region, or close-up map. By clicking 
at this point (option-Apple-clicking), you zoom out to the next "farther" map 
view. 

When you depress the Apple Key while viewing a data card or data table, the 
cursor changes to a "magnifying glass" with no "sign" in it to indicate that 
clicking will toggle you from a data card to a data table or vice versa. 

The "hand" cursor appears when you move the cursor over the "Arrange 
Rules" or "Arrange Categories" dialog box. It allows you to "grab" search 
rules or data categories and change the order in which they appear. 

The "double-headed arrow" cursor appears when you move the cursor between 
two category headings in the "Resize Categories" dialog box. It allows you to 
change the width of columns in data tables. 
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When you look at comparison, contrast, quartile, equal steps, or theme maps, 
the states and/or territories in the current database selection appear 
highlighted-that is, in black-instead of in the other colors. You can see the 
colors for those places when you click in the ocean or another nation (such as 
Canada or Mexico), thus clearing the database selection-but what if you don't 
want to clear your database selection? How can you gain the full benefits of 
the various color maps without messing up your current database selection? 

Well, you can't-in a way. You must lose your current database selection at 
least temporarily. That's because the USA GeoGraph maps are always closely 
linked to the database. They always show the state of the current database 
selection. But it's easy to circumvent that feature should it ever pose a 
problem. In fact, there are at least three different ways you can do it: 

• As we said, after you click in the ocean or choose "Clear Selection" from 
the Data menu, your database selection is eliminated, so no black 
highlighting interferes with the other colors on the map. Then, after 
examining the map, all you have to do is choose "Undo" from the Edit 
menu to restore your database selection-as long as you haven't done 
anything else with USA GeoGraph since you cleared the database 
selection except look at the screen. 

• If you had used the "Search" command to create your database selection 
in the first place, simply choose "Search" again from the Data menu. 
Your old search rule(s) should still be installed, so by clicking the 
"Search" button you'll restore your database selection. 

• Before you clear your database selection, "save" it by adding it to your 
report. Just select "Add Section" from the Report menu and give your 
map with the highlighting on it a name. Then go ahead and clear your 
database selection so that you can see all of the colors on the map in their 
full glory. When you're done, choose your report section from the Report 
menu and you'll "go back in time" to before you had cleared your 
database selection. 

The quickest way to learn the name of a particular state or territory on the 
Overview, Fifty States, or region map is to click on that place, thus selecting it, 
and then press OD (that is, press the Apple and D Keys simultaneously). 
You'll see the data card for that place, which includes its name. Then press 
OM to return to the map. There are, of course, other ways in which you can 
learn a place's name, such as by zooming in on the close-up map, where states 
and territories are named. Still, OD is the quickest and easiest method. 
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Tips on using 
the database 

Narrowing the 
database down to 
states that border 
on certain bodies 
of water or other 

geographic entities 

Using the 
"contains" search 

rule operator 
instead of "equals" 

The difference 
between "equals" 

and "contains" 

What if you want to narrow the database down to all of the states that border 
on, say, the Atlantic Ocean? You could just look at the Fifty States map and 
shift-click, one by one, on all of the states bordering that ocean. But that 
would be awfully tedious and, besides, you might miss one or two small states. 

There's a much better way: conduct a search using the rule "Borders equals 
Atlantic Ocean." Then the database is narrowed down to the states that meet 
that criterion. (This selection will also, of course, include the Caribbean island 
territories of Puerto Rico and the Virgin Islands. But if you limit your search 
to states, these territories will not become part of your database selection.) In 
this way, you get the selection you want quickly, easily, and accurately. 

If you want to select only those states that border on the Great Lakes, you can 
conduct a search using the "contains" operator instead of the more common 
"equals" operator. If you were to search for all states in which "Borders 
equals Lake," you wouldn't find anything. But if you search for the states in 
which "Borders contains Lake," you'll narrow the database down to the states 
whose borders include Lake Erie, Lake Huron, Lake Michigan, Lake Ontario, 
and Lake Superior. Since the five Great Lakes are the only items in the 
"Borders" category containing the word "Lake," you can be assured that the 
database selection reflects your wishes. 

Keep in mind that either "equals" or "contains" will often work in pretty much 
the same way in the multiple-entry text categories, such as "Minerals and 
Fuels." The fact that "coal" may be only one of several entries in a multiple
entry category does not prevent the "equals" operator from worlcing effectively 
in a search. So "Minerals and Fuels equals coal" and "Minerals and Fuels 
contains coal" will yield exactly the same search results. On the other hand, 
"Borders equals Mexico" and "Borders contains Mexico" will obtain different 
results. "Borders equals Mexico" will find only the states that border on 
Mexico, whereas "Borders contains Mexico" will find all of those states plus 
the ones that border on New Mexico since "New Mexico" contains the word 
"Mexico." 

Also note that the "contains" operator cannot be used in numeric data 
categories. The USA GeoGraph program won't let you choose it, thus 
eliminating a potential source of error and confusion. 
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As you probably know, anything you see on the screen with USA GeoGraph 
can be printed out. Does this mean that you can obtain a printout of the entire 
USA GeoGraph database? Yes, it does. Just make sure that all of the states 
and territories are selected (or that the selection is cleared; the effect is the 
same) and that all of the database categories are "active." Also, you should be 
viewing the data in the data card format because the resulting printout is much 
easier to use than a data table printout. Then all you have to do is begin 
printing. 

But-and this is a big "but" -we don't recommend that you try to print out the 
entire database. For one thing, it takes a very long time. Even the very fastest 
method of printing the entire USA GeoGraph database (using an Image Writer 
II and printing in "draft" mode) requires more than an hour-and-a-half to 
complete the printing process. And the result is a stack of paper nearly three 
inches thick. It's not because the USA GeoGraph printing routine is slow, 
inefficient, or anything like that. It's simply because USA GeoGraph contains 
that much data. When you consider data for fifty states and six territories in 
105 categories, many of which contain multiple entries, you realize that 
printing the entire database in one fell swoop is a major undertaking. But still, 
if you want to do it, you can do it. 

If your class is using several copies of USA GeoGraph and you wish to create 
one or more additional categories (as described on pages 96-99) and have all of 
your students work with them, do you have to go through the entire process of 
individually adding the new data to every single copy of the program? No, not 
at all. After you've finished adding your new categories to one of the copies, 
all you have to do is use the desktop "Finder" program to copy the file entitled 
USA.GEO.DATAO from the modified Information Disk to the other 
Information Disks. Or, if you prefer, you can copy the entire modified 
Information Disk to the other Information Disks. Then all of your copies of 
USA GeoGraph will have the new data. 

MECC publishes a USA GeoGraph Classroom Guide that provides detailed 
suggestions about using the program with students, including dozens of lessons 
in the form of student handouts and accompanying teacher notes. Some 
lessons focus on particular regions while others cover various geographic, 
economic, and sociological topics. Also included are lessons that help students 
learn how to use various USA GeoGraph features as well as descriptions of 
several educational games students can play using USA GeoGraph. 
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The Classroom Guide concentrates on classroom situations in which students 
have ready access to Apple lias computers and the USA GeoGraph disks. 
Many of the activities described in the Classroom Guide, however, can easily 
be adapted to a situation in which there is only one computer in the classroom. 
The computer would be controlled by the teacher, who uses a large-screen 
monitor or a projection system in front of a group of students. (USA 
GeoGraph will not, however, work equally well with all types of projection 
systems. See "Different Types of Projection Systems," below.) Focusing on 
current curriculum topics, the teacher can demonstrate various program 
functions, discuss their usefulness, and elicit questions or suggestions from 
students. On-screen occurrences would then serve as a stimulus for discussion. 

Using USA Teachers can also use USA GeoGraph before class to create "illustrations" to 
GeoGraph as a support classroom lectures or discussions. For example, a teacher might use 
"slide projector" the Report menu's "Add Section" command to save a variety of maps, data 

displays, and/or graphs to accompany a lecture. Then all the teacher has to do 
is choose each "section" from the Report menu to display the illustration to the 
students. In this way, USA GeoGraph can be used in much the same way as a 
slide projector-albeit a highly advanced slide projector with a decided 
geographic bent Alternatively, teachers can print maps or other types of 
displays, duplicate them, and distribute them to students as support material. 

Different types of As we've already noted, USA GeoGraph will not work equally well with all 
projection systems types of projection systems. An RGB video projector (such as the Sony 

1020-Q) connected to the RGB monitor port on your Apple lias and set to 
project in the "Line" mode will provide a very high-quality color image that 
should be satisfactory for virtually any type of classroom display using USA 
GeoGraph. Unfortunately, these kinds of video projectors are expensive and 
not very portable. 

Some of the portable and relatively inexpensive "palette-type" projection 
systems (such as the Telex MagnaByte and the Computer Accessories Data 
Display) will work in part with USA GeoGraph, but always with 
comparatively low image quality. If you're going to display only text (data 
cards, data tables, etc.) and graphs, the Telex MagnaByte 5020 is your best bet 
and should work to your satisfaction. It will not, however, differentiate colors 
sufficiently to be of much use in displaying maps that rely heavily on color. 
Other projection systems that work with the Apple lias in the "desktop" 
environment should also work with USA GeoGraph to varying degrees. But 
be sure to try out any system you may consider using before actually using it in 
class. 
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Q. Why was USA GeoGraph designed for the Apple lias and not the //e or 

//c? And why is it available on 3.5" disks but not on 5.25" disks? 

A. Because of the memory and graphics requirements of USA GeoGraph, it 
was necessary to restrict its use to the Apple lias. Besides, the desktop 
environment of the Apple lias lends itself to USA GeoGraph' s "living 
map" concept. Similarly, memory requirements also restricted it to 3.5" 
disks. USA GeoGraph fits comfortably on two 3.5" disks, but it would 
have required nine or ten 5.25" disks. 

Q. Why can't I change or update the data in USA GeoGraph? 

A. In order to squeeze 105 categories of data into USA GeoGraph, it was 
necessary to compact that data. This compacting resulted in the data being 
"frozen," preventing users from modifying it. You can, of course, add and 
edit up to three additional data categories of your choice. As for the bulk 
of the database, MECC plans to release periodic, inexpensive updates of 
the USA GeoGraph Information Disk. 

Q. I would like to prevent my students from using certain data categories 
altogether instead of just being able to "nudge" them toward using certain 
ones with the "Set Preferences" command. Why can't I restrict access to 
data categories that I don't want my students to use? 

A. There's a fundamental incompatibility between highly restrictive 
Management options and the ability for students to create and save USA 
GeoGraph documents. For instance, let's assume a student has created 
and saved a document that includes maps, data, and graphs involving 
"Birth Rate." What would happen to that document if the teacher then 
restricts access to the "Birth Rate" category? Would the student's hard 
work be eliminated? That would be terribly frustrating. In that case, 
would the student's use of that category override the teacher's restriction? 
Then why provide an option to prevent access to data categories when 
students can easily circumvent it? 

Because it was deemed more desirable to allow students to save their work 
(in case they can't complete it in a single session at the computer), USA 
GeoGraph doesn't allow teachers to prevent access to certain data 
categories. Instead, it allows teachers to use the "Set Preferences" 
Management option to create "default" data categories which students can 
indeed override but which can nevertheless be easily restored. 
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Why aren't theme 
maps available at 

all map levels? 

Q. Why are theme maps available only at the Fifty States level? 

A. The villain is disk space limitations. Each theme map takes approximately 
20K of memory, so we couldn't include theme maps at "closer" levels 
without severely cutting into memory that was needed for other desirable 
features. We consulted with geography educators to determine which 
theme maps were most desirable and at which levels. Our consultants 
agreed that nearly all theme maps would be most useful at the Fifty States 
level, where students would be able to view the nation as a whole. 

Why are several Q. 
different map 

projections 
used? 

I notice that different map projections are used for different on-screen 
maps. Why dido 't you maintain consistency by sticking with a single 
projection for all of the maps? 

A. The designers and graphic artists who worked on USA GeoGraph always 
chose the projection that best suited the particular part of the United States 
being depicted given the dimensions of the computer screen. 

For the Overview Map, we needed a projection that would allow students 
to see all fifty states plus the locations of the Pacific and Caribbean 
territories on one screen. Furthermore, this had to be done with a 
minimum of distortion in shape and size. The map that best met these 
criteria was the Vander Grinten projection, which until recently was the 
"official" world projection of the National Geographic Society. 

Polyconic projections, which are excellent for showing large areas smaller 
in size than an entire continent with little distortion of shape and size, 
were used for the Fifty States and "states" region maps. A Conic 
projection was used for the Carribean region, and a Mercator projection 
was used for the Pacific region. 

The following projections were used for the various close-up maps: 
Conic, Lambert Conformal Conic, Mercator, and Polyconic. Our primary 
concerns in determining which projections to use were accuracy and 
clarity of depiction on the screen. 

If students have questions about the variations in projections (as well as in 
scales), you'll have for yourself a ready-made "teachable moment"-an 
opportunity to take advantage of student curiosity in order to foster 
learning. You may find the "Maps" lesson in the USA GeoGraph 
Classroom Guide especially helpful. 
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Q. USA GeoGraph includes data about only six U.S. "territories": the Why doesn't 
District of Columbia, American Samoa, Guam, Northern Marianas, Puerto USA GeoGraph 
Rico, and the Virgin Islands. But there are other U.S. "possessions," such include data 
as Wake Island, the Midway Islands, and the Trust Territory of the Pacific. about other U.S. 
Why aren't these included? territories, such 

A. Most of the small U.S. territories not fucluded in USA GeoGraph, such as 
Wake and Midway, are administered by the U.S. armed forces or other 
branches of the government for military purposes. They have very small 
permanent populations (in some cases, they have no permanent 
populations). For these territories, the vast majority of entries in the USA 
GeoGraph database would have been "not applicable" or "no data 
available." Because of the focus in USA GeoGraph on "human 
geography," the program's designers decided not to include these small 
territories. 

As for the Trust Territory of the Pacific, it was established by the United 
Nations in 1947 to be administered by the United States. Most of these 
islands had been under Japanese control before or during World War II. 
They never were truly U.S. "possessions." Rather, the United States was 
holding them "in trust" for the U.N. and for the peoples of the region. 

At this time, the entire Trust Territory is undergoing transition. It has 
been effectively divided into four parts, each of which is pursuing its own 
path. One part, the Federated States of Micronesia (previously known as 
the "Caroline Islands"), has become an independent nation, albeit with a 
special economic and military relationship with the United States. As an 
independent nation, the Federated States of Micronesia is included in the 
database of USA GeoGraph's "companion product," World GeoGraph. 

Two other parts, Palau and the Marshall I stands, are also seeking 
independence, although they aren't quite as far along in the process as the 
Federated States of Micronesia. Although they aren't included in the 
current version of World GeoGraph, they will be seriously considered for 
future versions of that product. 

Finally, the Northern Mariana I stands (also known as "Northern 
Marianas"), have elected to remain a part of the United States as a 
commonwealth. Future statehood is a distinct possibility, perhaps in 
conjunction with nearby Guam (which is, technically, the southernmost of 
the Mariana Islands). Because of this fact, Northern Marianas is included 
in USA GeoGraph. 
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How do I recover 
files that have 

been thrown 
away? 

Q. Help! One of my kids used the desktop "Finder" program to "grab" 
several of the files on the USA GeoGraph disks and throw them into the 
trash can. This included the built-in map and data files. Even some of 
those all-important System files were lost! Now my copy of USA 
GeoGraph won't work properly any more. What can I do? 

A. First things first. USA GeoGraph comes with its own backup disks. That 
is, when you opened up the USA GeoGraph box, you should have found 
two copies of the Program Disk and two copies of the Information Disk. 
One pair of disks (a Program Disk and an Information Disk) should be for 
"everyday use." The other pair are your backups, which you should store 
safely away where potentially damaging hands can't reach them! That 
way, in case anything goes wrong with your "everyday" disks, you still 
have your backup copies to fall back on. 

Secondly, be sure to tell anyone using USA GeoGraph--especially 
children-not to throw any files away. If you nevertheless find that a file 
has been thrown away, you may be able to recover it if you work fast! 
When a file has been thrown into the desktop "trash can," it remains there 
until the "Empty Trash" command (under the Special menu) is used or 
until some demand has been made upon the computer's memory 
necessitating the emptying of the trash. If an important file has just now 
been thrown away, you may be able to open up the trash can (by double
clicking on it) and drag the discarded file back into the appropriate 
window, thus saving it from permanent removal-and saving yourself a 
lot of frustration. 

Still, all may not be lost for files that have been "permanently" removed, 
especially if you're an advanced user of the Apple IIGs. If someone has 
used the "Finder" to throw away a file vital to the functioning of USA 
GeoGraph, that file may still be on the disk, despite the fact that you can't 
see it in any of the desktop windows. You might try using a disk utility or 
file utility program, such as Copy II Plus™, to recover the missing files. 
But this is a last resort, and it may not work. 

Your best bet is simply this: 

Keep your backup copies of the USA GeoGraph disks safe and 
sound. If you don't have a backup copy of the Information Disk, you 
can make one using the ordinary desktop means of dragging files onto 
a blank disk. The Program Disk cannot, however, be copied, so it's 
especially important to protect the original backup copy. 

Instruct children (or anyone else, for that matter) using USA 
GeoGraph not to throw away desktop files. 
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Many persons played important roles in the development of USA GeoGraph. 
Its concept and basic structure are based upon the previously released World 
GeoGraph program, which was originally conceived by Dr. Don Rawitsch and 
Dr. Stephen Taffee of the MECC staff and designed by a MECC team that 
consisted of many of the same people who went on to develop USA 
GeoGraph. USA GeoGraph itself was designed and produced by a MECC 
team consisting of Charolyn Kapplinger, John J. Krenz, Steven D. Splinter, 
Dr. Wayne Studer, Paul R. Wenker, and Dr. Nelson Whyatt. The User's 
Guide was written by Wayne Studer and the Classroom Guide was written by 
Wayne Studer and Nelson Whyatt, with the exception of the "Teacher 
Training" section, which was written by Dick Carlstrom and Wayne Studer. 

The following consultants offered valuable guidance in developing USA 
GeoGraph: Dr. David Lanegran and Dr. Jerry Pitzl, Professors of Geography 
at Macalester College in St. Paul, Minnesota; Patrice St. Peter, who teaches 
social studies in the Mounds View (Minnesota) School System; and Charlie 
Fitzpatrick, who teaches geography at St. Paul Academy and Summit School 
in St. Paul. 

Management support was offered by Dick Burkhardt, Craig Copley, Greg 
Holey, Raymond D. Kush, Nan Leekley, Susan Schilling, Mark Schneider, and 
Stephen Taffee of the MECC staff. 

MECC greatly appreciates the valuable contribution of the administrative and 
teaching staff of Oxbow Creek Elementary School in Anoka County, 
Minnesota, for allowing their school to serve as a test site for USA GeoGraph. 
Teachers Jay Hueman and Cathy Stead used USA GeoGraph for several weeks 
in their fifth-grade classes. These educators and their students did much to 
help ensure the quality of the program and its support materials. 

CCopyright MECC 1989 
1llcsc materials may not be rcpvduccd in whole ar 
in part without writtrm permission from MECC. 

135 

Appendix A: 
Credits 



USA GeoGraph User's Guide 

To the Reader: 

MECC has made every effort to ensure the instructional and technical quality 
of this courseware package. Your comments-as user or reviewer-are valued 
and will be considered for inclusion in any future version of the product. 
Please address comments to: 

MECC Software Development 
3490 Lexington Avenue North 

St. Paul, MN 55126 
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There are three reasons for using a data disk with USA GeoGraph: 

• to save and later re-use "documents" that you or your students have 
created with USA GeoGraph; 

• to export data to other programs, such as an Apple Works spreadsheet; and 

• to save data categories that you have added to USA GeoGraph. 

The procedure for creating a data disk is very simple. Just follow the standard 
procedure for starting up your Apple lias using USA GeoGraph (see "Getting 
Started" on page 12). But when the desktop appears, instead of clicking on the 
USA GeoGraph icon, eject the Program Disk or the Information Disk and 
insert an uninitialized 3.5" disk in its place. The program will inform you that 
this disk is unreadable (Figure 95) and will give you the opportunity to change 
your mind about initializing it. (This is done to reduce the chances of your 
accidentally erasing an important disk.) 

GS/OS can't read this volume. Do you wont 
to initialize it? 

( Eject ) ( Initialize ) 

Figure 95 

If you click the "Initialize" button, the program will ask you to give the disk a 
name. Do this and then click OK. Another dialog box appears. Simply click 
the "Initialize" button. The program then proceeds to initialize the disk for use 
with the Apple lias. Once this process is complete, you can eject the data disk, 
reinsert the Program or Information Disk, and then go ahead with starting USA 
GeoGraph. 

Instructions for using a data disk to save documents you or your students have 
created with USA GeoGraph can be found in "Saving a Document" on pages 
88-89. 

Instructions for opening documents previously saved on a data disk are found 
in "Opening an Existing Document from within the Program" on pages 90-91 
and "Opening an Existing USA GeoGraplt Document from the Finder" on 
page92. 

Instructions for exporting data to a data disk so that it can be used with, say, a 
spreadsheet program, are found in "Exporting Data" on pages 92-93. 
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A data disk can also be used to save any data categories you may have added 
to USA GeoGraph (see "Adding a Category to the Database" on pages 
96-99). For instance, you may wish to use one set of "extra" categories with 
one class and a different set with another class. Or you may wish to use 
different sets of extra categories at different times of the school year. Because 
of all of the work involved in creating these new data categories, it's a1 ways 
best to save them before removing them for whatever reason (see "Removing a 
Category" on pages 101-102). 

To save your added categories, you must save onto your data disk the entire set 
of USA GeoGraph categories containing those categories. In other words, 
you'll be saving not only your added categories (from one to three of them) but 
the 105 built-in categories as well. You must have at least two disk drives 
attached to your Apple lies in order to do this. Use the desktop to open the 
window for the USA GeoGraph Information Disk. Then eject the Program 
Disk and replace it with your data disk. Drag the icons called USA.GEO. 
DATAO, USA.GEO.DATAl, USA.GEO.DATA2, and GEOGRAPH. 
MAPS onto the icon for your data disk. This will copy those files onto your 
data disk, which can now function as your Information Disk on those 
occasions when you want to use those categories. 

At this point you can restart USA GeoGraph using the original Information 
Disk and use the "Remove Category" command to remove those categories
taking comfort in the knowledge that those categories are safely stored away 
on a different disk, ready for use whenever you like. 
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USA GeoGraph may be installed on any SCSI hard disk that works with an 
Apple IlGs computer. 

Before installing USA GeoGraph on your hard disk: 

Make sure that the version of the Apple IIGs System installed on your 
hard disk is up to date. Apple periodically issues updated versions of 
the Apple llGs System. Because these updates normally fix errors and 
enhance performance, we recommend that you try to use the most 
recent version of the Apple IIGs System with your hard disk. 

Make sure your hard disk has sufficient capacity for the USA 
GeoGraph application program, database files, and map files, which 
altogether take up about 800K of disk space. 

The procedure for installing USA GeoGraph on your hard disk is quite 
familiar to anyone accustomed to working with the Apple liGs or Macintosh 
desktop interface. Just follow these steps: 

Step 1 

Step2 

Step3 

Step4 

Step 5 

If your Apple IIGs isn't already running, go ahead and start up your 
computer from the hard disk. 

If you have two disk drives, insert both of the USA GeoGraph 
disks (the Program Disk and the Information Disk) in the disk 
drives. 

If you have only one disk drive, insert the USA GeoGraph Program 
Disk. 

Open the USA GeoGraph Program Disk window and use the 
mouse to "drag" the USA GeoGraph icon (see Figure 2 on page 12) 
from the Program Disk window to the hard disk icon. This copies 
the USA GeoGraph application program onto the hard disk. 

If you have only one disk drive, eject the Program Disk when the 
copy process is complete and insert the Information Disk in its 
place. (If you have two disk drives, this step isn't necessary.) 

Now open the USA GeoGraph Information Disk window and drag 
all of the files from the Information Disk window to the hard disk 
icon. This copies the database and map files onto the hard disk. 
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Step 6 

Step 7 

Step 8 

Step 9 

When the copy process is complete, eject the USA GeoGraph 
disk(s) from the disk drive(s). 

Create a new desktop folder and name it USA.GEOGRAPH. (Be 
sure to insert a period instead of a space between the words.) 

Put all of the USA GeoGraph files (the application program 
itself as well as the database and map files) into the 
USA.GEOGRAPH folder. 

Double-click on the USA GeoGraph icon to start running the 
program. 

Note that every time you try to open USA GeoGraph from the hard disk, the 
computer will ask you to insert the Program Disk to verify that you do indeed 
have an "original" copy of the program (Figure 96). This is to protect the 
program from unwarranted copying. Users of hard disks will need to have 
ready access to an "original" Program Disk in order to run USA GeoGraph. 

Please insert the disk: 

USA.GEOGRAPH 

(Cancel) 

Figure 96 

( OK ) 

What if you wish to work with USA GeoGraph in a computer lab setting? The 
most efficient way is to use the Network Version, which is available separately 
from MECC. The Network Version of USA GeoGraph, which is designed to 
run on an AppleTalk network, includes a single USA GeoGraph disk (that • s all 
you need) and copies of the User's Guide and the Classroom Guide, plus a 
network installation card with instructions for installing USA GeoGraph onto 
your network. In this way, a number of students can work with the USA 
GeoGraph program simultaneously. 

USA GeoGraph is also available in specially-priced "Lab Packs" that include 
five Program Disks, five Information Disks, and one copy each of the User's 
Guide and the Classroom Guide. If you have questions about these Lab Packs 
or the Network Version of USA GeoGraph, or if wish to place an order, 
contact MECC at 3490 Lexington Avenue North, St. Paul, MN 55126, or call 
(612) 481-3500. 
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The following information describes each of the 105 data categories used in 
USA GeoGraph. The "Place" category is described first. After that, 
categories are listed alphabetically. The abbreviations that appear in the data 
table headings when the "Abbreviate Category Names" feature is turned on 
appear in brackets after each category name. Very short category names, such 
as "Place," do not have abbreviations. 

Whenever possible, U.S. government statistical data served as the primary 
source of information appearing in the database. See Appendix F, "Selected 
Bibliography," for a list of sources consulted. 

Identifies each state or territory by the name by which it is most generally 
recognized rather than by its official name. For example, "Rhode Island" is 
used rather than the official "Rhode Island and Providence Plantations" and 
"Virginia" is used rather than the official "Commonwealth of Virginia." 

Cites the U.S. Postal Service's official two-letter abbreviation for each state or 
territory. 

Lists four items of agricultural produce-including such animal products as 
beef, pork, wool, and dairy products-that are especially important to a state or 
territory's economy. The produce items are generally listed in order of 
economic importance to that place, although sources and figures often differ 
widely. The absence of an item from this category for a particular state or 
territory does not suggest that the item is not important to the economy of that 
place-only that the items listed are probably more important. 

Cites the estimated value of agricultural commodities produced by a state or 
territory for a single year (1986), expressed in millions of dollars, as reported 
by the U.S. Department of Agriculture. 

Cites the number of airline passengers on regularly scheduled air carriers for a 
single year, in this case 1983. These figures are expressed in thousands of 
passengers and apply to the state in which the reporting airports are located. 
States that rely heavily on hub airports in neighboring states will show low 
figures-in some cases zero, as in the case of Delaware, which relies almost 
exclusively on major airports in Pennsylvania, New Jersey, and Maryland. 
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Annual pay, 
average [Pay] 

Area, land 
[Arl] 

Area, total 
[ArT] 

Area, water 
[ArW] 

Asian population 
[APop] 

Birth rate 
[BR] 

Cites the average annual pay for the people living in a state or territory, based 
on figures for the late 1980s. 

Provides the land area of a state or territory measured in either square miles or 
square kilometers, depending on whether you have chosen to work with 
English or metric units. These figures do not include inland water, such as 
lakes. 

Provides the total area of a state or territory measured in either square miles or 
square kilometers, depending on whether you have chosen to work with 
English or metric units. These figures, which equal the sum of the "Area, 
Land" and "Area, Water" categories, include inland water. 

Provides the water area of a state or territory measured in either square miles 
or square kilometers, depending on whether you have chosen to work with 
English or metric units. These figures include all inland water, such as lakes, 
but do not include off-shore territorial waters that are part of oceans, bays, 
gulfs, or Great Lakes. 

Cites the percentage of a state or territory's population that is of Asian descent, 
including but not limited to Japanese, Chinese, and Southeast Asian, as 
reported by the U.S. Census Bureau. The figures in this category also include 
the indigenous peoples of Hawaii and the various U.S. Pacific territories, 
despite the fact that they are more accurately considered to be of Polynesian, 
Micronesian, or Melanesian extraction. 

Cites the average number of births annually per 1,000 population, based on 
estimates for the mid-1980s made by the National Center for Health Statistics. 
Figures are calculated to the nearest tenth. For comparative purposes, the 
overall figure for the entire world for the same period is 29.0 births per 1,000 
population. 
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Cites the percentage of a state or territory's population that is of African 
descent, as reported by the U.S. Census Bureau. The term "African American" 
has recently been suggested as a term preferable to "black," although this 
proposal has met with some controversy among Black Americans themselves. 
Because of this unresolved nature of this controversy, the makers of USA 
GeoGraph decided to adhere to the terminology currently in use by the U.S. 
Census Bureau, which is "black." In those cases in which persons consider 
themselves "black" in a racial sense but "Hispanic" in an ethno-linguistic 
sense, there may be overlapping of this category with the "Hispanic 
Population" category. In this and the other "ethnic group" categories in USA 
GeoGraph, the figures are based on self-identification. In other wotds, persons 
are placed in the category with which they identify themselves. 

Lists the states, nations, and major bodies of water that border on a state or 
territory. The bodies of water included in this category can be divided into 
three types: primary bodies, regions of those primary bodies, and straits 
passing between primary bodies. 

The primary bodies of water in USA GeoGraph are the Atlantic, Pacific, and 
Arctic Oceans as well as the five Great Lakes. The "water regions" are areas 
or divisions of the primary bodies of water that are outlined by stretches of 
land or chains of islands but aren't truly separated from the larger bodies to 
which they belong. The Gulf of Mexico and the Caribbean Sea, for example, 
are regions of the Atlantic Ocean. Straits, which are important to the world's 
transportation network, are narrow passages connecting larger bodies of water. 
The only strait included in USA GeoGraph is the Bering Strait. "Water 
regions" are listed as subdivisions of the primary bodies of water. 

Arctic Ocean 

Atlantic Ocean 
Caribbean Sea 
Gulf of Mexico 

Bering Strait 

Lake Erie 
Lake Huron 
Lake Michigan 
Lake Ontario 
Lake Superior 

Pacific Ocean 
Bering Sea 

If a state borders on a "region" of a primary body of water but not on the 
primary body itself, only the region is listed in the "Borders" category for that 
state. For instance, Texas borders on the Gulf of Mexico but not on the 
Atlantic Ocean. Although the Gulf of Mexico is a region of the Atlantic 
Ocean, the Atlantic Ocean is not listed as one of Texas's borders. 
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Borders 
(continued) 

Capital 
[Cap] 

Cities 
[Cit] 

Climate zones 
[Ciim] 

Several important bodies of water, such as the Chesapeake Bay and the 
Delaware Bay, aren't listed in the "Borders" category because they cannot be 
considered "borders" in the same sense as the ones previously listed. Rather, 
they are more like internal features of certain states. These are therefore listed 
under "Natural Features" for the appropriate states and territories. (See 
"Natural Features" on page 154.) 

In many cases a river forms the border between two places, such as the Ohio 
River between the states of Ohio and West Virginia. Rivers are not, however, 
listed in the "Borders" category. Instead, Ohio and West Virginia are listed as 
bordering each other, and the Ohio River is listed as a "Natural Feature" of 
both states. 

Identifies the capital city of each state or territory. The only case in which 
there is any ambiguity involves the Northern Marianas. Different sources cite 
either "Saipan" or "Susupe" as the capital. Saipan is the "main island" of the 
Northern Marianas. The U.S. State Department and, in fact, the people of the 
Northern Marianas look upon the entire island as the capital. On the other 
hand, Susupe is the name of the town on Saipan where most governmental 
business takes place. The designers of USA GeoGraph decided to follow the 
State Department in listing Saipan as the capital. Because it is the largest town 
in the Northern Marianas, Susupe is listed in the "Cities" category, described 
next. 

Lists all the cities within a state or territory with a population of at least 
200,000, based on U.S. Census Bureau estimates for the mid-1980s. The cities 
are listed in order of size, with the largest city appearing first. If a place has no 
cities with a population of at least 200,000, the largest city within that state or 
territory is listed. 

Lists the types of climate found within each state or territory. The most 
predominant climate is listed first Keep in mind that large states and 
territories-and sometimes even small ones-may include many different 
climates, although some of those climates may describe very small areas 
within those places. Also note that different geography textbooks and 
reference works use different terminology to describe various climates. In 
many cases climatic descriptions embrace descriptions of vegetation as well. 
USA GeoGraph uses the following climatic terminology, followed by brief 
descriptions: 
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tropical rain forest hot and wet all year; sometimes called "wet tropical" 

savanna hot all year with distinct wet and dry seasons; 
sometimes called "wet-and-dry tropical" 

steppe 

desert 

mediterranean 

subtropical 

marine 

continental 

subarctic 

tundra 

alpine 

hot summers and mild or cold winters with distinct 
moist and dry seasons; sometimes called "prairie" or 
"semiarid" 

dry all year and either hot all year or with hot summers 
and cold winters; sometimes called "arid" 

hot and dry summers, mild and moist winters 

moist all year with hot summers and mild winters; 
sometimes called "humid subtropical" 

mild and moist all year; sometimes called "temperate 
marine" or "maritime" 

moist all year with hot or mild summers and cold 
winters; sometimes called "humid continental" 

moist all year with cool summers and bitterly cold 
winters; sometimes called "taiga" 

cool and moist summers, bitterly cold and dry winters; 
sometimes called "subpolar" 

highly variable temperature and precipitation depending 
upon elevation and latitude, although usually cooler and 
wetter than the surrounding lower-elevation regions; 
sometimes called "highland," "vertical," or "mountain" 

One additional type of climate-that of "ice cap" (bitterly cold and dry all 
year; sometimes called "polar")-is most commonly considered not to occur in 
the United States, although a few sources list it as occurring in parts of Alaska. 

Keep in mind that not all places with mountains boast an alpine climate. 
Relatively low mountains generally do not cause a great enough climatic 
variation to justify the distinction of an alpine climate. A good example of this 
is found in the Appalachian Mountains of the eastern United States. While 
temperature does change somewhat with elevation in these relatively low 
mountains, the deviations from the subtropical or continental norms are not 
great enough to describe the climate as "alpine." 
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Coastline 
[Coast] 

Crime, property 
[CrimP] 

Crime, violent 
[CrimV] 

Date of admission 
[Date] 

Cites the amount of coastline for each state or territory measured in miles or 
kilometers, depending on whether you have chosen to work with English or 
metric units. In this category, coastline is considered to be that part of a state 
or territory that borders on an ocean, a Great Lake, the Gulf of Mexico, or the 
Caribbean Sea. Shores that border on more or less "internal" bodies of water, 
such as the Chesapeake Bay, are not counted here. 

Cites the number of instances of property crime per 100,000 population, as 
reported by the Federal Bureau of Investigation (FBI) for the year 1987. 
"Property crimes" are those that involve loss of property without threat of 
personal injury, such as burglary, larceny, and theft, including motor vehicle 
theft. 

Cites the number of instances of violent crime per 100,000 population, as 
reported by the Federal Bureau oflnvestigation (FBI) for the year 1987. 
"Violent crimes" are those that involve actual or threatened personal injury, 
such as murder, non-negligent manslaughter, rape, robbery, and aggravated 
assault. 

Cites the date on which a state entered the union. Of course, for territories, 
including the District of Columbia, this category lists "not applicable." The 
date of admission for each of the original thirteen states is traditionally 
considered to be the date on which that state ratified the U.S. Constitution. Of 
the thirteen, Delaware was the frrst to do so and Rhode Island was the last. 

Special note should also be made of the case of North and South Dakota. On 
November 2, 1889, President Benjamin Harrison had the bills of statehood for 
both states before him at the same time. In order to avoid antagonizing 
citizens of either state by signing the other state's bill frrst, Harrison shuffled 
the bills, signed them quickly, and reshuffled them, so that nobody-not even 
he--knew for sure which state entered the union frrst. The tradition has arisen, 
however, that North Dakota is considered to be the thirty-ninth state and South 
Dakota the fortieth. Thus, whenever you sort the USA GeoGraph database 
according to the "Date of Admission" category, North Dakota will always 
precede South Dakota, adhering to tradition despite the fact that their entries in 
this category are identical. 
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Cites the average number of deaths annually per 1,000 population, based on 
U.S. government estimates for the mid-1980s. Figures are calculated to the 
nearest tenth. For comparative purposes, the overall figure for the entire world 
for the same period is 11.0 deaths per 1,000 population. 

Cites for each state or territory the percentage of persons aged 25 or older who 
have completed at least four years of college, as reported by the U.S. Census 
Bureau. 

Cites for each state or territory the average dollar expense per pupil in average 
daily attendance in public schools for the school year ending in June 1987, as 
reported by the National Education Association. 

Cites for each state or territory the percentage of persons aged 25 or older who 
have completed at least four years of high school, as reported by the U.S. 
Census Bureau. 

Cites for each state or territory the percentage of persons aged 25 or older who 
have obtained less than five years of formal education, as reported by the U.S. 
Census Bureau. The persons who are referred to in this category have received 
no more than an elementary education in school. 

Cites the number of electoral votes for each state in presidential elections. 
These figures, based upon the 1980 census and the resultant state 
representation in Congress, are accurate for the 1984 and 1988 elections. In all 
likelihood, some of these figures will change for the 1992 election as a result 
of the 1990 census. 

Cites the percentage of a state or territory's total supply of electricity that is 
produced through the burning of coal, as reported by the U.S. Energy 
Information Administration. These figures (as well as those for the other four 
"Electricity" categories) are for the year 1983. The figures in these five 
categories may not add up to 100% because of estimation, rounding, and the 
fact that some electricity is produced through other means, such as wood
burning, waste-burning, and geothermal sources. 
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Electricity, gas Cites the percentage of a state or territory's total supply of electricity that is 
[EIG] produced through the burning of natural gas, as reported by the U.S. Energy 

Information Administration. 

Electricity, hydro Cites the percentage of a state or territory's total supply of electricity that is 
[EIH] produced at hydroelectric power plants, as reported by the U.S. Energy 

Information Administration. 

Electricity, nuclear Cites the percentage of a state or territory's total supply of electricity that is 
[EIN] produced at nuclear power plants, as reported by the U.S. Energy Information 

Administration. 

Electricity, Cites the percentage of a state or territory's total supply of electricity that is 
petroleum produced through the burning of petroleum, as reported by the U.S. Energy 

[EIP] Information Administration. 

Elevation, average 
[EvAv] 

Elevation, highest 
[EvHi] 

Elevation, lowest 
[Evlo] 

Cites the average elevation within the boundaries of each state and territory, 
measured in feet or meters, depending on whether you have chosen to work 
with English or metric units. These and other elevation figures in USA 
GeoGraph are from the U.S. Geological Survey. 

Cites the highest elevation within the boundaries of each state and territory, 
measured in feet or meters, depending on whether you have chosen to work 
with English or metric units. 

Cites the lowest elevation within the boundaries of each state and territory, 
measured in feet or meters, depending on whether you have chosen to work 
with English or metric units. For many (but not all) places bordering on 
oceans, the lowest elevation is at sea level, which is listed as "0" (zero) feet or 
meters. Negative values indicate lowest elevations below sea level. 
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Cites the amount of commercial energy consumed in one year within each state 
or territory, expressed either in trillions of BTUs (British Thermal Units) or in 
millions of megawatt-hours, depending on whether you have chosen to work 
with English or metric units. This data is based on energy-industry estimates 
for the mid-1980s and includes energy consumed in a variety of forms, 
including fossil fuels and electricity (however generated-hydroelectric, 
nuclear, geothermal, tidal, etc.). Figures are rounded to the nearest tenth. 

Cites the average annual energy consumption per person for each state or 
territory, expressed either in millions of BTUs (British Thermal Units) or in 
megawatt-hours, depending on whether you have chosen to work with English 
or metric units. This data is based on energy-industry estimates for the mid-
1980s and includes energy consumed in a variety of forms, including fossil 
fuels and electricity (however generated-hydroelectric, nuclear, geothermal, 
tidal, etc.). Figures are rounded to the nearest tenth. For purposes of 
comparison, the annual energy consumption per capita in 1985 for the world 
overall was 61.8 million BTUs or 18.1 megawatt-hours. 

Cites the amount of commercial energy produced in one year within each state 
or territory, expressed either in trillions of BTUs (British Thermal Units) or in 
millions of megawatt-hours, depending on whether you have chosen to work 
with English or metric units. This data is based on energy-industry estimates 
for the mid-1980s and includes energy produced in a variety of forms, 
including fossil fuels and electricity (however generated-hydroelectric, 
nuclear, geothermal, tidal, etc.). Figures are rounded to the nearest tenth. 

Cites the annual commercial energy production per person for each state or 
territory, expressed either in millions ofBTUs or in megawatt-hours, 
depending on whether you have chosen to work with English or metric units. 
This data is based on energy-industry estimates for the mid-1980s and includes 
energy produced in a variety of forms, including fossil fuels and electricity 
(however generated-hydroelectric, nuclear, geothermal, tidal, etc.). Figures 
are rounded to the nearest tenth. For purposes of comparison, the annual 
energy production per capita in 1985 for the world overall was 54.3 million 
BTUs or 15.9 megawatt-hours. 

Lists several items of general interest: state nickname(s), bird, flower, and 
tree. Some U.S. territories have territorial nicknames, birds, flowers, and/or 
trees, while others do not. 
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Gross domestic 
product 

[GOP] 

Ground water 
dependence 

[GWD] 

Hazardous waste 
production 

[HWP] 

Highway mileage 
[HiMi] 

Highway usage 
[Hi Us] 

Hispanic 
population 

[HPop] 

Cites the gross domestic product (GDP) of a state or territory; that is, the total 
value of final goods and services produced by a place or generated by 
commerical transactions in a given year-usually between 1984 and 1986. 
These figures are expressed in millions of dollars. 

Cites the percentage of a state or territory's population that is dependent upon 
ground water resources (as opposed to rivers, lakes, and other "above ground" 
water resources) for their drinking water, as reported by the U.S. Geological 
Survey. 

Cites the amount of hazardous waste produced within a state or territory in a 
single year, measured in thousands of tons or metric tons, depending on 
whether you have chosen to work with English or metric units. These figures 
are based upon Environmental Protection Agency (EPA) estimates for the mid-
1980s. In this instance, the term "hazardous waste" is used as a catch-all 
phrase to describe waste materials the dangers of which may be of a chemical, 
biological, or radioactive nature. 

Cites the approximate amount of paved roadway within a state or territory's 
boundaries, measured in miles or kilometers, depending on whether you have 
chosen to work with English or metric units. These figures include both rural 
and urban roads and, in most cases, are rounded to the nearest hundred. 

Describes the relative usage of highways within each state or territory in terms 
of the average distance traveled over each unit of roadway per year, measured 
in miles per mile or kilometers per kilometer, depending on whether you have 
chosen to work with English or metric units. The figures in this category 
(which are rounded to the nearest hundred) are obtained by dividing the total 
mileage traveled by all land-based motor vehicles within a given year for each 
state or territory by the highway mileage in that state or territory. In short, this 
category provides useful figures for comparing the degree of usage of 
highways from place to place. 

Cites the percentage of a state or territory's population that is of Hispanic 
heritage, including Mexican, Puerto Rican, Cuban, and other Latin American 
ancestry with Spanish cultural and linguistic ties, as reported by the U.S. 
Census Bureau. Because this category is of an ethno-linguistic nature, it may 
embrace people of European, African, Native American, or mixed descent. 
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Cites up to three major industries for each state or territory, based on_ 
percentage of labor force. Here, "industries" refers to general fields of 
economic endeavor, including agriculture (which embraces both the tilling of 
soil and the raising of livestock). 

Cites the average number of children born alive who die before their first 
birthday per 1,000 live births per year, based on estimates for the mid-1980s 
by the National Center for Health Statistics. Figures are calculated to the 
nearest tenth. For comparative purposes, the overall figure for the entire world 
for the same period is 65.0 infant deaths per 1,000 live births. 

Cites the percentage of adult women within a state or territory who are 
participants in the labor force-that is, who either have jobs or are looking for 
jobs outside the home. Keep in mind that this is not the percentage of the labor 
force that consists of women. The figures in this and the other labor-related 
categories are based on estimates by the U.S. Bureau of Labor Statistics. 

Cites the percentage of adult men within a state or territory who are 
participants in the labor force-that is, who either have jobs or are looking for 
jobs outside the home. Keep in mind that this is not the percentage of the labor 
force that consists of men. 

Cites the percentage of the labor force in each state or territory that is engaged 
in agriculture. For the purposes of this category, "agriculture" includes the 
raising of livestock as well as the tilling of soil. 

Cites the percentage of the labor force in each state or territory that is engaged 
in manufacturing, construction, extractive, or other non-agricultural "blue
collar" industries. 

Cites the percentage of the labor force in each state or territory that is engaged 
in office or "professional" work-that is, "white-" or "pink-collar" jobs. 
These figures include many persons employed by the government and/or in 
service industries, so there is significant overlap with the "Labor Force in 
Services" category. 
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Labor force in 
services 

[LFSv] 

Land, built-up 
[LB] 

Land, cropland 
[LC] 

Land, federal 
[LFed] 

Cites the percentage of the labor force in each state or territory that is engaged 
in service industries-such as education, medicine, banking, insurance, 
plumbing, and so on, in which one's "product," so to speak, is one's own 
service and expertise. These figures include many persons employed by the 
goverment and/or in office or professional work, so there is significant overlap 
with the "Labor Force in Office Work" category. 

Cites the percentage of non-federalland within a state or territory that is 
constructed upon or paved over. The figures in this category include land used 
for residences, industrial sites, commercial sites, small urban parks, golf 
courses, cemetaries, airports, highways, land fills, and other types of 
construction. The information in this and the next five "land" categories 
comes from the U.S. Department of the Interior. 

Cites the percentage of non-federalland within a state or territory that is used 
to produce crops for harvest. 

Cites the percentage of land within a state or territory that is owned by the U.S. 
federal government. It includes (but is not restricted to) military bases. It also 
includes land embraced by other land-use categories in USA GeoGraph, 
particularly "Land, Built-up," "Land, Forested," and "Land, Rangeland." 

Land, forested Cites the percentage of non-federalland within a state or territory that is 
[LFor] "forested," defined as land with at least a 25% tree canopy cover or at least 

10% stocked by forest trees of any size. 

Land, pasture 
[LP] 

Cites the percentage of non-federalland within a state or territory that is 
covered by forage plants that have been introduced by humans for the purpose 
of grazing by animals. 

Land, rangeland Cites the percentage of non-federalland within a state or territory covered by 
[LR] low-lying natural vegetation, such as grasses, forbs, or shrubs, which may or 

may not be used by humans for the purpose of grazing by animals. 
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Cites the number of years a female infant born in a particular state or territory 
in the mid-1980s may be expected to live. These figures and those in the next 
category are calculated to the nearest tenth and are based on actuarial estimates 
that take into account a wide range of natural and social factors, including 
nutrition, health care, and violence. These figures do not represent the average 
age at which people are likely to die once they have grown up. In other words, 
if the female life expectancy figure for a place is 75.0, that does not mean that 
the average age of death of the adult females currently living in that place is 
75. Rather, it means that females born during the 1980s may be expected to 
live, on the average, to age 75. 

Cites the number of years a male infant born in a particular state or territory in 
the mid-1980s may be expected to live. 

Cites the percentage of families within a state or territory whose household 
income falls below the federal government's definition of poverty level, which 
varies according to household size. The term "low-income families" is 
preferred to something like "families living in poverty" because not all 
families whose household incomes fall below the government's "poverty 
threshold" are in fact "poor." For example, a farm family that raises a large 
amount of its own food may enjoy a considerably higher standard of living 
than an urban family with an equal or even higher monetary income. "Low
Income Family" is therefore a more accurate, less "biased" term, simply 
stating the facts of low household incomes without making assumptions about 
associated standards of living. 

Lists up to three types of manufacturing industries (generally referred to by the 
generic terms for the actual goods produced) that are especially important to a 
state or territory's economy. These items are generally listed in order of 
economic importance to that state or territory, although sources and figures 
often differ widely. The absence of an item from this category for a particular 
place does not suggest that the item is not important to the economy of that 
place-only that the items listed are probably more important. 

Cites the estimated value-added (the final value of products minus the cost of 
the raw materials from which they were made) of manufactured goods 
produced by a state or territory for a single year (1985), expressed in millions 
of dollars. 
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Millionaires Cites the number of millionaires living in a state or territory per 100,000 
[Mill] population in the year 1982. 

Minerals and fuels 
[M&F] 

Lists up to three minerals and/or fossil fuels that are especially important to a 
state or territory's economy. These items are generally listed in order of 
economic importance to that place, although sources and figures often differ 
widely. The absence of an item from this category for a particular state or 
territory does not suggest that the item is not important to the economy of that 
place-only that the items listed are probably more important. For some 
places this category may include only one or two items or even "none." Such 
instances suggest that the state or territory is poor in mineral resources, is not 
yet able to exploit its mineral resources effectively, or relies heavily on just 
one or two mineral resources. 

Minerals and fuels Cites the estimated value of minerals and fuels produced by a state or territory 
value [M&FV] for a single year (1980), expressed in millions of dollars. 

Native American 
population 

[NPop] 

Natural features 
[NatF] 

Cites the percentage of a state's population that is of Native American descent, 
including American Indians, Eskimo (Inuit), and Aleuts, as reported by the 
U.S. Census Bureau. The figures in this category do not include the 
indigenous peoples of Hawaii and the various U.S. island territories. In those 
cases in which persons consider themselves American Indians in a racial sense 
but "Hispanic" in an ethno-linguistic sense, there may be overlapping of this 
category with the "Hispanic Population" category. 

Cites the natural features (such as rivers, bays, mountain ranges, mountain 
peaks, islands, and deserts) most often mentioned in geography textbooks for 
each state and territory. Constructed features, such as canals and dams, are not 
included. Generally the larger states have many entries in this category while 
smaller states and territories have fewer. 

If a natural feature appearing in the database lies within the boundaries of more 
than one state, it is listed under all of the states in whose boundaries it lies. 
Similarly, if a natural feature straddles the border of two states, it is included 
under both states. (For example, Lake Tahoe straddles the border of California 
and Nevada, so it is listed under both states.) Major rivers forming the borders 
of states are also included. Bordering oceans and Great Lakes are not 
included; see "Borders" on pages 143-144. 
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Cites the annual rate of natural increase of population in a state or territory, 
expressed in terms of persons per 1,000 population and based on U.S. Census 
Bureau estimates for the mid-1980s. Basically, this figure is obtained by 
subtracting the death rate from the birth rate. Figures are calculated to the 
nearest tenth. For those places in which the death rate exceeds the birth rate, a 
negative figure appears in this category. For comparative purposes, the overall 
figure for the entire world for the same period is 18.0. 

Cites the net change in the population of a state or territory over the period 
from 1980 to 1987 that occurred through migration-not through natural 
increase. In other words, the figure in this category represents the number of 
people who migrated into a state or territory during this period minus the 
number of people who migrated out of that state or territory. This information 
is based on U.S. Census Bureau estimates. A negative value indicates that 
more people left a state or territory than entered it during this period. 

Cites the total estimated nitrogen oxide air pollutant emissions in each state 
and territory in a single year (1982), measured in thousands of tons or 
thousands of metric tons, depending on whether you have chosen to work with 
English or metric units. The information in this and the next category is based 
upon estimates by the U.S. Environmental Protection Agency (EPA). Nitrogen 
oxides are major contributors to the problem of acid rain. 

Cites the total estimated particulate (dust, ash, smoke) air pollutant emissions 
in each state and territory in a single year (1982), measured in thousands of 
tons or thousands of metric tons, depending on whether you have chosen to 
work with English or metric units. 

Cites the annual per capita income of each state or territory, expressed in 
dollars, based on U.S. Bureau of Economic Analysis estimates for 1987. 
These figures are useful as one factor to consider in evaluating and comparing 
the "standard of living" in different places. They're obtained by dividing a 
state or territory's gross domestic product figure for a given year by its 
population figure for the same year. The figures in this category, however, 
will not agree with those you would obtain if you divide the figures in the 
"Gross Domestic Product" category by those in "Population 1988" because of 
the difference in years of calculation (1987 versus 1988) as well as the 
rounding of figures and other adjustments. 
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Political index 
[Pol] 

Provides a rough indication of the partisan political leanings of a state, based 
upon the 1988 state and federal elections and, for offices not up for election in 
1988, the current party affiliations of those holding offices at the time of the 
elections. For each state, values were assigned to either the Republican or 
Democratic Party based on the following scale: 

1988 presidential election - 10 points 
federal senators - 4 points each 

federal representatives - 2 points each 
governors - 5 points 

state senators and representatives - 1 point each 

When these points were totaled for each state, the state was designated 
"Republican" or "Democratic" depending on whether the Republican or 
Democratic Party received a majority of the points. Then, the majority figure 
was divided by the total figure to obtain a percentage figure that, because it 
always represented the majority, would always be greater than 50 but less than 
100. This would suggest the relative strength of the "majority" party in each 
state's politics. One of the parties was then designated as starting at 0 (zero) 
and the other as starting at 100. (For fairness, the flip of a coin determined that 
0 would represent a "totally" Democratic "ideal" and that 100 would represent 
a "totally" Republican "ideal.") Then the majority percentage figure for 
"Democratic" states was subtracted from 100 to obtain an index figure. The 
following scale resulted: 

0 

strongly 
Democratic 

12.5 

somewhat 
Democratic 

25.0 37.5 

borderline 

50 

somewhat 
Republican 

62.5 75.0 

strongly 
Republican 

87.5 100 

Therefore a state with a Political Index of, say, 13.2 would be strongly 
Democratic, with the Democratic Party having a virtual lock-hold on political 
power in that state. A state with an index of 34.5 would be somewhat 
Democratic but not overwhelmingly so. An index of 48.9 would very much 
indicate a borderline state in which neither party has clear dominance. An 
index of 63.1 would suggest a somewhat Republican state, but, again, not 
overwhelmingly so. And an index of 88.6 would indicate a state that is 
strongly Republican, to the virtual exclusion of the Democratic Party. 

If students were to sort states "from 0 to 9" on the basis of Political Index, the 
states ranking "first" would be the ones most strongly Democratic and the ones 
ranking "last" would be the ones most strongly Republican. Students should, 
however, keep in mind that this indicator is just that-an indicator useful for 
comparative and speculative purposes, and not by any means a definitive 
figure. 

156 ©Copyright MECC 1989 
These materials may not be reproduced in whole or 

in part without written permission from MECC. 



USA GeoGraph User's Guide 

Cites the approximate population living within the rrwdern-day borders of a 
state or territory in 1800, as reported by the U.S. Census Bureau. Figures are 
rounded to the nearest thousand. It is very important to keep in mind that these 
figures are for modem-day borders. For instance, in 1800, the state of Virginia 
included the modem-day states of Virginia and West Virginia; the state of 
Massachusetts included the modem-day states of Massachusetts and Maine. 
The figures reported in this category, however, embrace only that portion of a 
state's population living in its modem-day territory-not its territory in 1800. 
The figure for West Virginia is the number of persons who in 1800 were living 
in that part of Virginia that eventually became West Virginia. The figure for 
Maine is the number of persons in 1800 living in that part of Massachusetts 
that eventually became Maine. 

For other places that were not yet states in 1800 but for which reliable 
population estimates within those eventual borders are available, those figures 
are provided. If the entry in this category for a particular state or territory 
reads "no data available," it means precisely that-not that no one lived in that 
area in 1800. 

Cites the approximate population living within the rrwdern-day borders of a 
state or territory in 1850, as reported by the U.S. Census Bureau. Figures are 
rounded to the nearest thousand. Once again, it is important to keep in mind 
that these figures are for modem-day borders. In 1850, the state of Virginia 
still included the modem-day state of West Virginia. The figures reported in 
this category embrace only that portion of a state's population living in its 
modem-day territory-not its territory in 1850. The figure for West Virginia 
is the number of persons who in 1850 were living in that part of Virginia that 
eventually became West Virginia. 

For other places that were not yet states in 1850 but for which reliable 
population estimates within their eventual borders are available, those figures 
are provided. If the entry in this category reads "no data available," it means 
precisely that-not that no one lived in that area in 1850. 

Cites the approximate population living within the various states and territories 
in 1900, as reported by the U.S. Census Bureau. Figures are rounded to the 
nearest thousand. By 1900, the borders of all modem U.S. states had become 
"solidified," despite the fact that several eventual states (Oklahoma, New 
Mexico, Arizona, Alaska, and Hawaii) had not yet entered the union and were 
still territories. Population figures for 1900 are, however, available for these 
eventual states. 
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Population 1900 If the entry in this category for a modern-day territory reads "no data 
(continued) available," it means precisely that-not that no one lived there in 1900. 

Population 1950 
[P1950] 

Population 1988 
[P1988] 

Population 2000 
(projected) 

[P2000] 

Cites the approximate population living within the borders of a state or 
territory in 1950, as reported by the U.S. Census Bureau. Figures are rounded 
to the nearest thousand. 

Cites the approximate population living within the borders of a state or 
territory in 1988 (the most recent year for which reliable figures are available 
for every state), as reported by the U.S. Census Bureau. Figures are rounded to 
the nearest thousand. 

Provides the U.S. Census Bureau's estimate of the most likely population of a 
state or territory in the year 2000, based on current trends and patterns of birth, 
death, and migration. Figures are rounded to the nearest thousand. 

Population age 65 Cites the percentage of a state or territory's population age 65 and over. These 
and over figures are based on U.S. Census Bureau data for 1987 and are calculated to 

[P65+] the nearest tenth of a percentage point. 

Population born 
outside state 

[PBOS] 

Population density 
[Dens] 

Population 
foreign-born 

[PFB] 

Cites the percentage of a state or territory's population in 1980 born outside 
the borders of that state or territory. 

Cites for each state or territory the average number of people per square mile 
or square kilometer, depending on whether you have chosen to work with 
English or metric units. Figures are rounded to the nearest tenth. These 
figures are obtained by dividing the overall 1988 population by the land area, 
although the figures here may not precisely match those you might obtain by 
dividing the population and area figures provided in the database because of 
the rounding off of data. 

Cites the percentage of a state or territory's population in 1980 born in 
countries other than the United States and its territories. This figure does not 
include children born of U.S. citizens temporarily living overseas (as in 
military or diplomatic service). 
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Cites the net increase in population for a state or territory over the period from 
1980 to 1987. This figure combines the population change due to migration 
with the population change due to natural increase. In other words, this figure 
represents the number of people who migrated into a state or territory during 
this period plus the number of people born there, minus the number of people 
who migrated out of that state or territory and minus the number of people who 
died there. A negative value indicates a net decrease in population. 

Cites the annual rate of total population increase in a state or territory, 
expressed as a percentage of the 1980 population. These figures are based on 
U.S. Census Bureau estimates for the the period from 1980 to 1987. This 
figure takes into account both natural increase (births minus deaths) and net 
migration (in-migration minus out-migration). Negative values indicate 
decreasing populations. 

Cites the number of people per physician in each state or territory, based on 
mid-1980s figures from the U.S. Census Bureau. 

Cites the percentage of a state or territory's population under the age of 15. 
These figures are based on 1987 estimates from the Population Reference 
Bureau in Washington, D.C., and are calculated to the nearest tenth of a 
percentage point. 

Cites the average annual precipitation for each state or territory, expressed in 
either inches or millimeters, depending on whether you have chosen to work 
with English or metric units. Figures are rounded to the nearest tenth of an 
inch or to the nearest millimeter. Precipitation in the form of snow is 
converted to its equivalent in rainfall. 

For states with several different types of climates, average annual precipitation 
for various locations within that state are averaged together to result in an 
average for the state as a whole. Obviously, for very large states, such as 
Alaska, Texas, and California, many different locales are used, and annual 
average precipitation for the various locations can range anywhere from 
virtually nothing to well over 60 inches per year. Even very small states, such 
as Hawaii, can have startling variations depending on where the measurements 
are taken. Still, the same technique of averaging the figures for different 
locations is always used. This results in a state or territorial average that, 
despite its shortcomings, is nevertheless useful for comparative purposes. 
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Recreation lands 
[Reel] 

Region 

Soil erosion 
[Soil] 

Status 

Cites the amount of land within each state or territory that has been set aside 
for recreational use-specifically federal, state, and local parks and forests
expressed in square miles or square kilometers, depending on whether you 
have chosen to work with English or metric units. 

Identifies the region of which each state or territory is a part. Different 
geography textbooks and reference works recognize different "breakdowns" of 
regions. For instance, some books cite the "Northeast" as a single region, 
while others divide it into "New England" and the "Middle Atlantic States." 
Some books cite all of the "South" as a single region, while others break it 
down further. And even when regional terminology is in basic agreement, 
often there are disagreements as to which states are included. Is Maryland part 
of the Northeast or the South? Is Kentucky part of the South or the Midwest? 
Is Alaska part of the West or a separate region unto itself? 

While geography textbooks were certainly an important consideration in 
determining what would be the breakdown of regions in USA GeoGraph, a 
major influence on the final determination was the fact that each regional map 
would have to be depicted in a clear and useful manner on the computer 
screen. In other words, what would "fit"? The designers of USA GeoGraph 
decided to adhere to the "official" regional breakdown used by the U.S. Census 
Bureau, which consists of the "Northeast," "Midwest," "South," and "West." 
In addition, USA GeoGraph includes two additional regions for U.S. 
territories: "Caribbean Island Territories" and "Pacific Island Territories." 

Cites the average annual loss of cropland due to natural forces (wind, rain, etc.) 
within each state or territory, expressed in thousands of tons or thousands of 
metric tons, depending on whether you have chosen to work with English or 
metric units. This information is based upon estimates by the U.S. Department 
of Agriculture Soil Conservation Service. 

States simply whether each place is a state or a territory. The word "territory" 
is used as a generic term for all U.S. "possessions" that are not among the fifty 
states and includes the District of Columbia as well as island dependencies in 
the Pacific and Caribbean. 
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Cites the total estimated sulfur oxide air pollutant emissions in each state and 
territory in a single year (1982, the most recent year for which reliable figures 
are available for every state), measured in thousands of tons or thousands of 
metric tons, depending on whether you have chosen to work with English or 
metric units. This information is based on estimates by the Environmental 
Protection Agency. Sulfur oxides contribute to the problem of acid rain. 

Cites the average January temperature for each state or territory, expressed in 
either degrees Fahrenheit or degrees Celsius, depending on whether you have 
chosen to work with English or metric units. Figures are rounded to the 
nearest whole number. The average temperature for the month takes into 
account both the average high daytime temperature and the average low 
nighttime temperature. 

As with the "Precipitation, Annual Average" category (see page 159), average 
temperature can vary widely from one part of a state to another, especially in 
larger states. Again, the technique of calculating the average from a variety of 
locations within the larger states is used. This results in a state or territorial 
average figure that, despite its shortcomings, is useful for comparative 
purposes. 

Cites the average July temperature for each state or territory, expressed in 
either degrees Fahrenheit or degrees Celsius, depending on whether you have 
chosen to work with English or metric units. Methodology is identical to that 
of the "Temperature, January Average" category. 

Provides the number of final and proposed toxic waste sites in each state or 
territory that have been placed on the National Priorities List as of June 1988, 
as determined by the Environmental Protection Agency. These sites are 
selected through the use of a numerical evaluation system that measures the 
risk posed by the site. Sites on this list are given priority in receiving federal 
funds for clean-up. The current list includes 1,177 sites. 

Cites the unemployment rate as a percentage of the labor force in each state or 
territory, as reported by the U.S. Bureau of Labor Statistics. These figures are 
for the year 1987. 
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Union membership 
[Union] 

Urban population 
1980 

[Urban] 

Urban population 
change 1970-80 

[UPC] 

Water use for 
irrigation 

[lrrig] 

Water use 
per capita 

[WUC] 

White population 
[WPop] 

Cites union membership as a percentage of the employed non-agricultural 
labor force in each state or territory, as reported by the Industrial Relations 
Data and Information Services. These figures are for 1982. 

Cites the percentage of a state or territory's population living in urban areas, as 
determined by the U.S. Census Bureau in the 1980 census. The "urban 
population" is defined as all persons living in places with populations of 2,500 
or more that are incorporated as cities, villages, boroughs, or towns, but 
excluding persons living in rural portions of extended cities. Using this 
criterion, all populations in the United States are defined as either "urban" or 
"rural." 

Cites the change in the urban population of a state or territory from 1970 to 
1980. This figure is obtained by subtracting the urban population percentage 
for 1970 (as reported by the U.S. Census Bureau) from the urban population 
percentage for 1980. A negative figure indicates that the percentage of a state 
or territory's population that lives in urban areas decreased from 1970 to 1980. 

Cites the average amount of water used per day within a state or territory for 
the purpose of agricultural irrigation, measured in millions of gallons or 
millions of liters, depending on whether you have chosen to work with English 
or metric units. These figures are for the year 1985 as reported by the U.S. 
Geological Survey. 

Cites for each state or territory the average amount of water used per day per 
person, measured in gallons or liters, depending on whether you have chosen 
to work with English or metric units. Again, these figures are for 1985 as 
reported by the U.S. Geological Survey. 

Cites the percentage of a state or territory's population that is "white"-that is, 
of European descent-as reported by the U.S. Census Bureau. In those cases 
in which persons consider themselves "white" in a racial sense but "Hispanic" 
in an ethno-linguistic sense, there may be overlapping of this category with the 
"Hispanic Population" category. 
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USA GeoGraph includes 24 theme maps that can be viewed at the "Fifty 
States Map" level. The following descriptions provide information about each 
of these maps. They are arranged in alphabetical order. 

Keep in mind that the state and national borders that appear on these maps are 
always modem-day, even on theme maps of a historical nature. If you wish, 
you can use the Maps menu's "Hide Boundaries" command to remove the state 
borders. In addition, remember to use the "Show Key" command, also on the 
Maps menu, to view an explanatory color-key for each map. 

Depicts various ranges of the average acidity of rainfall in different parts of the 
United States, measured in pH units. The lower the pH, the more acidic the 
rain. Although a pH of 7.0 is "neutral" (neither acid nor base), rainfall is 
normally slightly acidic, so only rainfall with a pH reading of less than 5.6 is 
usually considered "acid rain." Nevertheless, this map delineates areas with 
pH readings as high as 6.5. Acid rain should therefore be considered a 
significant problem in those areas on this map with average pH readings of 5.5 
or lower. This map is based on reports from the Canada/United States 
Co-ordinating Committee on Transbounding Air Pollution. 

Indicates the predominant type(s) of agriculture (including dairy farming and 
livestock raising) in various parts of the United States. 

Shows how the United States was divided during the American Civil War from 
1861 to 1865. Southern states that seceded from the Union and formed the 
"Confederate States of America" are shown in red. Slave states whose 
governments remained loyal to the Union (sometimes referred to as the 
"Border States") are shown in a mixed red and blue pattern, which results in a 
somewhat "checkered purple" appearance. Note that West Virginia, which 
was formed in 1863 out of counties in Virginia that remained loyal to the 
Union, falls into this category. The remaining Union states (the "Free States") 
are shown in blue. 

U.S. territories that had not yet become states are shown in yellow. Most of 
these territories remained fmnly in Union control, although for a brief time the 
area immediately to the west of Texas was controlled by a territorial 
government sympathetic to the Confederacy. The Indian Territory (present
day Oklahoma) was itself divided, with some tribes supporting the Union, 
others supporting the Confederacy, and still others remaining neutral. Alaska 
and Hawaii, which were not U.S. territories during the Civil War, are shown in 
gray, just like the foreign nations of Canada and Mexico. 
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Climate zones Shows the various climate zones in the United States. For brief descriptions of 
the characteristics of each climate zone appearing on this map, see the 
information about the "Climate Zones" database category (on pages 144-145) 
in Appendix D, "Descriptions of the Categories Used in USA GeoGraph." 

Dialect regions Distinguishes the geographic regions most closely associated with the major 
dialects of modem American English as described by various linguists, most 
notably John Nist in his book A Structural History of English. Keep in mind 
the following facts: 

The thirteen dialect regions shown on this map and described below only 
represent major dialects. Each major dialect contains various sub-dialects. 

"Black American" dialect (or, more accurately, dialects) does not appear 
on this map because, far more so than any of the dialects that do appear on 
the map, its use hinges upon a particular ethnic group rather than upon 
geographic location. Some linguists consider Black American English a 
specialized sub-dialect of the Southern dialect, whereas others consider it 
quite separate altogether. 

In this age of mass communication and extreme mobility, distinctions 
among dialects of American English are becoming less conspicuous all the 
time. Lack of dialectal distinctions will be especially pronounced near the 
"boundaries" between any two dialect regions. 

Again because of the extreme mobility of American society, large 
numbers of persons living within any particular dialect region shown on 
this map do not speak in that dialect. 

Central Midland dialect-This variation of modem American English is 
generally considered to be the best candidate for "Standard American," and is 
thus sometimes called "Emerging General American." Not only is it the 
predominant dialect of the vast central region of the United States, but it is also 
the favored speech of the mass media, particularly television. Television 
network news anchors almost invariably speak in the Central Midland dialect. 

New England dialect-This dialect is characterized by the "loss" of the r 
sound in the middle of such words as "bam" (pronounced hahn) and horse 
(hoss); the addition of a final r sound in many words ending in a, such as 
"idea" (ideer) and "Cuba" (Cubar); the use of a "broad" British a in works like 
"ask" (ahsk) and "aunt" (ahnt); and the addition of they sound before the 
"long" u sound in such words as "dew" (dyoo) and "news" (nyooz). 
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New York City dialect-Found in New York City and its suburbs, this dialect 
is characterized by the dropping of the final r in such words as "brother" 
(brutha) and "another'' (anutha) and the substitution of the t sound for the thin 
words like "thought" (pronounced just like taught) and the d sound for the th 
in words like "this" (dis) and "that" (dat). Sometimes the er sound at the 
beginning and in the middle of words is pronounced oi, as in the case of "bird" 
being pronounced boid. In other cases the reverse is true, with words like 
"toilet" being pronounced terlet. The New York City dialect shows the strong 
influence of nineteenth- and early twentieth-century European immigration, 
particularly of Jews and Italians. 

Middle Atlantic dialect-This dialect differs little from Central Midland 
(Emerging General American), although it betrays some influence of the 
neighboring New York City and Southern dialects. 

Western Pennsylvania dialect-Found almost exclusively in the western half 
of Pennsylvania, though spilling over slightly into neighboring states, this 
dialect is also similar to Central Midland, although with a strong 
"Pennsylvania Dutch" (German) influence, particularly in its idioms and 
vocabulary. 

North Central dialect-Although a direct "descendant" of the New England 
dialect, the North Central dialect has lost many of the older dialect's unusual 
features-so much so that, in many ways, it is almost indistinguishable from 
Central Midland. Primary differences lie in vocabulary and idioms, although 
speakers of the North Central dialect pronounce the word "greasy" exclusively 
with an s sound, whereas in Central Midland, "greasy" may be acceptably 
pronounced with either an s or a z sound. This dialect is found in western New 
England, most of New York, and around the Great Lakes, extending into the 
eastern Dakotas. 

Northwestern dialect-Almost identical to Central Midland, the Northwestern 
dialect is distinguished by slightly different pronunciations of certain vowels. 
For example, "various" is often pronounced with a "long" a sound (vay-rious) 
in the Northwestern dialect as opposed to the "short" a sound exclusively used 
in Central Midland. 

Southwestern dialect-Again almost identical to Central Midland, the 
Southwestern dialect is characterized by the strong influence of Spanish
speakers, particularly in the vocabulary. Some linguists believe that a 
distinctive "California dialect" is emerging as well. 
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Dialect regions 
(continued) 

Southern dialect-More accurately described as a complex bundle of sub
regional dialects, most of the dialects spoken in the South do share certain 
traits that allow them to be grouped together in this manner. One of the most 
characteristic traits is the frequent "stretching" of simple vowels into 
diphthongs, as in the case of "dog" (dawug) and "flash"lflayish). Also, the 
"long" i sound is often pronounced ah, as in "I'' (ah) and "time" (tahm), and 
fmal r sounds are often dropped or replaced by a diphthong in words like "her" 
(huh) and "here" (heyah). 

Appalachian dialect-Commonly looked upon as a stereotypically "hillbilly" 
dialect, the Appalachian dialect is found in the southern portion of the 
Appalachian Mountain region, although it also stretches across Kentucky and 
Tennessee toward the Ozarks. Many linguists consider it, of all major 
American dialects, to be the one closest to the form of speech used by the 
earliest English settlers of North America. Among its distinguishing 
characteristics are the exclusive use o.f the z sound as opposed to the s in 
"greasy" and the preference for a "broad" o sound instead of the "short" u 

. sound in words like "hungry" (hongry). 

Cajun dialect-Unique to southern Louisiana, the Cajun dialect shows the 
extremely strong influence of the French spoken by the Acadians who moved 
to this area from Canada in the eighteenth century. In fact, many of the people 
in this region still prefer their variety of French to English. When English is 
spoken, it is basically a highly specialized variation on the Southern dialect 
spoken with a noticeable French accent. 

Hawaiian dialect-The Hawaiian dialect of American English is characterized 
by the strong influence of Japanese and native Hawaiian in vocabulary and 
vocal inflections. Linguists agree that much additional research needs to be 
done on American English as it is spoken in Hawaii. 

Alaskan dialect- Again, this is a case where a great deal of research still 
needs to be done. So far it seems that American English, as it is spoken in 
Alaska, is quite similar to Central Midland or Northwestern. Because of the 
remoteness of many parts of the state, distinctive sub-dialects are likely to 
form, if they haven't already. 

Elevation Depicts various ranges of elevation in the United States. While viewing this 
map, you can use the "Show English Units" and "Show Metric Units" 
commands to change the units of measurement you see on the key from feet to 
meters and back again. The information upon which this map is based comes 
from the U.S. Geological Survey. 
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Depicts various ranges of energy consumption in the United States. While 
viewing this map, you can use the "Show English Units" and "Show Metric 
Units" commands to change the units of measurement you see on the key from 
millions of BTUs per square mile per year to megawatt-hours per square 
kilometer per year and back again. This map is based upon energy-industry 
estimates. 

Indicates where in the United States various types of mineral or fuel energy 
resources are extracted from the earth. These energy resources include various 
types of coal (anthracite, bituminous, sub-bituminous, and lignite), petroleum, 
natural gas, and uranium. 

Shows the predominant ethnic groups in various parts of the United States, 
defined on a county-by-county basis. In this case, "predominant" means that a 
particular ethnic group forms either a majority or a large plurality of the 
population within a given county. Areas shaded pink, defined as "other," are 
those in which ethnic groups other than the seven specifically identified are 
predominant, including Italians, Irish, various Eastern Europeans, and Asians 
(the latter particularly in Hawaii). Areas shaded olive green, defined as "areas 
of extreme diversity," are those in which there is no one predominant ethnic 
group-that is, in which no one group makes up a majority or large plurality. 
The information upon which this map is based comes from the 1980 census. 

Indicates where land in the United States is owned by the federal government 
in the form of national parks and monuments (including state parks with close 
ties to the federal park system), national forests, national grasslands, and other 
federal lands (including military bases). 

Depicts various ranges of length of growing season in the United States, 
measured in months. As the key indicates, areas that have a growing season of 
twelve months-that is, a year-round growing season-are shown in dark 
green. At the opposite extreme, areas that have little or no growing season, 
and thus virtually no agriculture, are shown in blue-green. 
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Indian reservations Indicates in red where in the United States there are large federal and state 
and culture regions American Indian reservations. The other colors and patterns delineate the ten 

major culture regions of the indigenous Native American populations: 

Arctic-A culture adapted to life in extremely cold polar climates, dominated 
by the hunting of such Arctic animals as whales, walruses, caribou, and polar 
bears. This culture group includes the Eskimo (also known as the Inuit) and 
Aleuts. 

Subarctic-Also a hunting culture in many ways similar to that of the Arctic 
group, although with a far greater reliance on migration, following the caribou 
herds. In fact, peoples of the Subarctic culture group traditionally relied 
almost exclusively on caribou in much the same way as Plains Indians relied 
on the buffalo. Among the tribes belonging to this culture region are the 
Khotana, Kutchin, Dogrib, Chipewyan, and Sekani. 

Northwest Coast-A culture dominated by fishing of the rivers and coasts of 
the Pacific Northwest. Whaling and mountain hunting were important as well. 
Northwest Coast peoples, including the Chinook, Kwakiutl, Tsimshian, 
Nootka, Yurok, and Tlingit, were also experts at utilizing the extensive timber 
resources of the region and are well-known for their elaborate totem poles. 

California-Another fishing and hunting culture, although the people of this 
culture region also relied heavily on seed gathering-especially acorns, which 
they converted into flour. Among the tribes in this culture group are the 
Shasta, Miwok, Yokuts, Porno, and Chumash. 

Plateau-A culture dominated by salmon-fishing and intricate, highly 
effective political structures. Often this included representative government 
and tribal confederacies. Among the tribes in this group are the Klamath, 
Shuswap, Spokan, Cayuse, Yakima, and Nez Perce, although the latter were 
strongly influenced by neighboring tribes of the Great Plains culture region. 

Great Basin-A culture dominated by the needs of survival in extremely 
rugged, desert or semi-desert terrain. Its peoples were nomadic, subsisting on 
seeds, roots, insects, and small mammals. After the acquisition of horses, 
some of these tribes adopted the characteristics of neighboring Great Plains 
peoples. Among the tribes in this group are the Modoc, Ute, Paiute, Shoshone, 
and Washo. 
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Southwest-Another desert/semi-desert culture, although the peoples of this 
group did not adopt the nomadic ways of the Great Basin culture. Rather, the 
Southwest tribes-which included the Navajo, Hopi, Zuiii, Rio Grande 
Pueblos, Mojave, Pima, Papago, and Apache (the latter strongly influenced by 
the Great Plains culture )-developed a sophisticated culture distinctive for 
adobe and stone architecture, irrigation-based agriculture, and advanced skills 
in weaving and pottery. 

Great Plains-Perhaps the best-known of the North American Indian culture 
groups, the Plains Indian culture was actually a historically recent 
phenomenon. Before the introduction of horses to the region by Spaniards, the 
Great Plains were very sparsely settled, its few inhabitants eking out a meager 
living. But horses changed all that, allowing the region's original peoples, as 
well as newcomers from neighboring regions, to exploit the huge buffalo herds 
with tremendous effectiveness. This nomadic culture was embraced by such 
tribes as the Dakota (also known as the Sioux), Cheyenne, Pawnee, Arapaho, 
Kiowa, Crow, Mandan, Blackfeet, Wichita, Osage, Omaha, Iowa, Kansa, and 
Comanche. 

Northeast Woodlands-The frrst Native American culture encountered by 
English settlers, the tribes of the Northeast Woodlands group were typified by 
fairly sophisticated agriculture, supplemented by hunting and fishing. The 
forest trees and animals provided their food and shelter, the latter of which 
included wigwams and longhouses. Among the many tribes in this culture 
region are the Algonquin, the Iroquois (including the Cayuga, Mohawk, 
Oneida, Onandaga, and Seneca), Tuscarora, Huron, Massachuset, Pequot, 
Delaware, Powhatan, Miami, Erie, Cree, Ojibwa (also known as the 
Chippewa), Sauk, Fox, Winnebago, and Potawatomi. 

Southeast Woodlands-In many ways quite similar to the tribes of the 
Northeast Woodlands, the peoples of the Southeast Woodlands culture region 
were even more advanced and diverse in their agriculture. Because of their 
"sedentary" way of life, they settled in large towns and villages, often with 
highly organized political structures. This is perhaps why they were among 
the first American Indian tribes to widely adopt the so-called "ways of the 
white man"; some were therefore known as the "Civilized Tribes." Included in 
this group are the Cherokee, Shawnee, Chickasaw, Creek, Choctaw, Catawba, 
Alabama, Natchez, and Timucua. The Seminole, which were an offshoot of 
the Creek, though with a great mixture from other tribes, are also part of this 
group. 
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Land use 

Natural hazards 

Physiographic 
regions 

Indicates the predominant type of land use in various parts of the United 
States, divided into five categories: agriculture, forests, swampland, urban/ 
industrial, and barren (or "unutilized"). For further delineation of agricultural 
land use, see the "Agricultural Regions" theme map. For further delineation of 
forest land, see the "Vegetation Regions" theme map. 

Indicates areas of the United States that have relatively high risks of certain 
"natural hazards" of a meteorological or geological nature: tornadoes, 
hurricanes, river flooding, and volcanoes and/or earthquakes. If an area 
doesn't have the coloration indicating, for instance, high or moderate tornado 
risk, it doesn't mean that that area has no risk of tornadoes. Rather, it simply 
means that the risk of tornadoes is quite a bit lower there than it is in the high 
or moderate tornado-risk areas. The information upon which this map is based 
comes from the National Weather Service and the U.S. Geological Survey. 

Shows the ten major physiographic ("physical geography") regions of the 
United States. Different physiographic regions have highly distinctive 
topographies. These regions are as follows, listed alphabetically: 

Appalachian Highlands- The Appalachian mountain system, including its 
various ranges (such as the Allegheny, Blue Ridge, Great Smoky, Adirondack, 
and Green Mountains) and their valleys and foothills, including the Piedmont. 
In New England, this mountainous region extends right down to the Atlantic 
Coast. 

Arctic Slope- The northernmost portion of Alaska (and Canada), characterized 
by a steady, relatively steep decrease in elevation (hence "slope") from the 
Rocky Mountain System (Brooks Range) northward to the Arctic coast. 
Sometimes it is referred to as the "North Slope." 

Atlantic-Gulf Coastal Plain- The southeastern coastal flatlands. It starts with 
a narrow strip in the Northeast, embracing Cape Cod and Long Island. From 
there it stretches along the coast down to Texas, with a wide "bulge" extending 
northward up the Mississippi River. Much of this area is Tidewater, where the 
rivers are salty and are affected by the ocean tides. 

Hawaiian I stand Chain - A chain of islands in the middle of the Pacific 
Ocean. These islands are of volcanic origin and still include several active 
volcanoes. 
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Interior Plains- The flatlands of the central United States, commonly 
identified with the "Midwest," although extending around the Great Lakes into 
the western part of New York. The eastern half of this region is commonly 
referred to as the "Central Lowlands." The western half is generally called the 
"Great Plains." 

Inter-mountain Basins and Plateaus- The vast, high-elevation "valley" 
between the Pacific Mountain System and the Rocky Mountain System. 
Generally, this is a "tableland" marked by deserts, semi-deserts, mountains, 
mesas, canyons, and gorges. It includes the Columbia Plateau, the Colorado 
Plateau, and the Great Basin. In the northern United States and southern 
Canada, the Pacific and Rocky Mountain Systems converge, causing an 
"interruption" in this region. But then, in northern Canada, the two mountain 
systems separate again, allowing the Inter-mountain region to continue on up 
into Alaska, where it includes the Yukon Valley. 

Ozark Highlands- A hilly, elevated region that lies between the Interior Plains 
and the Atlantic-Gulf Coastal Plain in the south-central part of the country. It 
is frequently cut by gorges and valleys, making it rugged terrain. The 
southwestern portion of this region is often referred to as the "Ouachita 
Highlands," and sometimes this entire region is called the "Ozark-Ouachita 
Highlands." 

Pacific Mountain System- The chain of mountains that line the Pacific Coast 
of North America, including the Coast Range (often called the "Coastal 
Range"), Cascades, and Sierra Nevada. It extends up through Canada into 
Alaska, where it embraces the Wrangell, Alaska, and Aleutian Ranges. 

Rocky Mountain System- The vast chain of mountains that divide the Interior 
Plains from the Inter-mountain Basins and Plateaus. It includes a large number 
of ranges, including the Bitterroot, Sangre de Cristo, Blue, Davis, Bighorn, and 
Wasatch Mountains, and extends up through Canada into Alaska, where it 
embraces the Brooks Range. Some geologists consider the Rocky Mountain 
System to be the northern half of a great intercontinental mountain range that 
extends through Mexico and Central America and down into South America, 
where its southern half emerges as the Andes. 

Superior Upland- The southern portion of the Canadian Shield (also known 
as the "Laurentian Upland"), extending down into the United States around 
Lake Superior. This region is noticeably rockier and hillier than the 
surrounding plains and is characterized by a large number of lakes and 
marshes. 
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Physiographic 
regions 

(continued) 

Population density 

Precipitation, 
annual average 

Settlement 
patterns 

Temperature, 
January average 

Temperature, 
July average 

Keep in mind that these are only the major physiographic regions. In many 
geography texts, some of these regions are subdivided into smaller regions. 

Depicts various ranges in the population density of the United States. While 
viewing this map, you can use the "Show English Units" and "Show Metric 
Units" commands to change the units of measurement you see on the key from 
people per square mile to people per square kilometer and back again. Areas 
shown in white (only a few parts of Alaska) are virtually uninhabited. The 
information upon which this map is based comes from the 1980 census. 

Depicts various ranges of average annual precipitation in the United States. 
While viewing this map, you can use the "Show English Units" and "Show 
Metric Units" commands to change the units of measurement you see on the 
key from inches to millimeters and back again. The information upon which 
this map is based comes from the National Weather Service. 

Indicates which parts of the United States had been settled by Europeans, their 
descendants, and/or other non-indigenous peoples at various times in the 
nation's history-as of 1700, 1790, 1820, 1850, 1870, 1890, and since then. It 
does not take into account historical population distribution of Native 
American peoples: American Indians, Aleuts, and Inuit (Eskimo). 

Depicts various ranges of average January temperature in the United States. 
These figures take into account both daytime and nighttime temperatures. 
While viewing this map, you can use the "Show English Units" and "Show 
Metric Units" commands to change the units of measurement you see on the 
key from degrees Fahrenheit to degrees Celsius and back again. The 
information upon which this map is based comes from the National Weather 
Service. 

Depicts various ranges of average July temperature in the United States. If 
some of these ranges seem a little low to you, keep in mind that they take into 
account nighttime lows as well as daytime highs. While viewing this map, you 
can use the "Show English Units" and "Show Metric Units" commands to 
change the units of measurement you see on the key from degrees Fahrenheit 
to degrees Celsius and back again. Once again, the information upon which 
this map is based comes from the National Weather Service. 
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Delineates the various "steps" in the territorial expansion of the United States. Territorial 
Some textbooks and atlases do not distinguish the basin of the Red River of the expansion 
North (in the north-central part of the United States) as being a separate 
territorial acquisition from the Louisiana Purchase. This is because the U.S. 
government maintained that the Louisiana Purchase indeed included this 
region. Great Britain, however, claimed this land as well. It was not until the 
conclusion of a treaty between the United States and Great Britain fifteen years 
after the Louisiana Purchase, in 1818, that the basin of the Red River of the 
North indisputably became U.S. territory. That is why this USA GeoGraph 
theme map distinguishes it from the Louisiana Purchase. 

Also, some textbooks and atlases do not distinguish the Webster-Ashburton 
Treaty lands from the original territory of the United States. These areas in 
northern Maine and northeastern Minnesota were disputed between the United 
States and Great Britain until the signing of the treaty in 1842. 

Note that this map does not distinguish the thirteen original states from the rest 
of the land that was part of the original territory of the United States. For 
example, although Illinois was not one of the original thirteen states, the 
territory that eventually became Illinois was part of the original territory of the 
United States as defined by the Treaty of Paris of 1783, which ended the 
Revolutionary War. 

Shows the various time zones in the United States. Because the time advances Time zones 
by one hour for every zone going from west to east, the key includes a "sample 
time" for each zone, beginning with 1:00 for the westernmost time zone among 
the fifty states, Hawaiian Standard Time, and ending with 6:00 for the 
easternmost zone, Eastern Standard Time. In this way, students should easily 
be able to see that "Eastern time" is five hours later than "Hawaiian time." 
Note that this map does not take Daylight Savings Time into account and the 
fact that a few parts of the country do not adhere to Daylight Savings Time. In 
effect, these parts of the country are within one time zone for about half of the 
year but in a different time zone for the other half. 

Also note that all of Alaska (except for the westernmost Aleutian Islands, 
which do not appear on this theme map) adheres to a single "Alaskan" time 
zone. This is a very recent change. Until the mid-1980s, Alaska was divided 
into four distinct time zones (Pacific, Yukon, Alaskan-Hawaiian, and Bering). 
Older maps, globes, atlases, and geography textbooks that deal with time zones 
will therefore be out of date in this respect. 
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Vegetation regions Shows the predominant type(s) of natural vegetation in various parts of the 
United States. Natural forms of vegetation-and the corresponding vegetation 
regions-are largely the result of various factors of nature, including climate 
zones, physiographic regions, and soil types. 

Water sufficiency Indicates areas in the United States that face actual and potential problems with 
fresh water supply, including groundwater depletion and high levels of 
pollution. The information upon which this map is based comes from the U.S. 
Geological Survey. 
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The following publications were among those consulted in designing- USA 
GeoGraph, producing its on-screen maps, and compiling its database. This list 
is by no means exhaustive. 

Allen, James Paul and Eugene James Turner. We the People: An Atlas of 
America's Ethnic Diversity. New York: Macmillan Publishing Company, 
1988. 

Chaliand, Gerard and Jean-Pierre Rageau. A Strategic Atlas: Comparative 
Geopolitics of the World's Powers. Second edition. Translated from the 
French by Tony Berrett. New York: Harper and Row, 1985. 

Chapman, John D. and John C. Sherman, eds. Oxford Regional Economic 
Atlas: The United States and Canada. Second edition. Oxford: Oxford 
University Press, 1975. 

Compton's Encyclopedia and Fact-Index. 1984 edition. 26 volumes. 
Chicago: F.E. Compton Company, 1984. 

Cuff, David J. and William J. Young. The United States Energy Atlas. Second 
edition. New York: Macmillan Publishing Company, 1986. 

Glassborow, Jilly and Gillian Freeman, eds. Atlas of the United States. New 
York: Macmillan Publishing Company, 1986. 

Goode's World Atlas. Seventeenth edition. Editor Edward B. Espenshade, Jr. 
Chicago: Rand McNally and Company, 1987. 

Guide to Places of the World: A Geographical Dictionary. Consultant editor 
Alan B. Mountjoy. London: The Reader's Digest Association, 1987. 

Hacker, Andrew, ed. U/S: A Statistical Portrait of the American People. 
New York: Penguin BooksNiking Press, 1983. 

Hornor, Edith R., ed. Almanac of the 50 States: Basic Profiles with 
Comparative Tables. 1989 edition. Palo Alto, California: Infonnation 
Publications, 1989. 

Joint Committee bn Geographic Education of the National Council for 
Geographic Education and the Association of American Geographers. 
Guidelines for Geographic Education-Elementary and Secondary 
Schools. Washington, D.C.: Association of American Geographers and 
the National Council for Geographic Education, 1984. 
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Joel Makower, ed. The Map Catalog. New York: Vintage Books/filden 
Press, 1986. 

McCaslin, John C., ed. The International Petroleum Encyclopedia. Tulsa: 
Energy Group of Penn Well Publishing Company, 1988. 

The National Atlas of the United States of America. Washington, D.C.: U.S. 
Department ofthe Interior U.S. Geological Survey, 1970. 

New Century World Atlas. Chicago: Rand McNally and Company, 1986. 

The New Book of American Rankings. New York: Facts on File Publications, 
1984. 

The New EncycloptEdia Britannica. Fifteenth edition. Thirty volumes. 
Chicago: Encyclopredia Britannica, 1984. 

New International Atlas. Milan, Italy: John Bartholomew and Son, Ltd., 
1986. 

1988 Britannica Book of the Year. Editors Daphne Daume and Louise 
Watson. Chicago: Encyclopredia Britannica, 1988. 

The 1988 Information Please Almanac. Boston: Houghton Mifflin Company, 
1988. 

Nist, John. A Structural History of English. New York: St. Martin's Press, 
1966. 

Paxton, John, ed. The Statesman's Yearbook, 1988-89. 125th edition. New 
York: St. Martin's Press, 1988. 

Pearce, E. A. and C. G. Smith. The Times Books World Weather Guide. New 
York: Times Books, 1984. 

Sedeen, Margaret, ed. National Geographic Picture Atlas of Our Fifty States. 
Washington, D.C.: National Geographic Society, 1980. 

Rand McNally Desk Reference World Atlas. Chicago: Rand McNally and 
Company, 1987. 

Rand McNally Universal World Atlas. New revised edition. Chicago: Rand 
McNally and Company, 1987. 
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Rowell, Deborah, ed. The Oil and Gas Producing Industry in Your State. 
Washington, D.C.: Independent Petroleum Association of America, 1988. 

State and Metropolitan Area Data Book 1986. Washington, D.C.: U.S. 
Department of Commerce Bureau of the Census, 1986. 

Statistical Abstract of the United States 1989. 109th edition. Washington, 
D.C.: U.S. Department of Commerce Bureau of the Census, 1989. 

Weber, Susan, ed. USA by Numbers: A Statistical Portrait of the United 
States. Washington, D.C.: Zero Population Growth, Inc., 1988. 

The World Almanac and Book of Facts 1988. New York: World Almanac, 
1988. 

The World Factbook 1988. Washington, D.C.: Central Intelligence Agency, 
1988. 
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London. Fourth edition. New York: Rand McNally and Company, 1984. 

Ahlschwede, Ben F. Exploring Our World: The Americas. Chicago: Follett 
Publishing Company, 1980. 

Borchert, John R. America's Northern Heartland: An Economic and 
Historical Geography of the Upper Midwest. Minneapolis: University of 
Minnesota Press, 1987. 
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1983. 

Drummond, Dorothy W. and Robert R. Drummond. People on Earth: A 
World Geography. Glenview, Illinois: Scott, Foresman and Company, 
1983. 
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Gross, Herbert H. World Geography. Newton, Massachusetts: Allyn and 
Bacon, 1986. 

Gross, Herbert H., et al. Exploring Our World: The Americas. Chicago: 
Follett Publishing Company, 1980. 

Heath Student Atlas. Lexington, Massachusetts: D.C. Heath and Company, 
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D.C.: U.S. Environmental Protection Agency, 1987. 
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Canada and the United States. Seventh edition. New York: Oxford 
University Press, 1984. 

Patton, Clyde P., et al. A World View. Morristown, New Jersey: Silver 
Burdett and Ginn, 1988. 
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MECC is an organization established in 1973 to assist Minnesota schools in 
implementing educational computing. MECC provides a variety of services to 
education, including 1) development and distribution of instructional computing 
courseware; 2) in-service training for educators and development of materials for 
conducting training; and 3) educational computing assistance through newsletters and 
equipment purchase contracts. MECC's knowledge and expertise in the educational 
computing field comes from more than fifteen years of working with and providing 
leadership for thousands of educators on a daily basis. 

MECC Educational Computing Catalog 
A catalog containing descriptions of instructional computing courseware as well as 
training and planning materials is published annually and distributed at no charge. 
To request a catalog, write or call MECC Customer Services. 

MECC Etc. Catalog 
A catalog featuring "Emerging Technologies in the Classroom," such as laser 
videodisc players and LCD computer projection systems, is published twice a year 
and distributed at no charge. To request a catalog, write or call MECC Customer 
Services. 

MECC Memberships 
Educational institutions may become MECC Members, which qualifies them to 
obtain MECC courseware and training at specially reduced prices. To learn more 
about MECC Memberships, write or call MECC Marketing. 

Training and Staff Development Programs 
MECC conducts educational computing workshops for educators throughout the 
United States. For information on workshop schedules or to arrange a special 
training activity, write or call MECC Training Services. 

MECC Network Newsletter 
Published regularly throughout the school year, MECC's newsletter focuses on 
MECC activities, services, and products. To obtain, write or call indicating your 
interest in the MECC Network newsletter. 

Help Line 
If you have any problems using MECC software: 

1) make note of the name and version number of the product; 
2) note the brand and model of the equipment involved, as well 

as the type of printer card used if the problem concerns a 
printer; 

3) write or call the Help Line to describe the problem. 

For information on all the above items, use the MECC General Information telephone 
number: 612/481-3500. 

MECC 
3490 Lexington Avenue North 

St. Paul, MN 55126 
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"Abbreviate Category Names" command, 65-67, 
114 

"Abbreviation, Postal" data category, 
description, 141 
use with graphs, 70 

Abbreviations for categories, 66-67, 141-162 
"About USA GeoGraph" option, 105 
"Acid Rain" theme map, description, 163 
"Add Category" command, 96-99, 115 
"Add Rule" button and dialog box, 39-43, 45-46, 

56 
"Add Section" command, 78-80, 114, 117, 123 
"Agricultural Commodities" data category, 

description, 141 
"Agricultural Regions" theme map, description, 

163 
"Agricultural Value" data category, description, 

141 
"Airline Passengers" data category, description, 

141 
"And" precedence in searches, 47 
"And" searches, 42-44, 112 
"Annual Pay, Average" data category, description, 

142 
Apple (tt) menu, 66, 90, 105 
Apple-clicking, 

in a scroll box, 33-34, 54, 69, 74, 83, 95, 118 
on a data card or data table, 68, 118, 119 
on a map, 24-25,26, 117, 119 

"Area, Land" data category, description, 142 
"Area, Total" data category, description, 142 
"Area, Water" data category, description, 142 
"Arrange Categories" command, 61-63, 75, 113, 

119 
"Arrange Rules" button and dialog box, 49-50, 119 
Arranging (sorting) graphs, 70-71 
Arrow (selection) cursor, 119 
"Asian Population" data category, description, 142 

Bibliography, 175-179 
"Birth Rate" data category, description, 142 
"Black Population" data category, description, 143 
"Blank Map" option, 15, 19, 23, 110, 116 
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"Borders" data category, description, 143-144 

"Capital" data category, description, 144 
"Choose Printer" command, 83-84, 107 
"Cities" data category, description, 144 
"Civil War" theme map, description, 163 
"Clear Selection" command, 29, 53, 57, 69, 80, 

112, 123 
Clicking on a map, 22-28,53, 117 
"Climate Zones" data category, description, 

144-145 
"Climate Zones" theme map, description, 164 
Close box, 15 
"Close" command, 89-90, 106, 116 
"Close-up Map" command, 20-21, 110, 116 
Closing a document, 89-90 
"Coastline" data category, description, 146 
"Compare" command, 16-18,21, 111 
"Contains" operator (as opposed to "equals"), 124 
"Contrast" command, 55-57, 111 
Control-A, 94, 95, 96, 115, 116 
"Copy" command, 94, 104, 111 
"Crime, Property" data category, description, 145 
"Crime, Violent" data category, description, 145 
Cursors, 25-26,47,57,59, 114 
"Cut" command, 98, 108, 116 

Database, 
data categories, 29-33, 141-162 
selecting records (places), 26-28, 53-55 
searching for records (places), 39-53, 74, 112-

113 
sorting records (places), 57-59, 113 

Data cards, 27, 61, 67, 74, 109, 116, 119 
Data disks, 89, 92-93, 102, 137-138 
Data menu, 29,34-39,44-45,47-49, 57-58,60-63, 

112-114 
Data tables, 28, 29, 57, 63, 65, 67, 109, 116, 119 
"Date of Admission" data category, 

description, 146 
sorting, 59 

"Death Rate" data category, description, 147 
Desk accessories, 105 
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"Dialect Regions" theme map, description, 164-
166 

"Display Data Cards" command, 27, 61, 67, 74, 
109, 116 

"Display Data Table" command, 28, 29, 57, 63, 65, 
67, 109, 116 

"Display Distribution" command, 73-77, 109, 116 
"Display Graph" command, 69-70, 72, 109, 116 
"Display Map" command, 23, 27, 50, 72, 78, 109, 

116 
Display menu, 23, 27-28, 39, 50, 61, 63, 65, 67, 69, 

72, 74, 109 
Distribution tables, 

numeric, 74, 76-77 
textual, 74,75-76 

Double-clicking on a data card or data table, 68, 
118 

Double-headed arrow cursor, 64, 119 
Duplicating added categories, 125, 137-138 

"Edit Category" command, 100-101, 115 
Edit menu, 80, 108 
"Edit Rule" button and dialog box, 48 
"Education, College" data category, description, 

147 
"Education, Expenses Per Pupil" data category, 

description, 147 
"Education, High School" data category, 

description, 147 
"Education, Under 5 Years" data category, 

description, 147 
"Electoral Votes" data category, description, 147 
"Electricity, Coal" data category, description, 147 
"Electricity, Gas" data category, description, 148 
"Electricity, Hydro" data category, description, 148 
"Electricity, Nuclear" data category, description, 

148 
"Electricity, Petroleum" data category, description, 

148 
"Elevation, Average" data category, description, 

148 
"Elevation, Highest" data category, description, 

148 

"Elevation, Lowest" data category, description, 
148 

"Elevation" theme map, description, 166 
"Energy Consumption" data category, description, 

149 
"Energy Consumption Per Capita" data category, 

description, 149 
"Energy Consumption" theme map, description, 

167 
"Energy Production" data category, description, 

149 
"Energy Production Per Capita" data category, 

description, 149 
"Energy Resources" theme map, description, 167 
"Equal Steps Map" command, 19-20, 111 
"Ethnic Population" theme map, description, 167 
Expanding/limiting searches, 44-45, 50-53, 113 
"Export Data" command, 92-93, 106 

"Federal Lands" theme map, description, 167 
"Fifty States Map" command, 14, 19, 110, 116 
File menu, 12,83-85,87-92, 106-107 
"Find" command, 35-38, 113, 117 
"Find Next" command, 37-38, 113, 117 
Five themes of geography education, 5-7 
"Fun Facts" data category, description, 149 

"Geographic illiteracy," 4-5 
"Gross Domestic Product" data category, 

description, 150 
"Ground Water Dependence" data category, 

description, 150 
"Growing Season Length" theme map, description, 

167 

Hand cursor, 49, 62, 119 
Hard disks, 139-140 
"Hazardous Waste Production" data category, 

description, 150 
"Help" option, 66-67, 105, 116 
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"Hide/Show Boundaries" command, 13, 15, 21, 
112, 116 

"Highway Mileage" data category, description, 150 
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"Highway Usage" data category, description, 150 
"Hispanic Population" data category, description, 

150 

Icons, 12,91,92, 138,139-140 
"Indian Reservations and Culture Regions" theme 

map, description, 168-169 
"Industries" data category, description, 151 
"Infant Mortality Rate" data category, description, 

151 
Initializing a data disk, 137 
Interrupting printing, 87, 117 

Key combination command equivalents, 116-117 

"Labor Force, Female Participation" data category, 
description, 151 

"Labor Force, Male Participation" data category, 
description, 151 

"Labor Force in Agriculture" data category, 
description, 151 

"Labor Force in Industry" data category, 
description, 151 

"Labor Force in Office Work" data category, 
description, 151 

"Labor Force in Services" data category, 
description, 152 

"Land, Built-up" data category, description, 152 
"Land, Cropland" data category, description, 152 
"Land, Federal" data category, description, 152 
"Land, Forested" data category, description, 152 
"Land, Pasture" data category, description, 152 
"Land, Rangeland" data category, description, 152 
"Land Use" theme map, description, 170 
"Life Expectancy: Females" data category, 

description, 153 
"Life Expectancy: Males" data category, 

description, 153 
Location (one of the "five themes"), 6 
"Low-Income Families" data category, description, 

153 

Magnifying glass ("zooming") cursors, 24-25, 119 
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Management menu, 93-97, 100-101, 115 
"Manufacturing Industries" data category, 

description, 153 
"Manufacturing Value" data category, description, 

153 
Maps, 

comparison maps, 16-18,21, Ill 
close-up maps, 20-21, 110, 116, 119 
contrast maps, 55-57, 111 
equal steps maps, 19-20, 21, 111 
Fifty States map, 14, 50, 72, 110, 119, 130 
projections, 13, 130 
region maps, 15-16, 110, 119, 160 
scales, 13 
Overview map, 13, 110, 119 
theme maps, 13-15, 21, 79-80, 111, 130, 163-

174 
USA quartiles maps, 18-19,21, 111 

Maps menu, 13-21,50,72,78, 79, 110-112 
MECC information, 105, 135-136, 181 
"MECC Key Caps" desk accessory, 105 
"Millionaires," data category, description, 154 
"Minerals and Fuels" data category, description, 

154 
"Minerals and Fuels Value" data category, 

description, 154 
Movement (one of the "five themes"), 7 

"Native American Population" data category, 
description, 154 

"Natural Features" data category, description, 154 
"Natural Hazards" theme map, description, 170 
"Natural Increase Rate" data category, description, 

155 
"Net Migration, 1980-87" data category, 

187 

description, 155 
"Nitrogen Oxides" data category, description, 155 
"New Category" button, 73 
"New" command, 106, 116 

"Open" command, 12, 90, 92, 106, 116 
Opening a document, 90-91,92, 106 
Option-Apple-clicking on a map, 24-26, 117, 119 
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"Or" searches, 44-45, 113 
Overview Map, 13, 110, 119 

"Page Setup" option, 84-85, 107 
"Particulates" data category, description, 155 
"Paste" command, 98, 108, 116 
"Per Capita Income" data category, description, 

155 
"Physiographic Regions" theme map, description, 

170-172 
"Place" data category, description, 141 
Place (one of the "five themes"), 6 
"Political Index" data category, description, 156 
"Population 1800" data category, description, 157 
"Population 1850" data category, description, 157 
"Population 1900" data category, description, 157-

158 
"Population 1950" data category, description, 158 
"Population 1988" data category, description, 158 
"Population 2000 (Projected)" data category, 

description, 158 
"Population Age 60 and Over" data category, 

description, 158 
"Population Born Outside State" data category, 

description, 158 
"Population Density" data category, description, 

158 
"Population Density" theme map, description, 172 
"Population Foreign-Born" data category, 

description, 158 
"Population Growth, 1980-87" data category, 

description, 159 
"Population Growth Rate, 1980-87" data category, 

description, 159 
"Population Per Physician" data category, 

description, 159 
"Population Under Age 15" data category, 

description, 159 
"Precipitation, Annual Average" data category, 

description, 159 
"Precipitation, Annual Average" theme map, 

description, 172 
"Print Report" command, 85-87, 107, 116 

188 

"Print Window" command, 87, 107, 116 
Printing, 83-87, 125 

in color, 86 
interrupting, 87, 117 

"Printing Options" option, 85, 86, 107 

quartiles, 18-19,20,21,76,111 
"Quit" command, 91, 107, 116 
Quitting, 91, 107 

"Recreation Lands" data category, description, 160 
"Region" data category, description, 160 
"Region Map" option, 15-16, 110, 116 
Regions (in USA GeoGraph), 160 
Regions (one of the "five themes"), 7 
Relationships within places (one of the "five 

themes"), 6-7 
"Remove Category" command, 101-102, 115 
"Remove Ru1es" button and dialog box, 48-49 
"Remove Sections" command, 83, 114 
"Replace Section" command, 81-82, 114 
Report menu, 78-83, 114 
Report sections, viewing, 81, 114 
Reports, 78-83 
"Resize Categories" command, 63-65,66, 114, 119 
"Restore" button, 63,65 
"Restore Window Position" command, 109 

"Save As" command, 88-89, 106 
"Save" command, 88-89, 106, 116 
Saving a document, 88-89 
"Search" button, 42-47, 47, 52-53, 123 
"Search" command, 39-53,55, 112-113, 117, 123 
Search conjunction (and/or) buttons, 43-47,49, 50 
Search "operator" buttons, 40 
Search rules, 

adding, 42-44, 45-46 
creating, 39-42 
editing or replacing, 48 
limiting or expanding, 45, 50-53 
rearranging, 49-50 
removing, 48-49 
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Searches, types of, 
"And," 42-44, 112 
involving both "And" and "Or", 45-47, 113 
"Or," 44-45, 113 
simple (one-rule), 39-42, 112 

Selecting database records (places), 
by clicking on a map, 23-28, 51, 117 

Selecting database records (places) (continued), 
by using the "Search" command, 39-53, 55, 

112-113 
by using the "Select Places" command, 53-55, 

113 
"Select Places" command, 53-55, 113 
"Set Preferences" command, 93, 94-96, 101, 115, 

129 
"Settlement Patterns" theme map, description, 172 
Shift-clicking, 

in a scroll box, 33, 55, 83, 95, 118 
on a map, 24,27-28, 51, 117 

"Show Categories" command, 29-30, 33-35, 73, 
74,95,113 

"Show English Units" command, 59-61, 95, 114, 
116 

"Show Key" command, 14-15, 17, 20, 80, 112, 116 
"Show List" button and dialog box, 40-41 
"Show Metric Units" command, 59-61, 95, 114, 

117 
"Show Prefs" button, 95 
Simple (one-rule) searches, 39-42, 112 
Sliding maps, 22, 28, 117 
"Soil Erosion" data category, description, 160 
"Sort" command, 57-59,70-71, 113, 117 
Sorting (arranging), 

a database selection, 57-59 
a graph, 70-71 

"States Only" check box, 17-18, 20 
"Status" data category, description, 160 
"Sulfur Oxides" data category, description, 161 
System file, 91, 105, 139 

"Temperature, January Average" data category, 
description, 161 
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"Temperature, January Average" theme map, 
description, 172 

"Temperature, July Average" data category, 
description, 161 

"Temperature, July Average" theme map, 
description, 172 

"Territorial Expansion" theme map, description, 
173 

"Theme Map" option, 13-15,21,79-80, 111, 130 
Theme maps, 13-15,21,79-80, 111, 130, 163-174 
"Time Zones" theme map, description, 173 
"Toxic Waste Sites" data category, description, 

161 

"Undo" command, 80, 108, 116, 123 
"Unemployment Rate" data category, description, 

161 
"Union Membership" data category, description, 

162 
United States overall data, 105 
Units of measurement, 59-60, 141-162 
"Urban Population 1980" data category, 

description, 162 
"Urban Population Change, 1970-80" data 

category, description, 162 
USA GeoGraph, 

bibliography, 175-179 
Classroom Guide, 8, 125-126, 130, 140 
command descriptions, 105-115 
credits, 135 
equipment required, 11, 129 
Information Disk, 12-13, 89, 93, 137-139 
"Lab Packs," 140 
"living map," 3-4, 23, 26-28, 51, 72 
menu descriptions, 105-115 
Network Version, 140 
objectives, 11 
program description, 3, 11 
Program Disk, 12, 89, 93, 137-140 
starting up, 12-13 
title screen, 12 
User's Guide symbols, 7-8 
using with projection systems, 126 
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"USA Overall Data," 
comparing states or territories to, 16, 111 
help button, 66 

"USA Quartiles" option, 18-19, 21, 76, 111 

"Vegetation Regions" theme map, description, 174 

Watch (wait) cursor, 119 
"Water Sufficiency" theme map, description, 174 
"Water Use for Irrigation" data category, 

description, 162 

"Water Use Per Capita" data category, description, 
162 

"White Population" data category, description, 162 
WorldGeoGraph, 8, 117, 131, 135 

Zooming in, 
on a data card, 68, 119 
on a map, 24-25, 119 

Zooming out, 

190 

from a map, 25-26, 119 
to a data table, 68, 119 
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